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RÉSUMÉ

Les communications par satellite qui nous permettent de communiquer à travers le monde ont été développées

depuis les années 1960. Aujourd’hui, il est difficile de passer une journée sans l'aide des communications par 

satellite. Grâce à leurs avantages qui pourraient se résumer par la formule suivante : « Plus rapides, plus petits, 

meilleurs et moins chers », les nanosatellites sont récemment devenus un sujet de recherche très intéressant dans 

de nombreux pays développés. Ce mémoire traitera  beaucoup d’aspects liés aux nanosatellites, à travers trois 

parties principales : une partie bibliographique, une partie théorique, et une partie réalisation et simulation. Les 

points les plus saillants et significatifs dans ce mémoire sont l’étude de la mécanique orbitale des nanosatellites, 

la détermination de constellations optimales, et le calcul des bilans de liaison pour différents types d’orbite, dont

LEO (Low Earth Orbit), VEO (Very Low Earth Orbit) et MEO (Medium Earth Orbit).
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CHAPITRE I

Introduction

Ce chapitre présentera trois points importants : introduction au sujet de recherche, présentation de TéSA, objectif 

du stage et thématique générale du Master IT-RT.

I.1 Introduction au sujet de recherche

Les communications par satellite sont le résultat de la recherche dans le champ des communications et des 

technologies spatiales dont l'objectif est d'augmenter la distance et les capacités des communications avec les 

plus bas coûts possibles.

La Deuxième Guerre mondiale a stimulé l'expansion de deux technologies bien distinctes : les missiles et les 

micro-ondes. L'expertise définitivement acquise dans l'utilisation combinée de ces deux techniques a ouvert l'ère 

des communications par satellite.

Avant les années 2000, il y avait beaucoup de satellites traditionnels lancés et placés sur une orbite terrestre, 

ainsi que des minisatellites (< 500 kg) et des microsatellites (< 100 kg).

Depuis les années 2000, grâce aux progrès des microtechnologies, l'industrie aérospatiale et la communauté de la 

recherche ont engagé des missions qui impliquent de nombreux satellites, petits et peu coûteux tels que les 

nanosatellites (< 10 kg) et les picosatellites (< 1 kg) car les missions des satellites traditionnels sont extrêmement 

coûteuses (les coûts se chiffrent en milliards de dollars) et le développement de ces derniers nécessite beaucoup 

de temps.

De fait, les nanosatellites ont été l’objet d’un immense intérêt renouvelé à travers le monde ces tous dernières 

années grâce à leurs avantages énumérés ci-dessous :

 durée de développement plus rapide ;

 possibilité de rendre redondants les satellites, ce qui augmente la fiabilité du système ;

 réduction de la taille et du coût des stations terrestres ;

 solution idéale pour tester de nouvelles technologies ;

 possibilité d'être lancés en groupe ou en « Piggyback » avec de plus grands satellites ;

 réduction des coûts de fabrication et de lancement ;

 pertes financières minimisées en cas d'échec.

Les nanosatellites sont donc une solution bien ciblée aux problèmes de budget, de temps de développement, et de 

fiabilité d’un système de communications par satellite.

I.2 Présentation de TéSA

TéSA (Télécommunications Spatiales et Aéronautiques) est un laboratoire privé et coopératif créé en 1998, et 

situé au 14-16, port Saint-Etienne à Toulouse. TéSA rassemble les partenaires académiques ENAC, ENSEEIHT, 

ENSICA et Supaero (tous deux maintenant regroupés au sein de l’ISAE), ENST, INPT ; les industriels Thales 

Alenia Space et Rockwell Collins France ; et les institutionnels CNES et STNA (Service Technique de la 

Navigation Aérienne).

Figure I.1 : Partenaires de TéSA
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I.3 Objectif du stage

Les potentialités technologiques et économiques des nanosatellites qui offrent des perspectives d’avenir 

novatrices dans la conception des systèmes spatiaux et qui sont susceptibles de devenir une filière technologique 

et industrielle concurrente de la filière traditionnelle justifient quelque anticipation stratégique dans la recherche. 

L’objectif de ce stage est de contribuer à l’étude des nanosatellites dans cette perspective.

Le travail de stage, d’une durée de 6 mois et réalisé entre début mars et septembre 2011, se découpe en trois 

parties :

1. Partie bibliographique : état de l’art du développement des nanosatellites, de leurs technologies et de 

leurs applications. Cette partie présentera les éléments ci-dessous :

 introduction aux nanosatellites : historique des nanosatellites et caractéristiques générales d’un 

système nanosatellitaire ;

 technologies nanosatellitaires : caractéristiques des nanosatellites, sous-systèmes des nanosatellites, 

avantages, inconvénients et défis des nanosatellites ;

 applications des nanosatellites.

2. Partie théorique : éléments de conception d’un système nanosatellitaire. Cette partie consiste à étudier 

quelques éléments bien ciblés de conception préliminaire d’un système nanosatellitaire, en vue d’un futur 

démonstrateur éventuel, en partant au préalable d’une claire définition de la mission qui a été faite en 

étroite conjonction avec le laboratoire TéSA. Les éléments suivants de conception seront pris en compte :

 définition de la mission ;

 architecture système ;

 couche physique et couche liaison ;

 détermination de l’orbite ;

 constellation de satellites ;

 bilans de liaison.

3. Partie réalisation et simulation : réalisation d’un simulateur d’analyse orbitographique. Les études 

bibliographique et théorique menées dans les parties précédentes seront complétées dans cette troisième 

partie par la mise en œuvre, sous l’environnement logiciel STK, de scénarii représentatifs du système 

nanosatellitaire étudié (segment spatial, segment terrestre et architecture réseau) qui permettront de simuler, 

analyser et valider la conception du système. Cette partie abordera les thèmes ci-dessous :

 présentation de STK ;

 mécanique orbitale pour différents types d’orbite ;

 constellations en couverture continue de la Terre pour différents types d’orbite ;

 constellations pour un système satellitaire optimisé et rentable en basse orbite terrestre entre deux 

endroits précis ;

 bilans de liaison entre un nanosatellite en basse orbite terrestre et une station terrestre.

I.4 Thématique générale du Master IT-RT

Le vaste sujet des nanosatellites traité dans ce stage, s’il est nouveau, fait intervenir de nombreux champs 

multidisciplinaires de recherche et diverses disciplines des sciences de l’ingénieur :

 systèmes électriques et énergétiques (exemples : pico-cellules solaires, batteries, capteurs, etc.) ;

 mécanique (exemple : structure du nanosatellite, antennes, etc.) ;

 automatique (exemple : contrôle d’attitude du nanosatellite, contrôle de la vitesse du nanosatellite, contrôle 

thermique, etc.) ;

 réseaux et télécommunication (exemples : protocoles de communication, performances des communications, 

bilans de liaison, etc.).

Plus précisément, au cours de ce stage, les différents éléments de conception d’un système nanosatellitaire ont 

été abordés, depuis la définition de mission, jusqu’à l’analyse des performances de communication, en passant 

par l’étude du segment terrestre et du segment spatial. Un bref survol des divers sous-systèmes embarqués est 
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donné, ce qui offre l’opportunité de se placer dans la situation de la conception préliminaire d’un système 

nanosatellitaire complet.

Les points suivants :

- détermination de l’attitude du satellite, avec la comparaison des différents types d’orbite (VLEO, LEO 

et MEO),

- détermination de la constellation optimale, et analyse des performances des communications sous 

l’angle des bilans de liaison

sont davantage orientés vers les aspects communications et orbitographiques et donneront lieu au développement 

d’un simulateur d’analyse orbitographique et de constellations sous STK et à des simulations sous MATLAB.

Il s’avère donc que l’étude d’un système nanosatellitaire réalisée au cours de ce stage rentre parfaitement dans le 

cadre de la thématique du Master Recherche Informatique et Télécoms, parcours Réseaux et Télécoms (Master 

IT-RT).
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CHAPITRE II

Partie bibliographique : état de l'art du développement des nanosatellites – technologies 

et applications

Ce chapitre décrit trois points principaux :

1. Introduction aux nanosatellites : historique des nanosatellites et caractéristiques générales d’un

système nanosatellitaire;

2. Technologies nanosatellitaires : caractéristiques des nanosatellites, sous-systèmes des nanosatellites, 

avantages, inconvénients et défis des nanosatellite;

3. Applications des nanosatellites.

II.1 Introduction aux nanosatellites

II.1.1 Historique des nanosatellites

A.  Satellites miniaturisés

Les satellites miniaturisés ou petits satellites sont des satellites artificiels avec des poids exceptionnellement 

faibles, généralement moins de 500 kg, et des petites dimensions. La technologie des satellites miniaturisés a 

ouvert une nouvelle ère de l'ingénierie satellitaire en diminuant le coût des missions spatiales et sans réduire les 

performances.

Les satellites miniaturisés peuvent être classés en quatre groupes basés sur leur masse :

 minisatellites (entre 100 et 500 kg) ;

 microsatellites (entre 10 et 100 kg) ;

 nanosatellites (entre 1 et 10 kg) ;

 picosatellites (entre 0,1 et 1 kg).

Les satellites miniaturisés traditionnels sont des minisatellites ou des microsatellites. Le CubeSat, avec une 

masse maximale de 1 kg, est un exemple de grand picosatellite ou de petit nanosatellite.

Figure II.1 : Classification des satellites miniaturisés

B.  Naissance des nanosatellites

Les communications par satellite sont le résultat de la recherche dans le champ des communications et des 

technologies spatiales dont l'objectif est d'augmenter la distance et les capacités des communications avec les 

plus bas coûts possibles.

La Deuxième Guerre mondiale a stimulé l'expansion de deux technologies bien distinctes : les missiles et les 

micro-ondes. L'expertise définitivement acquise dans l'utilisation combinée de ces deux techniques a ouvert l'ère 

des communications par satellite.

Le premier satellite traditionnel avec émetteur radio destiné aux études atmosphériques, Spoutnik, de masse 83,6 

kg, a été lancé et placé sur une basse orbite elliptique terrestre (LEO: Low Earth Orbit, apogée : 947 km, périgée: 

215 km, inclinaison : 65°) par l'Union soviétique, le 4 octobre 1957.  Le Spoutnik n’est resté en orbite que 

pendant trois mois avant d’être consumé alors qu’il pénétrait dans l'atmosphère terrestre.

Les missions des satellites traditionnels sont extrêmement coûteuses (les coûts se chiffrent en milliards de 

dollars), depuis la phase de conception jusqu’à l’exploitation, en passant par la construction et le lancement. Par 

conséquent, l'industrie aérospatiale et la communauté de la recherche ont commencé à diriger leur attention sur 

0.1 1 10 100 1000500

[kg]

pico nano micro mini moyen

grand (>1000 kg)
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des missions qui impliquent de nombreux satellites, petits et peu coûteux tels que les nanosatellites et les 

picosatellites.

Le 12 décembre 1961, le premier nanosatellite nommé « Orbiting Satellite Carrying Amateur Radio » (OSCAR) 

de masse 4,5 kg a été lancé et placé sur une très basse orbite terrestre (VLEO : Very Low Earth Orbit, apogée : 

431 km, périgée : 245,30 km, et inclinaison : 81,14°) à Vandenberg AFB (Vandenberg Air Force Base, 

Californie, aux États-Unis) et n’est resté en orbite que pendant 22 jours.

Le 27 janvier 2000, le lancement d’ASU-OSCAR37, pesant 6 kg, à bord d'une fusée Minotaure-1, à partir de 

Vandenberg AFB, et sa mise sur orbite basse (apogée : 799 km; périgée : 746,30 km ; inclinaison : 100,19°) ont

fait renaitre les nanosatellites pour radio amateur. Ce satellite est actuellement non-opérationnel.

Le 30 juin 2003, CubeSat-OSCAR 55, le premier nanosatellite réussi pour radio amateur qui ait fonctionné 

jusqu’à présent, a été lancé depuis la base de Baikonur Cosmodrome, au Kazakhstan, à bord d'un Dnepr et a été 

inséré en orbite basse terrestre (apogée : 831 km et périgée : 816,30 km ; inclinaison : 98,72°). Ce satellite est de 

taille 10 × 10 × 10 cm

3

, et pèse 1 kg. Il s'agissait d'un projet du laboratoire Matunaga LSS (Laboratory for Space 

Systems) du Tokyo Institute of Technology, au Japon.

Un historique plus étendu des nanosatellites [8] est montré dans l’Annexe I, Tableau A.I.1.

II.1.2 Caractéristiques générales d’un système nanosatellitaire

A.  Architecture d’un système de communication par satellite

Le système satellitaire est composé d'un segment spatial, d’un segment de contrôle et d'un segment terrestre. [1]

 Segment spatial : contient un ou plusieurs satellites actifs et satellites de secours organisés en constellation.

 Segment de contrôle : composé de toutes les installations terrestres dédiées au contrôle et à la surveillance 

des satellites, également nommées stations TTC (Tracking, Telemetry, Command), et également à la gestion 

du trafic et des ressources associées à bord du satellite (stations de gestion du réseau).

 Segment terrestre : se compose de toutes les stations terrestres.

Figure II.2 : Architecture d’un système de communication par satellite
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B.  Types d’orbite

La trajectoire du satellite dans l'espace est appelé son orbite, l'orientation du satellite dans l'espace est appelée

son attitude. Il y a quatre types d’orbite principaux pour les communications par satellite [2] : LEO, MEO, GEO 

et HEO qui sont illustrés sur la Figure II.3 et caractérisés dans le Tableau II.1.

Figure II.3 : Types d’orbite des satellites

Types d’orbite

LEO

(orbite polaire)

MEO

HEO

(orbite de Molniya)

GEO

Inclinaison 90

o

Environ 50

o

Environ 64° 0

o

Altitude 200 – 2000 km 2000 – 35 786 km 500 – 39 900 km 35 786 km

Vélocité 6,5 – 8,2 km/s 6,9 - 7,8 km/s 1,5 – 10 km/s 3,1 km/s

Période orbitale 1,5 – 2 h 5 – 10 h 12 h 24 h

Durée de visibilité 15 – 20 mn 2 – 8 h 8 – 11 h Permanente

Retard de 

propagation

Quelques 

millisecondes

Dizaines de 

millisecondes

Centaines de 

millisecondes

>250 millisecondes

Bilan de liaison

Favorable, 

compatible avec les 

petits satellites et les

terminaux 

utilisateurs portables

Moins favorable

Pas favorable pour 

les petits terminaux 

portables

Pas favorable pour 

les petits terminaux 

portables

Contraintes de 

l'environnement

Faibles Faibles / moyennes Moyennes / fortes Faibles

Couverture 

terrestre 

instantanée

(diamètre à 10° 

d'élévation)

 6000 km  12 000 –15 000 km

16 000 km (apogée) 16 000 km

Exemples de

systèmes

IRIDIUM,

GLOBALSTAR

TELEDESIC,

SKYBRIDGE,

ORBCOMM, etc.

ODYSSEY,

INMARSAT P2, etc.

MOLNYA,

ARCHIMEDE, etc.

INTELSAT,

INTERSPOUTNIK,

INMARSAT, etc.

LEO : Low Earth Orbit

MEO : Medium Earth Orbit

HEO : High Earth Orbit

GEO : GEostationary Orbit

Tableau II.1 : Comparaison des orbites pour les communications par satellite
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C.  Bandes de fréquences

Les bandes de fréquences sont attribuées aux satellites selon les services de radiocommunications avec comme 

objectif de permettre une utilisation compatible avec les systèmes existants.

Les différentes bandes de fréquence utilisées dans les communications par satellite selon la norme IEEE 

américaine sont indiquées dans le Tableau II.2.

Appellation Bande de fréquence

Bande HF (High Frequency) 3 – 30 MHz

Bande VHF (Very High Frequency) 30 – 300 MHz

Bande UHF (Ultra High Frequency) 300 – 1000 MHz

Bande L (Long Wave) 1 – 2 GHz

Bande S (Short Wave) 2 – 4 GHz

Bande C 4 – 8 GHz

Bande X 8 – 12 GHz

Bande Ku (Kurz-Under) 12 – 18 GHz

Bande K (Kurz) 18 – 27 GHz

Bande Ka (Kurz-Above) 27 – 40 GHz

Bande V 40 – 75 GHz

Bande W 75 – 110 GHz

Bande mm 110 – 300 GHz

Tableau II.2 : Bandes de fréquences des communications par satellite

II.2 Technologies nanosatellitaires

Au cours des dernières années, l'industrie aérospatiale, la communauté de la recherche et beaucoup de projets 

spatiaux menés dans les laboratoires universitaires et se sont concentrés sur le développement de nanosatellites 

qui constituent une technologie récente et aux très grandes potentialités.

Cette partie abordera les thèmes des caractéristiques des nanosatellites, de leurs avantages et inconvénients par 

rapport aux satellites traditionnels, du défi représenté par les nanosatellites et les sous-systèmes des 

nanosatellites.

II.2.1 Caractéristiques des nanosatellites

Les caractéristiques des nanosatellites [7] sont indiquées dans le Tableau II.3.

Masse 1 – 10 kg

Dimensions

1 unité CubeSat (longueur × largeur × hauteur : environ 10 × 10 × 10 cm

3

)

1,5 unité CubeSat (10 × 10 × 15 cm

3

), 

2 unités CubeSat (10 × 10 × 20 cm

3

),

3 unités CubeSat (10 × 10 × 30 cm

3

), 

4 unités CubeSat (10 × 10 × 40 cm

3

), 

5 unités CubeSat (10 × 10 × 50 cm

3

), 

6 unités CubeSat (10 × 20 × 30 cm

3

)

Types d’orbite

VLEO (Very Low Earth Orbit, altitude inférieure à 500 km) ou LEO (500 à 

800 km)

Source d'énergie

3,3 V ; 5 V ; 6,5 V ; 8,2 V ; 12 V ; 12,5 V ou 24 V DC suivant la technologie 

de conception de l'alimentation de puissance.

Bande de fréquence VHF (130-160 MHz) ou UHF (400-450 MHz)

Types de modulation BPSK, FSK, AFSK ou GMSK

Puissance émise 750 mW ou 28,75 dBm en moyenne

Sensibilité du récepteur Environ -100 dBm pour un TEB de 10

-5
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Débit descendant 1200, 2400, 4800 ou 9600 bit/s

Débit montant De 300 à 1200 bit/s

Types de protocole de 

communication

Nombreux protocoles disponibles (AX. 25 pour la plupart des usages)

Nombre de nanosatellites 

nécessaires pour couvrir 

la Terre

30 à 60 nanosatellites, suivant l'altitude de l'orbite.

Exemple : une constellation d'environ 60 nanosatellites israéliens en orbite 

terrestre basse (LEO) peut couvrir la Terre.

Coût Inférieur à 1 million de dollars

Durée de vie

2 à 5 ans, suivant de nombreux paramètres tels que le type d'orbite, la charge 

utile, les cycles de l’alimentation, le lancement, etc.

Tableau II.3 : Caractéristiques des nanosatellites

II.2.2 Sous-systèmes des nanosatellites

Un système nanosatellitaire comprend un certain nombre de sous-systèmes [4] décrits ci-dessous :

 Sous-système de détermination et de contrôle de l’attitude (ADC : Attitude Determination and Control 

subsystem) :

- Stabilisation et orientation du satellite dans la direction souhaitée (pour maintenir le faisceau de  l'antenne 

RF pointé sur les zones destinées à la Terre) au cours de la mission, malgré les couples de perturbations 

externes et les forces agissant sur lui.

 Sous-système d’orientation et de navigation (GNC : Guidance and Navigation subsystem) :

- La navigation ou détermination de l'orbite signifie la détermination de la position et de la vitesse du 

satellite ou, de façon équivalente, des éléments orbitaux en fonction du temps.

- L’orientation ou contrôle d'orbite signifie ajustement de l’orbite pour satisfaire à certaines conditions 

prédéterminées.

 Sous-système de poursuite, télémesure et commande (TT&C : Tracking, Telemetry and Command). Il assure 

l'interface entre les systèmes spatial et terrestre :

- La fonction de poursuite désigne la détermination de la position du vaisseau spatial et le suivi de ses 

déplacements en utilisant l’angle, la distance et la vitesse de l'information.

- La fonction de télémesure permet de collecter, coder et transmettre des informations pour les autres sous-

systèmes.

- L’élément de commande reçoit et exécute des commandes de contrôle à distance (télécommande) visant à 

effectuer des changements sur les fonctions de la plate-forme : configuration, position et vitesse.

 Sous-système de commande et de traitement des données (C&DH : Command and Data Handling 

subsystem) :

- Réception, validation et décodage des commandes, et distribution des commandes vers les sous-systèmes et 

constituants appropriés du satellite.

- Réception des données scientifiques et des données d’opération courante venant des autres sous-systèmes et 

composants du satellite, et empaquetage des données en vue de leur stockage sur un enregistreur de données 

ou transmission de ces données vers le sol via le sous-système communications.

 Sous-système d’alimentation électrique (EPS : Electrical Power Subsystem) :

- Le sous-système d'alimentation est constitué des panneaux solaires, des batteries de secours et des systèmes 

d’alimentation électrique qui délivrent la puissance électrique pour les divers sous-systèmes du satellite.

 Sous-système de contrôle thermique (TCS : Thermal Control Subsystem) :

- Maintien de la température de l'équipement intérieur et autour de la structure du satellite à l’intérieur des 

limites requises de température pour chaque phase de la mission.

 Sous-système structures et mécanismes :

- Supporte tous les autres sous-systèmes du véhicule spatial, attache le véhicule spatial à l’infrastructure de 

lancement.
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 Sous-système antenne :

- Réception et transmission des signaux micro-ondes, transmis dans une bande de fréquence donnée et avec 

une polarisation donnée par les stations terrestres situées dans une région particulière sur la surface de la 

Terre.

 Sous-système communication de la charge utile :

- Réception des signaux micro-ondes venant d’une zone terrestre donnée.

- Amplification de la fréquence porteuse.

- Conversion de la fréquence porteuse de la liaison montante vers la liaison descendante.

- Transmission des signaux micro-ondes vers une zone terrestre donnée.

II.2.3 Avantages et inconvénients des nanosatellites

Les avantages et les inconvénients des nanosatellites par rapport aux satellites traditionnels [9] sont résumés dans

le Tableau II.4.

Avantages

« Plus rapide, plus petit, meilleur et moins cher »

Inconvénients

 Temps de construction plus rapide.

 Possibilité de rendre  redondants les satellites, ce qui augmente la 

fiabilité du système.

 Réduction de la taille et du coût des stations terrestres.

 Solution idéale pour tester de nouvelles technologies.

 Possibilité d'être lancés en groupe ou en « Piggyback » avec de plus 

grands satellites.

 Réduction des coûts de fabrication et de lancement.

 Pertes financières minimisées en cas d'échec.

 Décroissance orbitale plus 

rapide.

 Durée de vie plus courte.

 Puissance d’émission plus 

faible.

 Plus faible capacité d’emport 

matériel.

Tableau II.4 : Avantages et inconvénients des nanosatellites

II.2.4 Défis des nanosatellites

Les nanosatellites qui sont de masse réduite, à bas coût et dédiés à des missions en orbites VLEO ou LEO ont 

présenté des nouveaux défis pour la recherche tels que :

 Une nécessité de progrès dans les microtechnologies, la miniaturisation électronique, la manipulation et le 

stockage des données, la disponibilité de l'énergie, les technologies d'imagerie, l'intelligence autonome et les 

performances associées.

 L’apparition de nouveaux petits lanceurs sur le marché (par exemple : missiles militaires modifiés de longue 

portée et intercontinentaux, structure spéciale pour les charges utiles auxiliaires qui permet de lancer 

simultanément plusieurs petits satellites), requérant des innovations dans les systèmes de propulsion et 

d’autres technologies, ainsi que dans la mise en service et la gestion d’applications plus vastes dans les futurs 

systèmes de lancement.

 Une réduction continue de la complexité et des coûts des missions.

 L’émergence de nouveaux marchés potentiels avec les états et les clients commerciaux ou académiques.

II.3 Applications des nanosatellites

Les nanosatellites ont été utilisés dans diverses applications telles que [9] :

 Les télécommunications. De nombreuses applications peuvent être mentionnées, telles que :

- Voix : téléphonie, téléphonie personnelle, téléphones publics distants.

- Messagerie : radiomessagerie, relevé de compteur  (meter reading).

- Données : distribution de logiciels, bases de données, email, réseau de terminaux VSAT, etc.

- Diffusion : radio numérique, télévision radiodiffusée, télédiffusion directe.

- Multimédia : télémédecine, téléenseignement, téléconférence, télétravail, vidéo à la demande, téléachat,

- Internet.

 L’observation de la Terre. Cela couvre les activités liées à la collecte des données et des images pour les 

prévisions de tremblements de terre, de tempêtes et d'activités volcaniques.
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 La recherche scientifique. Les nanosatellites peuvent être un moyen économique et rapide d'explorer des 

objectifs scientifiques à petite échelle et bien ciblés (par exemple : surveillance de l'environnement des 

rayonnements dans l'espace, mise à jour du champ de référence géomagnétique international, etc.) ou de 

fournir un démonstrateur de concepts opérationnels avant le développement de l'instrumentation à grande 

échelle.

 Les démonstrations des technologies. Les nanosatellites peuvent être un moyen attrayant et à faible coût de 

tester, vérifier et évaluer des nouvelles technologies ou des services sur un environnement orbital réel avec 

des risques acceptables avant la mise en œuvre d’une mission coûteuse en grandeur nature.

 Les applications militaires. Les nanosatellites peuvent être utilisés dans un but militaire, le plus souvent pour 

rassembler des renseignements (satellites de communication), ou alors comme une arme militaire.

 La formation académique. Les programmes dédiés aux nanosatellites sont un moyen de renforcer l’expertise 

industrielle et de former des étudiants, des scientifiques et des ingénieurs dans les compétences liées à 

l'espace, en leur permettant d’avoir une expérience pratique de toutes les étapes (techniques et de gestion) 

d'une mission spatiale particulière (depuis la conception, la production, le test, jusqu’au lancement et à 

l’exploitation orbitale).

II.4 Conclusion

Au travers de ce chapitre, la problématique des nanosatellites a été introduite, en commençant par un bref 

historique ; les technologies des nanosatellites et leurs applications ont été décrites en passant par une vue 

ensemble d’un système nanosatellitaire incluant, les caractéristiques générales d’un tel système, les

caractéristiques des nanosatellites, leurs sous-systèmes, les avantages et inconvénients des nanosatellites, les 

défis des nanosatellite, et les applications des nanosatellites. Ces informations de base nous aideront à entrer 

dans le prochain chapitre qui décrira des éléments de conception d’un système nanosatellitaire.
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CHAPITRE III

Partie théorique : éléments de conception d’un système nanosatellitaire

Dans le chapitre II, une vue d'ensemble d’un système nanosatellitaire, avec ses technologies et applications

associées, a été décrite. Ce chapitre III abordera quelques éléments de conception d’un système nanosatellitaire 

liés à son architecture générale, à sa couche physique et sa couche liaison, à la détermination de l’orbite, à 

l’optimisation d’une constellation de nanosatellites, et aux bilans de liaison.

III.1 Définition de la mission

Pour simplifier le travail, on s’appuiera sur les hypothèses prises pour le nanosatellite OUFTI-1 qui a été 

développé pour des applications de télécommunications (radio amateur) par l’Université de Liège en Belgique.

Les principales hypothèses sont résumées dans le Tableau III.1. Le nanosatellite fictif qui sera l’objet de l’étude 

sera appelé, par la suite et tout au long du rapport, KAMPUCH-1.

Masse 1 kg

Dimensions 1 unité CubeSat (longueur × largeur × hauteur : environ 10 × 10 × 10 cm

3

)

Type d’orbite

LEO

Apogée (h

a

) : 1447 km

Périgée (h

p

) : 354 km

Inclinaison (i) 71°

Argument de périgée (� )
30° (défini pour les simulations)

R.A.A.N (�)
45° (défini pour les simulations)

Anomalie vraie (V) 15° (défini pour les simulations)

Élévation (�)
5°

Bande de fréquence

- Bande VHF : 145 MHz pour la liaison descendante

- Bande UHF : 435 MHz pour la liaison montante

Source d'énergie

Batterie : de 3,3 à 7,2 V. Elle se compose de trois convertisseurs fournissant

trois tensions différentes (3,3 V ; 5 V ; 7,2 V) pour alimenter les divers sous-

systèmes suivant la tension requise.

Types de protocole

- D-STAR : utilisé dans les communications de radio amateur de la charge utile

- AX.25 : utilisé pour la télémétrie / télécommande (TM/TC)

- Balise : utilisée pour envoyer 12 paramètres critiques en code Morse

Débits

- D-STAR : 4800 bit/s 

- AX.25 : 9600 bit/s

- Balise : 12 mots par minute

Types de modulation

- D-STAR : GMSK

1

- AX.25 : FSK

- Balise : GMSK or FSK (défini par l'utilisateur)

Puissance émise

- D-STAR; AX.25 : environ 750 mW ou +28,7 dBm

- Balise : environ 100 mW ou +20 dBm

Sensibilité du récepteur Inférieure à -100 dBm pour un TEB (Taux d’Erreur Binaire) de 10

-5

Coût Inférieur à 1 million de dollars

Durée de vie 1 à 2 ans (4,8 ans estimé par STK)

Tableau III.1 : Caractéristiques du nanosatellite KAMPUCH-1

1

GMSK (Gaussian Minimum Shift Keying) est une modulation FSK à phase continue. Les informations numériques sont 

filtrées par un filtre gaussien afin de diminuer la bande passante (ou la puissance de la bande latérale) avant d’être appliquées 

à une modulation FSK. 0,5-GMSK désigne la modulation GMSK caractérisée par un produit bande passante × durée symbole 

de 0,5, lequel offre une haute efficacité spectrale. La réduction de la bande passante vient cependant aux dépens des 

interférences inter-symboles (Inter-Symbol Interference, ISI). C'est pourquoi la modulation GMSK requiert un rapport signal 

sur bruit E

b

/N

0

plus élevé pour obtenir le même TEB.



Page | 12

III.2 Architecture système

Un système satellitaire comporte trois segments : le segment spatial, le segment de contrôle et le segment

terrestre. Dans notre cas de figure, il n’y aura que deux segments : le segment spatial et le segment terrestre car

le segment de contrôle est considéré inclus dans le segment terrestre. Cette section va aborder l'architecture du

segment terrestre, en donnant un aperçu de la station terrestre, du centre de contrôle de mission (Mission Control

Center, MCC) et du relais D-STAR [4].

III.2.1 Architecture du segment spatial

L’architecture du segment spatial, qui est illustrée sur la Figure III.1, comprend un ou plusieurs satellites actifs et 

des satellites de secours organisés en constellation.

Figure III.1 : Architecture du segment spatial

III.2.2 Architecture du segment terrestre

L'architecture du segment terrestre se compose des quatre éléments : la station terrestre (en anglais : Ground

Station), le centre de contrôle de mission (en anglais : Mission Control Center, MCC), le relais D-STAR (en 

anglais : D-Star Repeater), et le module D-STAR de communication par satellite (en anglais : Satellite

Extension). L'architecture du segment terrestre est illustrée sur la Figure III.2.

Figure III.2 : Architecture du segment terrestre

A. Station terrestre

La station terrestre est responsable de :

- la liaison RF entre les satellites et le système terrestre. Elle contrôle les rotors d’antenne, le contrôleur du

nœud terminal (en anglais : Terminal Node Controller, TNC), et les émetteurs-récepteurs utilisés ;

- la liaison entre la station MCC et toutes les stations terrestres ou tous les réseaux des stations terrestres.

B. Centre de contrôle de mission

Le centre de contrôle de mission du système KAMPUCH-1 permet aux opérateurs de commander et de contrôler

les nanosatellites depuis des terminaux via le serveur opérationnel. Il est conçu pour exécuter les fonctions

suivantes :

- préparation et transmission des télécommandes manuellement et automatiquement ;

- réception et traitement des télémesures manuellement et automatiquement ;

- collecte et récupération des données ;
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- affichage des données ;

- mises à jour en temps réel.

C. Relais D-STAR

Le système D-STAR (en anglais : « Digital Smart Technologies for Amateur-Radio ») est un système de

télécommunications numériques développé par le « Japanese Amateur-Radio League » (JARL) en 2003. C'est la

charge utile principale du système de communication du nanosatellite KAMPUCH-1 et qui est utilisée pour les

communications de radio amateur (en anglais : ham-radio communication).

 Caractéristiques du D-STAR

Les principales caractéristiques du D-STAR sont décrites ci-dessous :

- Il offre deux modes de communication, le mode DD (en anglais : Digital Data) et le mode DV (en anglais :

Digital Voice). Le mode DD transmet et reçoit seulement des données, avec un débit de 128 kbit/s, tandis

que le mode DV transmet des voix et des données simultanément, avec un débit de 4,8 kbit/s (données : 1,2

kbit/s et voix : 3,6 kbit/s avec codage AMBE et modulation GMSK). Le mode DV peut fonctionner dans la

bande 144 MHz (VHF), 440 MHz (UHF), et 1,2 GHz (bande L), tandis que le mode DD n’exige que la

bande 1,2 GHz (bande L). Le mode DV qui présente un intérêt à KAMPUCH-1 fournit une bande passante

limitée d’environ 6 kHz.

- Le D-STAR utilise la modulation GMSK avec un produit de 0,5 de la durée symbole et de la bande

passante, dénotée 0,5-GMSK qui offre une grande efficacité de la bande passante.

D. Module D-STAR de communication par satellite

Le module D-STAR de communication par satellite (en anglais : Satellite Extension) doit être ajouté entre le 

relais D-STAR et le satellite KAMPUCH-1 pour rendre le système de communication complètement compatible 

avec le réseau D-STAR.

III.3 Couche physique et couche liaison

Cette section abordera succinctement la couche physique et la couche liaison, et décrira le protocole AX.25, le

protocole D-STAR et la balise ([7], [8]). Une description plus détaillée est fournie en Annexe II, A.II.1.

Le nanosatellite KAMPUCH-1 utilise deux types de modulation : avec le protocole AX.25 et la balise, la 

modulation 2-FSK pour la voie de télémesure et télécommande (TM/TC), et avec le protocole D-STAR la 

modulation 0,5-GMSK pour les communications de radio amateur. Les valeurs d’E

b

/N

0

requises suivant le

schéma de modulation et codage et le TEB requis sont montrées dans le Tableau III.2. Les options

sélectionnables dans l’outil de calcul de bilan de liaison Excel développé et utilisé au cours de ce stage (cf. 

section §III.6 Bilans de liaison) sont : AFSK/FM (en anglais : Audio Frequency Shift Keying on an FM Carrier),

une forme spéciale de la modulation FSK développée par M. James Miller et nommée « G3RUH», la

démodulation FSK non-cohérente (en anglais : Non-Coherent FSK), GMSK, BPSK et QPSK.

Type de modulation Codage TEB E

b

/N

0

requis [dB]

AFSK/FM aucun 10

-5

23,2

AFSK/FM aucun 10

-4

21,0

G3RUH FSK aucun 10

-5

18,0

G3RUH FSK aucun 10

-4

16,7

FSK non-cohérente aucun 10

-5

13,8

FSK non-cohérente aucun 10

-4

13,4

FSK cohérente aucun 10

-5

11,9

FSK cohérente aucun 10

-4

10,5

BPSK aucun 10

-6

10,5

QPSK aucun 10

-6

10,5

GMSK aucun 10

-5

9,6

BPSK aucun 10

-5

9,6

QPSK aucun 10

-5

9,6

GMSK aucun 10

-4

8,4
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BPSK Codage convolutionnel

2

(R=1/2, K=7) 10

-6

4,8

BPSK Convolutionnel (R=1/2, K=7) et RS

3

(255,223) 10

-6

2,5

BPSK Convolutionnel (R=1/6, K=15) et RS (255, 223) 10

-7

0,8

Tableau III.2 : Performances en E

b

/N

0

suivant le schéma de modulation et codage

III.3.1 Protocole AX.25

Le nom AX.25 provient de la recommandation X.25 du CCITT, l’ajout de la lettre A signifiant « Amateur ». Par

conséquent, AX.25 est un protocole de la couche liaison pour la radio amateur en mode paquet. Pour

KAMPUCH-1, le protocole AX.25 sera utilisé pour la voie TM/TC avec la modulation 2-FSK, et un débit de 9,6

kbit/s. Il y a trois types généraux de trame AX.25 (structure montrée en Annexe II, A.II.1 A) :

1. trame utile (trame I, en anglais : Information frame, I frame) ;

2. trame de surveillance (trame S, en anglais : Supervisory frame, S frame) ;

3. trame non-numérotée (trame U, en anglais : Unnumbered frame, U frame).

III.3.2 Protocole D-STAR

Le protocole D-STAR offre deux modes de communication : le mode DV (Digital Voice) et le mode DD (Digital 

Data). Le mode DV peut opérer dans les bandes de fréquence 144 MHz (bande VHF), 440 MHz (bande UHF),

et 1,2 GHz (bande L), tandis que le mode DD n’exige que la bande 1,2 GHz.

KAMPUCH-1 utilise le mode DV (4,8 kbit/s) avec le protocole D-STAR et la modulation GMSK pour des

communications de radio amateur. La structure de la trame D-STAR en mode DV est montrée en Annexe II,

A.II.1 B.

III.3.3 Balise

Pour KAMPUCH-1, la balise, avec un débit de 12 mots par minute et la modulation 2-FSK, est utilisée pour

transmettre 12 paramètres critiques en code Morse. La structure de la trame de la balise est montrée en Annexe

II, A.II.1 C.

III.4 Détermination de l’orbite

Cette section s’intéresse à la détermination de l’orbite d’un nanosatellite.

III.4.1 Éléments orbitaux classiques

Les éléments orbitaux dits de Kepler ou classiques [5] sont utiles pour les opérations spatiales et pour déterminer

quatre paramètres au sujet de l’orbite, à savoir : la taille de l’orbite, la forme de l’orbite, l’orientation du plan 

dans l’espace et la position du satellite. Ces éléments orbitaux classiques sont indiqués dans le Tableau III.3 et 

illustrés sur la Figure III.3.

Il y a lieu de définir maintenant quelques termes courants de mécanique orbitale :

 Périgée : Le point où le satellite est le plus proche de la Terre.

 Apogée : Le point où le satellite est le plus éloigné de la Terre.

 Orbite équatoriale : inclinaison i = 0° ou 180°, le plan de l’orbite est contenu dans le plan équatorial.

2

Codage convolutionnel : un code convolutionnel opère au niveau de l’octet, et les bits complémentaires sont ajoutés à 

chaque mot. Cependant, les erreurs sont corrigées sur une base séquentielle (bit par bit).  Le plus populaire de ces méthodes

est le système de codage ou de décodage convolutionnel de Viterbi, ainsi nommé par référence à son inventeur, Andrew 

Viterbi. Il y a deux paramètres qui configurent le degré du codage : le taux de codage R et la longueur de contrainte K du 

code. La longueur de contrainte K est le nombre des symboles en sortie qui sont affectés par les symboles d’entrée. Un 

exemple de codage convolutionnel est le code de Viterbi (R=1/2, K=7).  

3

Code bloc : un décodeur bloc opère sur un bloc entier de données. Les bits supplémentaires de codage sont ajoutés à la fin 

du bloc. Le plus populaire des codages bloc est connu sous le nom de « Reed-Solomon » (RS), bien qu'il y ait beaucoup 

d'autres formes de codage bloc. Pour le codage RS, deux paramètres sont utilisés : la longueur n (en octets) du bloc de 

symboles de données utiles et la longueur k (en octets) du bloc de symboles du mot code (en anglais : code word). 

L'encodeur code un bloc de n symboles de données utiles (bits) en un mot code de k symboles. Donc les erreurs sont 

corrigées au niveau bloc (ou trame). Voici un exemple de codeur Reed-Solomon : k = 255 octets, n = 223 octets.
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 Orbite prograde : 0° ≤ i < 90°, le satellite gravite dans la même direction que la Terre (rotation vers

l’Est autour de la Terre).

 Orbite polaire : i = 90°, le satellite gravite au-dessus des pôles.

 Orbite rétrograde : 90° < i ≤ 180°, le satellite gravite dans la direction opposée à la rotation de la Terre 

(rotation vers l’Ouest autour de la Terre).

 Axe d’équinoxe vernal : axe qui est pris comme la direction principale du centre du Soleil au centre de 

la Terre, le premier jour du printemps.

Élément Nom Description Définition Remarque

a Demi-grand axe Taille de l’orbite

La moitié de la distance 

entre l’apogée et le 

périgée de l’ellipse

La période orbitale et 

l'énergie dépendent de la 

taille de l’orbite.

e Excentricité Forme de l’orbite

Le rapport de la moitié 

de la distance séparant

les foyers (c) et du

demi-grand axe

- Cercle : e = 0

- Ellipse : e < 1

- Parabole : e = 1

- Hyperbole : e > 1

i Inclinaison

Orientation du plan 

orbital (inclinaison 

du plan orbital)

L'angle entre le plan 

orbital et le plan 

équatorial, mesuré dans 

le sens antihoraire au 

nœud ascendant.

- Équatorial : i = 0° ou 180°

- Prograde : 0° ≤ i < 90°

- Polaire : i = 90°

- Rétrograde : 90° < i ≤ 180°

Ω

R.A.A.N : 

ascension droite 

du nœud 

ascendant 

Rotation du plan 

orbital autour de la 

Terre

L’angle, mesuré vers 

l'Est, entre l'équinoxe 

vernal et le nœud 

ascendant

0° ≤ Ω < 360°

ω

Argument du 

périgée

Orientation de 

l’orbite dans le plan 

orbital

L’angle, mesuré dans le 

sens du mouvement du 

satellite, formé entre le

nœud ascendant et le 

périgée

0° ≤ ω < 360°

ν Anomalie vraie

Position du satellite 

sur son orbite

Angle, mesuré dans le 

sens du mouvement du 

satellite, du périgée à la 

position du satellite

0° ≤ ν < 360°

Tableau III.3 : Éléments orbitaux classiques

III.4.2 Caractérisation des orbites

Les principaux paramètres caractérisant les différents types d'orbite sont indiqués dans le Tableau III.4 [5]. Les 

paramètres orbitaux complets sont donnés en Annexe II, A.II.4 A. On y trouvera également une brève 

explication des relations qui lient certains paramètres à d’autres.

Types d’orbite

Paramètres orbitaux

Elliptique Circulaire

LEO VLEO 

MEO 

“Molniya

” 

MEO 

“Tundra” 

LEO 

Altitude de l’apogée (h

a

) [km] 1447,00 370,00 39105,00 46340,00 650,00

Altitude du périgée (h

p

) [km] 354,00 368,00 1250,00 25231,00 650,00

Inclinaison (i) [degrés] 71,00° 40,02° 63,4° 63,4° 72°

R.A.A.N (�) [degrés] 45,00 45,00 45,00 45,00 45,00

Argument du périgée (�) [degrés] 30,00 30,00 30,00 30,00 0,00

Anomalie vraie (v) [degrés] 15,00 15,00 15,00 15,00 45,00

Tableau III.4 : Différents types d’orbites
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Éléments orbitaux classiques

Géométrie elliptique Axe de l’équinoxe vernal 

Origine géométrique des sections coniques

Figure III.3 : Eléments orbitaux classiques 

III.4.3 Zone de couverture, durée de visibilité et nombre de satellites nécessaires pour une couverture

continue

La zone de couverture et la durée de visibilité dépendent de deux paramètres : l'altitude de l'orbite et l'angle 

d'élévation.

Les résultats concernant la zone de couverture, la durée de visibilité et le nombre des satellites nécessaires par 

plan (N) pour assurer une couverture continue sous la trace de l'orbite sont indiqués dans le Tableau III.5. Ils ont 

été estimés pour les différents types d’orbite aux altitudes minimale, maximale et moyenne (pour les orbites

elliptiques) du satellite, ou à une altitude constante du satellite (pour les orbites circulaires), et avec un angle 
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d'élévation de 5°. L’influence de l’angle d’élévation sur ces mêmes paramètres pour le cas particulier d’une 

orbite LEO elliptique peut être observée dans le Tableau III.6. Tous ces résultats ont été obtenus sous Matlab en 

appliquant les formules données dans l'Annexe II, A.II.2. Nous pouvons observer que :

- Si l’altitude d’orbite   la zone de couverture  et la vélocité du satellite   la durée de visibilité 

 le nombre N de satellites nécessaires pour assurer une couverture continue sous la trace de l’orbite .

- Si l’angle d’élévation   la zone de couverture   la durée de visibilité   le nombre N des 

satellites nécessaires pour assurer une couverture continue sous la trace de l’orbite .

Type d’orbite

LEO elliptique, période orbitale (T) = 103,00 minutes

Altitude minimale Altitude maximale Altitude moyenne

Altitude de l’orbite [km] 354,00 1447,00 900,50

Rayon de l’orbite [km] 6732,14 7825,14 7278,64

Angle de nadir [Degrés] 54,29 70,70 60,80

Angle central [Degrés] 14,30 30,71 24,20

Longueur de l’empreinte [km] 3183,34 6837,25 5387,20

Superficie de l’empreinte [km

2

] 7917743,81 35845129,46 22457032,18

Vélocité du satellite [m/s] 6863,96 7978,36 7400,21

Durée de visibilité [minutes] 6,65 16,60 12,13

Nombre de satellites nécessaires pour 

une couverture continue, N

7 16 9

Type d’orbite

VLEO elliptique, période orbitale (T) = 91,93 minutes

Altitude minimale Altitude maximale Altitude moyenne

Altitude de l’orbite [km] 368,00 370,00 369,00

Rayon de l’orbite [km] 6746,14 6748,14 6747,14

Angle de nadir [Degrés] 70,32 70,37 70,34

Angle central [Degrés] 14,63 14,68 14,66

Longueur de l’empreinte [km] 3258,31 3268,90 3263,61

Superficie de l’empreinte [km

2

] 8293032,38 8346703,93 8319866,43

Vélocité du satellite [m/s] 7685,02 7687,30 7686,16

Durée de visibilité [minutes] 7,06 7,09 7,08

Nombre de satellites nécessaires pour

une couverture continue, N

13 14 13

Type d’orbite

MEO “Molniya” elliptique, période orbitale (T) = 717,79 minutes

Altitude minimale Altitude maximale Altitude moyenne

Altitude de l’orbite [km] 1250,00 39105,00 20177,50

Rayon de l’orbite [km] 7628,14 45483,14 26555,64

Angle de nadir [Degrés] 8,03 56,40 13,84

Angle central [Degrés] 28,60 76,97 71,16

Longueur de l’empreinte [km] 6366,78 17136,45 15842,27

Superficie de l’empreinte [km

2

] 31181392,57 197973707,52 173048953,63

Vélocité du satellite [m/s] 1586,63 9460,34 3874,28

Durée de visibilité [minutes] 11,22 180,01 68,15

Nombre de satellites nécessaires pour 

une couverture continue, N

4 64 11

Type d’orbite

MEO “Tundra” elliptique, période orbitale (T) = 1436,04 

minutes

Altitude minimale Altitude maximale Altitude moyenne

Altitude de l’orbite [km] 25231,00 46340,00 35785,50

Rayon de l’orbite [km] 31609,14 52718,14 42163,64

Angle de nadir [Degrés] 6,92 11,60 8,67

Angle central [Degrés] 73,40 78,08 76,33

Longueur de l’empreinte [km] 16342,54 17383,11 16994,65
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Superficie de l’empreinte [km

2

] 182596906,84 202799432,66 195209174,85

Vélocité du satellite [m/s] 2380,82 3970,76 3074,68

Durée de visibilité [minutes] 68,60 121,69 92,12

Nombre de satellites nécessaires pour 

une couverture continue, N

12 21 16

Type d’orbite LEO circulaire, période orbitale (T) = 97,73 minutes

Altitude de l’orbite [km] 650,00

Rayon de l’orbite [km] 7028,14

Angle de nadir [Degrés] 64,70

Angle central [Degrés] 20,30

Longueur de l’empreinte [km] 4520,21

Superficie de l’empreinte [km

2

] 15880252,72

Vélocité du satellite [m/s] 7530,94

Durée de visibilité [minutes] 10,00

Nombre de satellites nécessaires pour 

une couverture continue, N

10

Tableau III.5 : Zone de couverture, durée de visibilité et nombre de satellites pour assurer une couverture continue de la Terre 

pour différents types d’orbite

LEO elliptique, période orbitale (T) = 103,00 minutes

Angle 

d’élévation

[Degrés]

Longueur de 

l’empreinte

[km]

Superficie de 

l’empreinte

[km

2

]

Vélocité du 

satellite

[m/s]

Durée de 

visibilité 

[minutes]

Nombre des satellites 

nécessaires pour une 

couverture continue, N

5 3183,34 7917743,81 7978,36 6,65 7

10 2468,83 4772173,12 7978,36 5,16 8

15 1953,71 2991997,38 7978,36 4,08 9

20 1578,85 1955314,94 7978,36 3,30 10

25 1299,00 1324138,92 7978,36 2,71 11

Tableau III.6 : Zone de couverture, durée de visibilité et nombre des satellites pour assurer une couverture continue de la 

Terre pour différents angles d’élévation

III.4.4 Temps de vol du périgée à l’anomalie vraie initiale

Les valeurs du temps de vol (Time Of Flight : TOF) du périgée à l’anomalie vraie initiale pour les différents 

types d’orbite sont indiquées dans le Tableau III.7, et ont été obtenues en appliquant les formules de l'Annexe II, 

A.II.2.

Valeur initiale de 

l'excentricité (E)

[rad]

Anomalie 

moyenne (M)

[rad]

Anomalie 

vraie initiale 

(v)

[degrés]

Temps de vol

[minutes]

LEO elliptique 0,24 0,22 15 3,69

VLEO elliptique 0,26 0,26 15 3,83

MEO “Molniya” elliptique 0,11 0,03 15 3,55

MEO “Tundra” elliptique 0,20 0,15 15 34,89

LEO circulaire 0,79 0,79 45 12,22

Tableau III.7 : Temps de vol du périgée à l’anomalie vraie initiale pour différents types d’orbite

III.5 Constellation de satellites

Comme un satellite peut couvrir seulement une portion limitée de la Terre à un instant particulier, une 

constellation de satellites, qui est un groupe de satellites semblables qui sont synchronisés pour graviter autour

de la Terre d'une certaine façon optimale (au sens du nombre total de satellites nécessaires qui doit être 

minimal), est nécessaire pour garantir une couverture continue de la Terre ou une couverture (continue) pour une 

zone spécifique. Par conséquent, le problème de la conception d’une constellation se résume à la question : 

« Quelle est la combinaison d’orbites qui fournit la couverture optimale pour toutes les stations au sol? » Une 

combinaison d’orbites est liée à de nombreux paramètres qui doivent être envisagés, parmi lesquels les 
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caractéristiques des orbites (excentricité, inclinaison, altitude, etc.), la durée de visibilité, l'espacement relatif 

entre les satellites dans les plans adjacents ou l'espacement F entre les plans dans une constellation de Walker, 

etc.

Pour simplifier le problème de la conception d’une constellation de satellites, un ou plusieurs paramètres sont 

supposés fixes comme l'inclinaison, l'espacement F entre les plans dans une constellation de Walker, l'altitude de 

l’orbite du satellite, etc. pour trouver la constellation optimale. Les constellations de satellites sont classées en 

deux catégories : constellations d’orbites circulaires et constellations d’orbites elliptiques. Les résultats obtenus 

pour ces deux types de constellation sont donnés dans les sections qui suivent.

III.5.1 Constellations d’orbites circulaires

Il y a deux types de base de méthodes de conception de constellations d’orbites circulaires : elles relèvent de la 

méthode générale appelée « rue de couverture » (street of coverage) : constellations « Walker Star » et « Walker 

Delta » [3].

A.  Walker Star

On se reportera à l’Annexe A.II.5 A pour une description de ce type de constellation. Le nombre approximatif de 

plans et le nombre total approximatif de satellites sont donnés dans le Tableau III.8. Les résultats dans ce tableau 

ont été estimés pour différents types d’orbite, respectivement aux altitudes minimale, maximale et moyenne 

(pour les orbites elliptiques) du satellite, ou à une altitude constante du satellite (pour les orbites circulaires), et 

avec un angle d'élévation de 5°, et calculés sous Matlab avec une valeur approximative de l'angle central de la 

Terre et un nombre N de satellites requis par plan tels qu’estimés dans la section III.4.3, et indiqués dans le

Tableau III.5.

Type d’orbite

LEO elliptique

Altitude minimale Altitude maximale Altitude moyenne

Angle central [degrés] 14,30 30,71 24,20

Nombre de satellites requis par plan, N 7 16 9

Largueur de la rue [degrés] 8,88 17,40 13,91

Rue de la couverture (SOC) [degrés] 17,76 34,79 27,82

D_SD [degrés] 23,18 48,11 38,11

D_OD [degrés] 17,76 34,79 27,82

Nombre de plans, P 5 8 5

Nombre total de satellites, TNOS 35 128 45

Type d’orbite

VLEO elliptique

Altitude minimale Altitude maximale Altitude moyenne

Angle central [degrés] 14,63 14,68 14,66

Nombre de satellites requis par plan, N 13 14 13

Largueur de la rue [degrés] 4,93 7,05 4,86

Rue de couverture (SOC) [degrés] 9,87 14,10 9,72

D_SD [degrés] 19,57 21,73 19,52

D_OD [degrés] 9,87 14,10 9,72

Nombre de plans, P 9 10 10

Nombre total de satellites, TNOS 117 140 130

Type d’orbite

MEO “Molniya” elliptique

Altitude minimale Altitude maximale Altitude moyenne

Angle central [degrés] 28,60 76,97 71,16

Nombre de satellites requis par plan, N 4 64 11

Largueur de la rue [degrés] 28,47 71,41 70,33

Rue de couverture (SOC) [degrés] 56,94 142,81 140,66

D_SD [degrés] 57,07 148,38 141,49

D_OD [degrés] 56,94 142,81 140,66

Nombre de plans, P 2 4 2

Nombre total de satellites, TNOS 8 256 22
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Type d’orbite

MEO “Tundra” elliptique

Altitude minimale Altitude maximale Altitude moyenne

Angle central [degrés] 73,40 78,08 76,33

Nombre de satellites requis par plan, N 12 21 16

Largueur de la rue [degrés] 73,21 77,65 76,06

Rue de couverture (SOC) [degrés] 146,42 155,30 152,12

D_SD [degrés] 146,61 155,73 152,39

D_OD [degrés] 146,42 155,30 152,12

Nombre de plans, P 2 2 2

Nombre total de satellites, TNOS 24 42 32

Type d’orbite LEO circulaire

Angle central [degrés] 20,30

Nombre de satellites requis par plan, N 10

Largueur de la rue [degrés] 9,55

Rue de couverture (SOC) [degrés] 19,10

D_SD [degrés] 29,85

D_OD [degrés] 19,10

Nombre de plans, P 7

Nombre total de satellites, TNOS 70

Tableau III.8 : Détermination des constellations optimales par la méthode « Walker Star »

Il faut se garder à l’esprit un certain nombre de limitations de la constellation « Walker Star » :

- La distance de séparation perpendiculaire D_SD ou D_OD est minimale au niveau du pôle et maximale 

à l'équateur. Par conséquent, pour couvrir la Terre, la rue de couverture de chaque plan orbital doit être 

espacée uniformément d'une distance d’environ la moitié de l'équateur afin que chaque rue de

couverture touche sa voisine.

- La constellation « Walker Star » nécessite considérablement plus de satellites que les autres types de 

constellation pour couvrir la Terre quand il y a beaucoup de points de croisements (ou chevauchement 

des empreintes des satellites).

- Aux pôles, le chevauchement des empreintes des satellites vont provoquer des interférences et des

couvertures multiples. De plus, les vélocités relatives plus élevées des satellites traversant les plans

voisins vont rendre le maintien des liaisons inter-satellites (Inter-Satellite Link : ISL) très difficile à 

cause du décalage Doppler (Doppler shift). Pour éviter ces problèmes, certaines empreintes doivent être 

désactivées, et cela nécessite également des moyens sophistiqués de poursuite des satellites, de 

commutation entre deux satellites voisins et de rétablissement des liens.

B.  Walker Delta

Le principe de la constellation « Walker Delta » est explicitée en Annexe A.II.5 B.

Le nombre approximatif de plans et de satellites requis par plan pour les différents types d’orbite en utilisant 

cette constellation sont donnés dans le Tableau III.9.

Constellation « Walker Delta » (i : T/P/F)

Type d’orbite LEO elliptique

Inclinaison (i) [degrés] 71

Espacement des plans (F) 1

Altitude 

minimale

Altitude

maximale

Altitude

moyenne 

Nombre de plans (P) 5 8 5

Nombre total de satellites (T) 35 128 45

Unité modèle (Pattern Unit, PU=360°/T) [degrés] 10,29 2,81 8

Espacement des nœuds [degrés] 72 45 72

Espacement des satellites dans le plan [degrés] 51,43 22,5 40

Différence de phase entre les plans adjacents [degrés] 10,29 2,81 8

Type d’orbite VLEO elliptique
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Inclinaison (i) [degrés] 40,02

Espacement des plans (F) 1

Altitude 

minimale

Altitude

maximale

Altitude

moyenne 

Nombre de plans (P) 9 10 10

Nombre total de satellites (T) 117 140 130

Unité modèle (Pattern Unit, PU) [degrés] 3,08 2,57 2,77

Espacement des nœuds [degrés] 40,00 36,00 36

Espacement des satellites dans le plan [degrés] 27,69 25,71 27,69

Différence de phase entre les plans adjacents [degrés] 3,08 2,57 2,77

Type d’orbite MEO “Molniya” elliptique

Inclinaison (i) [degrés] 63,40

Espacement des plans (F) 1

Altitude 

minimale

Altitude

maximale

Altitude

moyenne 

Nombre de plans (P) 2 4 2

Nombre total de satellites (T) 8 256 22

Unité modèle (Pattern Unit, PU) [degrés] 45,00 1,41 16,36

Espacement des nœuds [degrés] 180,00 90,00 180,00

Espacement des satellites dans le plan [degrés] 90,00 5,63 32,73

Différence de phase entre les plans adjacents [degrés] 45,00 1,41 16,36

Type d’orbite MEO “Tundra” elliptique

Inclinaison (i) [degrés] 63,40

Espacement des plans (F) 1

Altitude 

minimale

Altitude

maximale

Altitude

moyenne

Nombre de plans (P) 2 2 2

Nombre total de satellites (T) 24 42 32

Unité modèle (Pattern Unit, PU) [degrés] 15,00 8,57 11,25

Espacement des nœuds [degrés] 180,00 180,00 180,00

Espacement des satellites dans le plan [degrés] 30,00 17,14 22,50

Différence de phase entre les plans adjacents [degrés] 15,00 8,57 11,25

Type d’orbite LEO circulaire

Inclinaison (i) [degrés] 72,00

Espacement des plans (F) 1

7

Nombre de plans (P) 70

Nombre total de satellites (T) [degrés] 5,14

Unité modèle (Pattern Unit, PU) [degrés] 51,43

Espacement des nœuds [degrés] 36,00

Espacement des satellites dans le plan [degrés] 5,14

Tableau III.9 : Détermination de la constellation « Walker Delta » pour différents types d’orbite

Les limitations de la méthode de constellation « Walker Delta » viennent du fait qu’elle ne permet pas d’obtenir 

une couverture au-dessus d’une certaine latitude (qui dépend de la valeur constante de l'inclinaison i), ce qui 

signifie que généralement la couverture polaire est négligée.

III.5.2 Constellations d’orbites elliptiques

Les constellations d’orbites elliptiques sont utilisées pour couvrir une zone spécifique (définie entre des 

emplacements spécifiques) à cause du changement de nombreux paramètres de conception de la constellation 

avec l'altitude du satellite le long de son orbite, tels que l’empreinte de la couverture (la plus grande empreinte de 

la couverture étant à l'apogée et la plus petite au périgée), la durée de visibilité du satellite et la vélocité du 

satellite.
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Pour une constellation d’orbites elliptiques, afin de limiter le nombre de variables dans la conception de la 

constellation, et ainsi sa complexité, la constellation « Walker Star » et « Walker Delta » peuvent être utilisées. 

Cependant, ces deux méthodes ne peuvent pas fournir une constellation optimale pour une constellation d’orbites

elliptiques pour une couverture (continue) de la Terre, car il y aurait de nombreux chevauchements des

empreintes des satellites et, en outre, la couverture ne serait pas assurée au-dessus d’une certaine latitude (qui 

dépend de la valeur constante de l’inclinaison i). Mais une fois que les deux méthodes sont utilisées pour la 

couverture (continue) d’une zone spécifique qui est bien choisie, elles fourniraient une constellation d’orbites

elliptiques bien plus optimale que celle d’orbites circulaires, parce que la couverture en orbites circulaires ne 

s’étend pas vers son apogée comme celle en orbites elliptiques.

III.6 Bilans de liaison

Les bilans de liaison seront établis dans cette section pour évaluer la marge système suivant les qualités de 

service (QoS : Quality of Service) requises en termes de taux d’erreur de bit, et en fonction de la valeur des 

paramètres clés du système comme la puissance émise, la Puissance Isotrope Rayonnée Equivalente (PIRE), les 

pertes de propagation, etc., ce qui permet de vérifier si les liens de communication sont valides. Les bilans de 

liaison doivent prendre en compte l'atmosphère terrestre et les effets de l'environnement spatial sur les satellites. 

Les effets de propagation ont été calculés à partir d’hypothèses très simplificatrices. Mais en Annexe II, A.II.6, 

un rapide sommaire de l’environnement spatial est donné, et le lecteur est prié de s’y reporter.

III.6.1 Outil Excel feuille de calcul de bilans de liaison

Afin de calculer les bilans de liaison du système KAMPUCH-1, un outil Excel de feuille de calcul de bilans de 

liaison entièrement paramétrable a été développé. C’est un outil très puissant permettant de :

- configurer l'ensemble du système nanosatellitaire entre le satellite et la station au sol ;

- calculer les bilans de liaison sur les liens descendant et montant. 

La feuille de calcul Excel est composée de treize onglets :

1. « Title Page » (page de titre)

2. « I.I.R.R »  (Introduction, Instructions, Référence, Révisions);

3. « Orbit & Frequency » (propriétés de l’orbite et choix des fréquences); 

4. « Uplink Budget » (bilan de liaison sur le lien montant); 

5. « Downlink Budget » (bilan de liaison sur le lien descendant); 

6. « System Performance Summary » (résumé des performances du système); 

7. « Transmitters » (systèmes d’émission et pertes en lignes); 

8. « Receivers » (systèmes de réception et pertes en lignes);

9. « Antenna Gains » (gains d’antenne);

10. « Antenna Pointing Losses » (pertes de dépointage des antennes);

11. « Antenna Polarization Loss » (pertes de dépolarisation des antennes);

12. « Atmos. & Ionos. Losses » (perte atmosphériques, pertes ionosphériques et pertes dues à la pluie);

13. « Modulation-Demodulation Method » (sélection des schémas de modulation et codage).

A titre d’exemple, un aperçu des deux onglets « Orbit & Fréquence » et « Downlink Budget » est montré sur la 

Figure III.4 et la Figure III.5 respectivement.
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Figure III.4 : Onglet « Orbit & Fréquence » de l’outil Excel de calcul des bilans de liaison

Figure III.5 : Onglet « Downlink Budget » de l’outil Excel de calcul des bilans de liaison

III.6.2 Structure des bilans de liaison

La structure des bilans de liaison du nanosatellite KAMPUCH-1 est illustrée sur la Erreur ! Source du renvoi 

introuvable. ci-après.
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Figure III.6 : Structure des bilans de liaison

III.6.3 Bilans de liaison du nanosatellite KAMPUCH-1

Dans cette section, nous allons observer l'impact des différents types d’orbite, des fréquences et des types de 

modulation avec ou sans codage, sur les bilans de liaison du système nanosatellitaire KAMPUCH-1, en nous 

focalisant sur la marge système et la puissance minimale admissible de l’émetteur en prenant une marge système 

désirée de 6 dB requis pour un système professionnel.

A.  Bilans de liaison entre le nanosatellite KAMPUCH-1 et la station terrestre de Liège

Les caractéristiques du nanosatellite et de la station terrestre supposée située à Liège, en Belgique, qui ont été 

utilisées pour calculer les bilans de liaison sont fournies dans l'Annexe II, A.II.7, dans le Tableau A.II.9 et le 

Tableau A.II.10 respectivement. Rappelons que les principales caractéristiques du nanosatellite KAMPUCH-1 

sont également résumées dans le Tableau III.1.

Les bilans de liaison entre un nanosatellite KAMPUCH-1 et la station sol de Liège représentés dans le Tableau 

III.10 ont été établis en utilisant l’outil Excel de calcul des bilans de liaison présenté précédemment.
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D’après le Tableau III.10, nous pouvons observer que :

- Pour les liaisons montante et descendante, la marge système pour le protocole D-STAR est de 6,46 dB 

meilleure que celle du protocole AX.25 parce que le protocole D-STAR utilise la modulation GMSK, 

qui est plus performante que la modulation FSK non-cohérente et que le débit des données transmises 

est plus faible que celui du protocole AX.25.

- La marge système pour le canal de balise est de 18,06 dB et 11,42 dB plus élevée que celle du protocole 

AX.25 et D-STAR respectivement parce que la balise utilise un débit de données transmises beaucoup 

plus faible et la modulation FSK non-cohérente.

Type d’orbite LEO (à l’altitude minimale du satellite)

Bande de fréquence UHF/VHF

Liaison montante

(UHF)

Liaison descendante (VHF)

Protocole AX.25 D-STAR AX.25 D-STAR Balise

Station terrestre Satellite 

Puissance transmise [W] 20 20 0,75 0,75 0,10

[dBW] 13,01 13,01 -1,25 -1,25 -10,00

Pertes totales des lignes de 

transmission

[dB] 3,09 3,09 1,02 1,02 1,02

Gain d’antenne [dBi] 13,35 13,35 2,15 2,15 2,15

PIRE [dBW] 23,27 23,27 -0,12 -0,12 -8,87

Liaison montante Liaison descendante

Pertes de dépointage d’antenne [dB] 0,15 0,15 7,60 7,60 7,60

Pertes de dépolarisation d’antenne [dB] 0,23 0,23 0,23 0,23 0,23

Pertes en espace libre [dB] 149,68 149,68 140,14 140,14 140,14

Pertes atmosphériques [dB] 2,10 2,10 2,10 2,10 2,10

Pertes ionosphériques [dB] 0,40 0,40 0,80 0,80 0,80

Pertes dues à la pluie [dB] 0,00 0,00 0,00 0,00 0,00

Niveau du signal isotrope [dBW] -129,29 -129,29 -150,99 -150,99 -159,74

Satellite Station terrestre

Pertes de dépointage d’antenne [dB] 7,60 7,60 0,15 0,15 0,15

Gain d’antenne [dBi] 2,15 2,15 13,35 13,35 13,35

Pertes totales des lignes de 

transmission

[dB] 0,83 0,83 1,85 1,85 1,85

Température de bruit efficace [K] 219,66 219,66 681,13 681,13 681,13

Figure de mérite (G/T) [dB/K] -22,10 -22,10 -16,83 -16,83 -16,83

Densité de puissance du rapport 

signal sur bruit (S/N

0

)

[dBHz] 69,60 69,60 60,62 60,62 51,87

Débit des données [bps] 9600,00 4800,00 9600,00 4800,00 20,00

[dBHz] 39,82 36,81 39,82 36,81 13,01

E

b

/N

0

du système [dB] 29,78 32,79 20,80 23,81 38,86

Méthode de démodulation 

FSK non-

cohérente

GMSK

FSK non-

cohérente

GMSK

FSK non-

cohérente

Codage Aucun Aucun Aucun Aucun Aucun

TEB spécifié 10

-5

10

-5

10

-5

10

-5

10

-5

Perte de mise en œuvre du 

démodulateur

1,00 1,00 1,00 1,00 1,00

E

b

/N

0

requis du système [dB] 13,35 9,72 13,35 9,72 13,35

E

b

/N

0

seuil [dB] 14,35 10,72 14,35 10,72 14,35

Marge système [dB] 15,43 22,07 6,45 13,09 24,51

Marge système désiré [dB] 6,00 6,00 6,00 6,00 6,00

Marge système disponible [dB] 9,43 16,07 0,45 7,09 18,51

Puissance minimale admissible de [dB] 3,58 -3,06 -1,70 -8,34 -28,51
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l’émetteur

[W] 2,28 0,49 0,68 0,15 0,0014

Tableau III.10 : Bilans de liaison entre le nanosatellite KAMPUCH-1 et la station terrestre de Liège

B.  Impact des types d’orbite sur les bilans de liaison

Cette section a pour but d’examiner l'impact du changement du type d'orbite sur les bilans de liaison entre le

nanosatellite KAMPUCH-1 et la station terrestre de Liège, et de déterminer les types d’orbite qui peuvent fournir 

une liaison de communication valide en supposant que les bandes de fréquence UHF/VHF sont utilisées. 

Changer le type d'orbite (LEO → MEO, VLEO) entraînera un changement des pertes en espace libre, comme 

indiqué dans le Tableau III.11.

Bande de fréquence UHF/VHF

Liaison descendante (VHF) Liaison montante (UHF)

Fréquence 145 MHz 435 MHz

Type d’orbite

Pertes en espace libre [dB]

Liaison descendante Liaison montante

LEO 140,14 149,68

VLEO 140,36 149,90

MEO (Molniya) 146,97 156,51

MEO (Tundra) 165,35 174,89

Tableau III.11 : Pertes en espace libre pour différents types d’orbite

Les bilans de liaison entre le nanosatellite KAMPUCH-1 et la station terrestre de Liège pour les différents types 

d'orbite avec les protocoles de la balise, AX.25 et D-STAR sont présentés dans les tableaux A.II.11, A.II.12 et 

A.II.13 respectivement de l’Annexe II. Les remarques que nous pouvons faire à partir de ces tableaux sont les

suivantes :

- Les pertes en espace libre des liaisons montante et descendante pour une orbite LEO sont meilleures de 

respectivement 0,22 dB, 6,84 dB et 25,21 dB que celles des orbites VLEO, MEO « Molniya» et MEO 

« Tundra »,

- Pour les bilans de liaison descendante avec le protocole de la balise, avec une marge système désiré de 

6 dB, le lien de communication n’est valide que pour les orbites LEO, VLEO et MEO « Molniya » et la 

puissance minimale admissible de l’émetteur (du satellite) est de 0,0014 W, 0,0015 W et 0,0068 W

respectivement, ce qui montre que la qualité de la liaison est excellente même pour de très faibles 

puissances d’émission.

- Pour les bilans de liaison descendante avec le protocole AX.25, avec une marge système désiré de 6 dB, 

le lien de communication n’est valide que pour l’orbite LEO et VLEO avec une puissance minimale 

admissible de l’émetteur (du satellite) de 0,68 W et 0,71 W respectivement. Pour les bilans de liaison 

montante avec le protocole AX.25, avec une marge système désiré de 6 dB, le lien de la communication

n’est valide que pour l’orbite LEO, VLEO et MEO « Molniya » avec la puissance minimale admissible 

de l’émetteur (de la station sol) de 2,28 W, 2,40 W et 11,01 W respectivement.

- Pour les bilans de liaison descendante avec le protocole D-STAR, avec une marge système désiré de 6 

dB, le lien de communication est valide pour les orbites LEO, VLEO et MEO « Molniya » avec une 

puissance minimale admissible de l’émetteur (du satellite) de 0,1465 W, 0,1540 W et 0,7066 W

respectivement. Pour les bilans de liaison montante avec le protocole D-STAR, le lien de 

communication n’est valide également que pour les orbites LEO, VLEO et MEO « Molniya » avec une 

puissance admissible minimale de l’émetteur  (de la station sol) de 0,49 W, 0,52 W et 2,38 W

respectivement.

- Donc, avec la condition d’une marge système de 6 dB, il y a deux types d’orbite, LEO et VLEO, qui 

peuvent être utilisés pour établir les liens de communication pour tous les trois types de protocole

utilisés. Cependant, les bilans de liaison pour l'orbite LEO sont meilleurs que ceux pour l’orbite VLEO

en termes de marge système et de puissance de transmission requise. Par conséquent, l'orbite LEO est le 

meilleur choix pour notre système sous ce rapport.
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C.  Impact des fréquences sur les bilans de liaison

Cette section étudiera l'impact du changement des bandes de fréquence sur les bilans de liaison entre le 

nanosatellite KAMPUCH-1 et la station terrestre de Liège avec l’orbite LEO, le satellite étant placé au périgée, 

et avec seulement le protocole AX.25. Les raisons pour lesquelles nous n’envisageons que le protocole AX.25 

est que ce cas constitue celui où la valeur de la marge système est la plus faible parmi tous les types de protocole 

utilisés. Ainsi, si les bilans de liaison sont valides pour le protocole AX.25, ils le seront pour les autres 

protocoles.

Le changement des bandes de fréquence UHF/VHF vers les bandes Ka ou Ku donnera lieu à un changement des 

pertes totales des lignes de transmission (car le type de câble a changé), des types d’antenne et des pertes en 

espace libre. Les pertes en espace libre pour les différentes bandes de fréquence sont données dans le Tableau 

III.12. Les pertes en ligne, les gains d'antenne et les autres pertes sont calculées dans les feuilles de calcul Excel.

Remarque : le satellite est placé au périgée de l’orbite LEO

Bande de fréquence UHF/VHF Ku Ka

Liaison 

descendante

Liaison 

montante

Liaison 

descendante

Liaison 

montante

Liaison 

descendante

Liaison 

montante

Fréquence

[MHz]

VHF

145 MHz

UHF

435 MHz

12 GHz 14 GHz 20 GHz 30 GHz

Pertes en espace 

libre

[dB] 140,14 149,68 178,50 179,83 182,93 186,45

Pertes 

atmosphériques

[dB] 2,10 2,10 0,71 0,86 3,38 2,77

Pertes 

ionosphériques

[dB] 0,80 0,40 0,00 0,00 0,00 0,00

Pertes dues à la 

pluie

[dB] 0,00 0,00 11,57 16,05 32,09 62,79

Tableau III.12 : Pertes en espace libre pour différentes bandes de fréquence

Le bilan de liaison entre le nanosatellite KAMPUCH-1 et la station terrestre de Liège avec le protocole AX.25 

pour les bandes de fréquence UHF/VHF, Ku et Ka est donné dans le Tableau III.13.

Type d’orbite LEO (à l’altitude minimale du satellite)

Protocole AX.25

LIAISON MONTANTE

Bande de fréquence UHF/VHF Ku Ka

Station terrestre

Puissance transmise [W] 20 20 20

[dBW] 13,01 13,01 13,01

Pertes totales des lignes de transmission [dB] 3,09 9,40 14,85

Gain d’antenne [dBi] 13,35 54,20 60,82

PIRE [dBW] 23,27 57,81 58,98

Liaison montante

Pertes de dépointage d’antenne [dB] 0,15 1,03 5,27

Pertes de dépolarisation d’antenne [dB] 0,23 0,23 0,23

Pertes en espace libre [dB] 149,68 179,83 186,45

Pertes atmosphériques [dB] 2,10 0,86 2,77

Pertes ionosphériques [dB] 0,40 0,00 0,00

Pertes dues à la pluie [dB] 0,00 16,17 63,26

Niveau du signal isotrope [dBW] -129,29 -140,32 -198,99

Satellite
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Pertes de dépointage d’antenne [dB] 7,60 0,00 0,00

Gain d’antenne [dBi] 2,15 5,27 5,27

Pertes totales des lignes de transmission [dB] 0,83 1,70 2,40

Température de bruit efficace [K] 219,66 245,16 262,12

Figure de mérite (G/T) [dB/K] -22,10 -20,33 -21,31

Densité de puissance du rapport signal sur 

bruit (S/N

0

)

[dBHz] 69,60 67,95 8,29

Débit des données désiré [bps] 9600,00 9600,00 9600,00

[dBHz] 39,82 39,82 39,82

E

b

/N

0

du système [dB] 29,78 28,13 -31,53

Modulation

FSK non-

cohérente

FSK non-

cohérente

FSK non-

cohérente

Codage Aucun Aucun Aucun

TEB spécifié 10

-5

10

-5

10

-5

Pertes de mise en œuvre du démodulateur 1,00 1,00 1,00

E

b

/N

0

requis du système [dB] 13,35 13,35 13,35

E

b

/N

0

seuil [dB] 14,35 14,35 14,35

Marge système [dB] 15,43 13,78 -45,88

Marge système désiré [dB] 6,00 6,00 6,00

Marge système disponible [dB] 9,43 7,78 -51,88

Puissance minimale admissible de 

l’émetteur

[dB] 3,58 5,23 64,89

[W] 2,28 3,34 3085215,08

LIAISON DESCENDANTE

Bande de fréquence UHF/VHF Ku Ka

Station terrestre

Puissance transmise [W] 0,75 0,75 0,75

[dBW] -1,25 -1,25 -1,25

Pertes totales des lignes de transmission [dB] 1,02 1,81 2,17

Gain d’antenne [dBi] 2,15 5,59 6,90

PIRE [dBW] -0,12 2,53 3,48

Liaison descendante

Pertes de dépointage d’antenne [dB] 7,60 0,00 0,00

Pertes de dépolarisation d’antenne [dB] 0,23 0,23 0,23

Pertes en espace libre [dB] 140,14 178,50 182,93

Pertes atmosphériques [dB] 2,10 0,71 3,38

Pertes ionosphériques [dB] 0,80 0,00 0,00

Pertes dues à la pluie [dB] 0,00 11,66 32,33

Niveau du signal isotrope [dBW] -150,99 -188,56 -215,40

Satellite

Pertes de dépointage d’antenne [dB] 0,15 0,76 2,17

Gain d’antenne [dBi] 13,35 52,87 57,30

Pertes totales des lignes de transmission [dB] 1,85 5,38 7,00

Température de bruit efficace [K] 681,13 434,15 450,93

Figure de mérite (G/T) [dB/K] -16,83 21,11 23,76
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Densité de puissance du rapport signal sur 

bruit (S/N

0

)

[dBHz] 60,62 60,39 34,79

Débit des données désiré [bps] 9600,00 9600,00 9600,00

[dBHz] 39,82 39,82 39,82

E

b

/N

0

du système [dB] 20,80 20,57 -5,03

Modulation 

FSK non-

cohérent

FSK non-

cohérent

FSK non-

cohérent

Codage Aucun Aucun Aucun

TEB spécifié 10

-5

10

-5

10

-5

Pertes de mise en œuvre du démodulateur 1,00 1,00 1,00

E

b

/N

0

requis du système [dB] 13,35 13,35 13,35

E

b

/N

0

seuil [dB] 14,35 14,35 14,35

Marge système [dB] 6,45 6,22 -19,38

Marge système désiré [dB] 6,00 6,00 6,00

Marge système disponible [dB] 0,45 0,22 -25,38

Puissance minimale admissible de 

l’émetteur

[dB] -1,70 -1,47 24,13

[W] 0,6764 0,7131 258,8751

Tableau III.13 : Impact des fréquences sur les bilans de liaison avec le protocole AX.25

Nous pouvons observer que :

- Pour la liaison descendante, le lien de la communication n’est valide que dans les bandes de fréquence 

UHF/VHF et Ku avec une puissance minimale admissible de l’émetteur (du satellite) de 0,6764 W et 

0,7131 W respectivement.

- Pour la liaison montante, seules les bandes de fréquence UHF/VHF et Ku permettent d’établir une 

communication, avec une puissance minimale admissible de l’émetteur (de la station sol) de 2,28 W et 

3,34 W respectivement.

D.  Impact des types de modulation avec ou sans codage sur le bilan de liaison

Cette section examine l'impact du changement du schéma de modulation et codage sur les bilans de liaison entre 

le nanosatellite KAMPUCH-1 et la station terrestre de Liège, avec le protocole AX.25.

Les modulations comparées pour un TEB de 10

-5

sont : FSK non-cohérente non codée, FSK cohérente non 

codée, GMSK non codée, BPSK non codée et BPSK avec un codage convolutionnel. Les performances en E

b

/N

0

de ces schémas de modulation et codage ont été données dans le Tableau III.2 plus haut. 

Le Tableau III.14 met en comparaison les valeurs de la marge système et de la puissance minimale admissible de 

l’émetteur pour les liaisons montantes et descendante pour les différents schémas de modulation et codage 

identifiés.

En liaison montante, la modulation BPSK associée à un codage convolutionnel permet d’obtenir une marge 

système très confortable de 22,87 dB, et de réduire la puissance de l’émetteur jusqu’à 0,41 W.

Les calculs théoriques effectués dans ce chapitre seront complétées dans le prochain chapitre par la mise en 

œuvre d’une série de simulations sous l’environnement logiciel STK.
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Figure III.7 : Courbe d’E

b

/N

0

théorique en fonction du TEB pour différents types de modulation

Bande de fréquence UHF/VHF

Type d’orbite LEO (à l’altitude minimale du satellite)

Protocole AX.25

Liaison montante (UHF)

Type de modulation

FSK

non-cohérente

FSK 

cohérente

GMSK BPSK BPSK

Codage Aucun Aucun Aucun Aucun

Convolutionnel

(R=1/2, K=7)

E

b

/N

0

du système [dB] 29,78

E

b

/N

0

seuil [dB] 14,35 13,60 10,72 10,59 6,91

Marge système [dB] 15,43 16,18 19,06 19,19 22,87

Marge système désiré [dB] 6,00 6,00 6,00 6,00 6,00

Marge système disponible [dB] 9,43 10,18 13,06 13,19 16,87

Puissance minimale

admissible de l’émetteur

[dB] 3,58 2,83 -0,05 -0,18 -3,86

[W] 2,28 1,92 0,99 0,96 0,41

Liaison descendante (VHF)

Modulation

FSK

non-cohérente

FSK 

cohérente

GMSK BPSK BPSK

Codage Aucun Aucun Aucun Aucun

Convolutionnel 

(R=1/2, K=7)

E

b

/N

0

du système [dB] 20,80

E

b

/N

0

seuil [dB] 14,35 13,60 10,72 10,59 6,91

Marge système [dB] 6,45 7,20 10,08 10,21 13,89

Marge système désiré [dB] 6,00 6,00 6,00 6,00 6,00

Marge système disponible [dB] 0,45 1,20 4,08 4,21 7,89

Puissance minimale 

admissible de l’émetteur

[dB] -1,70 -2,45 -5,33 -5,46 -9,14

[W] 0,68 0,5685 0,2931 0,2843 0,1219

Tableau III.14 : Performances de différents schémas de modulation et codage pour le protocole AX.25
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CHAPITRE IV

Partie réalisation et simulation : réalisation d’un simulateur d’analyse 

orbitographique et d’analyse des performances de communication

Les études bibliographique et théorique menées dans les parties précédentes sont complétées dans cette partie par 

la mise en œuvre de simulations, sous l’environnement logiciel STK, de mécanique orbitale, de constellations de 

satellites et de bilans de liaison. Cette partie sera divisée en cinq parties :

1. Présentation de STK

2. Mécanique orbitale pour différents types d’orbite

3. Constellations en couverture continue de la Terre pour différents types d’orbite

4. Constellations pour un système satellitaire optimisé et rentable en basse orbite terrestre entre deux 

endroits précis

5. Bilans de liaison entre un nanosatellite en basse orbite terrestre et une station terrestre située à Liège.

IV.1 Présentation de STK

Le logiciel STK (Satellite Tool Kit), actuellement dans sa version 9.2.2, est un programme complet de 

simulation spatiale développé par la société Analytical Graphics, Inc. (AGI). STK a une large gamme de 

fonctionnalités, et pour cette raison, est largement utilisé dans la communauté spatiale, en particulier pour des 

applications de télédétection. STK est utilisé dans tous les domaines, dans toutes les branches d’activité de 

recherche et de développement, depuis les programmes de recherche universitaire, jusqu’aux opérations de

développement militaire.

STK est pourvu de bases de données bien fournies de villes, ainsi que de satellites actifs (ou autrefois actifs). 

Cependant, les utilisateurs ne sont pas limités à ce qui existe, il est également possible de créer de nouveaux 

satellites ou modèles d’objet basés sur le cahier des charges d’un projet spécifique. Cette flexibilité rend ce 

programme extrêmement polyvalent.

En outre, STK n'est pas limité aux systèmes satellitaires. Des stations terrestres et des véhicules peuvent être 

ajoutés aux scénarii de simulation; des avions, des missiles et des navires peuvent également être insérés dans les 

scénarii. Tous ces objets peuvent être équipés des capteurs, de systèmes radar, d’émetteurs, de récepteurs ou 

d’antennes, soit possédant des propriétés génériques, soit caractérisés par des modèles définis par l'utilisateur lui-

même.

L'interface utilisateur de STK est particulièrement utile et intuitive. Ce logiciel fournit une vue en trois

dimensions (3D) de la Terre et des satellites en orbite, ainsi qu’une représentation en deux dimensions (2D). 

Chaque détail de ces projections peuvent être modifié selon les préférences de l’utilisateur - les images peuvent 

être réalisées sous forme de simples illustrations en noir et blanc, ou peuvent être associées à des modèles de 

terrain réalistes.

STK excelle dans ses capacités de traitement et de modélisation des systèmes multi-objets. Il est possible de 

créer des groupes d'objets dans les constellations, ou de les organiser dans des liens. Cette fonctionnalité a été 

critique pour les simulations réalisées au cours de ce stage. Les fonctionnalités de STK offrent les outils 

nécessaires pour déterminer et ajuster la qualité d'un lien de communication, car elles fournissent des données 

dynamiques sur la qualité du signal, telles que le rapport signal sur bruit (Signal to Noise Ratio, SNR), le gain, la 

durée et le lieu de contact.

La gamme de produits STK a été réorganisée en trois éditions avec des modules STK supplémentaires :

- L’édition de base de STK (STK Basic Edition) est une application gratuite qui offre les fonctionnalités

fondamentales de l’édition professionnelle de STK.

- L’édition professionnelle de STK (STK Professional Edition) est une application orientée ingénierie à 

usage général qui tire sa puissance du moteur de mécanique spatiale breveté par AGI muni de capacités 

de visualisation intégrées. STK Professionnel a une interface utilisateur intuitive, des dizaines de 

milliers des paramètres de sortie des données et une structure modulaire permettant d’étendre 

l'application avec des fonctionnalités de modélisation et d'analyse spécialisées.
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- L’édition avancée de STK (STK Expert Edition) est une suite logicielle qui combine l’édition 
professionnelle de STK avec tous les modules d’analyse avancée de STK (STK / Analyzer, STK / 
Attitude, STK / Communications, STK / Couverture, STK / Radar, STK / Intégration et STK / Terrain, 
Imagerie et Cartes) à un coût réduit. 

- Les modules complémentaires de STK sont des modules qui peuvent être ajoutés aux éditions de 
base, professionnelle ou avancée de STK. 

 
Un aperçu des éditions et des modules de STK est montré sur la Figure IV.1. 
 
 

 
Figure IV.1 : Tableau des produits STK 

AGI offre une version enseignement à usage purement éducatif avec une licence gratuite limitée dans le temps 
pour certains modules STK, pour les établissements universitaires justifiant d’un programme de recherche 
universitaire. Le programme de simulation STK qui a été utilisé au cours de ce stage est une version 
enseignement accordée à TESA, et les modules actifs sont montrés sur la Figure IV.2. 
 

 
 

Figure IV.2 : Licences actives dans la version enseignement de STK 
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IV.2 Mécaniques orbitales pour différents types d’orbite 
 

IV.2.1    Remarques préliminaires 
 
 Tous les scénarii de simulation STK, sauf indication explicite, ont été exécutés sur la même période 

d’analyse de 24 heures, commençant le 7 juillet 2011 à 10:00:00 UTCG (ou 7 juillet 2011 12:00:00 LCLG), 
et se terminant le 8 juillet 2011 10:00:00 UTCG (ou 8 juillet 2011 12:00:00 LCLG). 

 Les différents types d’orbite utilisés pour tous les scénarii de simulation STK, sauf indication contraire, 
sont les suivants : 

o orbites elliptiques : LEO, VLEO, MEO (Molniya) et MEO (Tundra) [toutes sont inclinées] ; 
o orbites circulaires : LEO (inclinée), LEO (polaires). 

 
Les caractéristiques des différents types d'orbite pour les scénarii de simulation STK sont présentées dans le 
Tableau IV.1 ci-dessous. 
 

Types d’orbite 
Paramètres orbitaux 

Elliptique Circulaire 
LEO VLEO MEO 

“Molniya” 
MEO 

“Tundra” 
LEO 

Altitude de l’apogée (ha) [km] 1447,00 370,00 39105,00 46340,00 650,00 
Altitude du périgée (hp) [km] 354,00 368,00 1250,00 25231,00 650,00 
Inclinaison (i) [degrés] 71,00° 40,02° 63,4° 63,4° 72° 
R.A.A.N (𝛺𝛺) [degrés] 45,00 45,00 45,00 45,00 45,00 
Argument du périgée (𝜔𝜔) [degrés] 30,00 30,00 30,00 30,00 0,00 
Anomalie vraie (v) [degrés] 15,00 15,00 15,00 15,00 45,00 

Tableau IV.1 : Caractéristiques des différents types d'orbite utilisés dans les scénarii de simulation STK 
 
 Il n'y a pas de contraintes imposées sur les plans orbitaux pour tous les scénarii de simulation STK, sauf 

indication contraire, et les satellites sont supposés être capables de contrôler leur attitude ainsi que munis de 
liens de communication inter-satellites. 

 Pour toutes les constellations dans les scénarii de simulation STK, l'espacement relatif F entre les satellites 
dans les plans adjacents est égal à 1. 

 
IV.2.2    Objectif des simulations de mécanique orbitale  

 
Une station terrestre et une nanosatellite suivant différents types d’orbite sont créés dans STK. Les capacités de 
calcul de STK sont exploitées afin de déterminer les éléments orbitaux classiques : les temps d’accès, la distance 
oblique et les autres paramètres orbitaux pour chaque type d'orbite. Toutes les fois que cela sera possible ou 
applicable, une comparaison avec les résultats du chapitre III sera faite. 
 

IV.2.3    Résultats de simulation 
 
Les graphiques 3D et 2D des scénarii de simulation pour l’orbite LEO sont présentés sur la Figure IV.3. Pour les 
autres orbites, se reporter à l’Annexe III, A.III.2. Les valeurs de la période orbitale des différents types d’orbite 
calculées par STK et montrées dans le Tableau IV.2 sont les mêmes que celles calculées au chapitre III, dans la 
section III.4.2, l’Annexe II, A.II.4 A. 
 

Type d’orbite Période orbitale [minutes] 

LEO elliptique 103 

VLEO elliptique 91,93 

MEO « Molniya » elliptique 717,79 

MEO « Tundra » elliptique 1436,04 

LEO « inclinée » circulaire 97,73 

LEO « polaire » circulaire 97,73 
Tableau IV.2 : Périodes orbitales des différents types d’orbite 
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Graphique 3D

Graphique 2D

Figure IV.3 : Scénario de simulation pour l’orbite LEO elliptique

A.  Éléments orbitaux classiques

Les éléments orbitaux classiques obtenus par les simulations STK pour les différents types d’orbite considérés 

sont présentés dans les tableaux Tableau IV.3, Tableau IV.4, Tableau IV.5, Tableau IV.6, Tableau IV.7 et 

Tableau IV.8.

Temps 

(UTCG)

Demi-

grand axe 

[km]

Excentricité

Inclinaison 

[deg]

RAAN 

[deg]

Arg. du 

Périgée 

[deg]

Anomalie 

vraie [deg]

Anomalie 

moyenne 

[deg]

7/7/11 

10:00 AM

7278,637 0,075083 71 45 30 15 12,889

7/8/11 

10:00 AM

7278,637 0,075083 71 42,934 28,509 4,392 3,768

Variation de R.A.A.N (d) [degrés/jour]

-2,066

Variation de � (d) [degrés/jour]

-1,491

Tableau IV.3 : Éléments orbitaux classiques de l’orbite LEO elliptique
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Le Tableau IV.2 montre que, pour l’orbite LEO elliptique, la variation de � (d) est d'environ -1,49° par jour, la 

variation de R.A.A.N (d) est d'environ -2,07° par jour, et que l'anomalie moyenne à l’instant de début est 

d'environ 12,89° : on retrouve les mêmes résultats que ceux calculés au chapitre III, dans la section III.4.2, 

l’Annexe II, A.II.4 A.

Temps 

(UTCG)

Demi-

grand axe 

[km]

Excentricité

Inclinaison 

[deg]

RAAN 

[deg]

Arg. du 

Périgée 

[deg]

Anomalie 

vraie 

[deg]

Anomalie 

moyenne 

[deg]

7/7/11 

10:00 AM

6747,137 0,000148 40,02 45 30 15 14,996

7/8/11 

10:00 AM

6747,137 0,000148 40,02 38,729 37,911 257,397 257,413

Variation de R.A.A.N (d) [degrés/jour]

-6,271

Variation de� (d) [degrés/jour]

7,911

Tableau IV.4 : Éléments orbitaux classiques de l’orbite VLEO elliptique

Pour l’orbite VLEO elliptique, la variation de � (d) est d'environ 7,91° par jour, la variation de R.A.A.N (d) 

est d'environ -6,27° par jour, et l'anomalie à l’instant de début est d'environ 15°. Les résultats du chapitre III, 

dans la section III.4.2, l’Annexe II, A.II.4 A, sont confirmés.

Temps 

(UTCG)

Demi-

grand axe 

[km]

Excentricité

Inclinaison 

[deg]

RAAN 

[deg]

Arg. du 

Périgée 

[deg]

Anomalie 

vraie 

[deg]

Anomalie 

moyenne 

[deg]

7/7/11 

10:00 AM

26555,637 0,712749 63,4 45 30 15 1,781

7/8/11 

10:00 AM

26555,637 0,712749 63,4 44,875 30 32,216 3,964

Variation de R.A.A.N (d) [degrés/jour]

-0,125

Variation de � (d) [degrés/jour]

0,000

Tableau IV.5 : Éléments orbitaux classiques de l’orbite MEO « Molniya » elliptique

Pour l’orbite MEO « Molniya » elliptique, la variation de � (d) est sensiblement nulle, la variation de R.A.A.N 

(d) est d'environ -0,13° par jour, et l'anomalie à l’instant de début est d'environ 1,78° : ce sont les mêmes 

résultats que ceux calculés au chapitre III, dans la section III.4.2, l’Annexe II, A.II.4 A.

Temps 

(UTCG)

Demi-

grand axe 

[km]

Excentricité

Inclinaison 

[deg]

RAAN 

[deg]

Arg. du 

Périgée 

[deg]

Anomalie 

vraie 

[deg]

Anomalie 

moyenne 

[deg]

7/7/11 

10:00 AM

42163,637 0,250322 63,4 45 30 15 8,747

7/8/11 

10:00 AM

42163,637 0,250322 63,4 44,993 30 16,679 9,737

Variation de R.A.A.N (d) [degrés/jour]

-0,007

Variation de � (d) [degrés/jour]

0,000

Tableau IV.6 : Éléments orbitaux classiques de l’orbite MEO « Tundra » elliptique

Pour l’orbite MEO « Tundra » elliptique, la variation de � (d) est nulle, la variation de R.A.A.N (d) est 

d'environ -0,01° par jour, et l'anomalie à l’instant de début est d'environ 8,75° : ce sont les mêmes résultats que 

ceux calculés au chapitre III, dans la section III.4.2, l’Annexe II, A.II.4 A.
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Temps 

(UTCG)

Demi-

grand axe 

[km]

Excentricité

Inclinaison 

[deg]

RAAN 

[deg]

Arg. du 

Périgée 

[deg]

Anomalie 

vraie 

[deg]

Anomalie 

moyenne 

[deg]

7/7/11 

10:00 AM

7028,137 0 72 45 0 45 45

7/8/11 

10:00 AM

7028,137 0 72 42,809 0 305,122 305,122

Variation de R.A.A.N (d) [degrés/jour]

-2,191

Variation de� (d) [degrés/jour]

0,000

Tableau IV.7 : Éléments orbitaux classiques de l’orbite LEO « inclinée » circulaire

Pour l’orbite LEO « inclinée » circulaire, la variation de R.A.A.N (d) est d'environ -2.19° par jour, et 

l'anomalie à l’instant de début est d'environ 45° : ce sont les mêmes résultats que ceux calculés au chapitre III, 

dans la section III.4.2, l’Annexe II, A.II.4 A. Mais la variation de � (d) est nulle, alors que la valeur trouvée au 

chapitre III, dans la section III.4.2, l’Annexe II, A.II.4 A, est d'environ -1,85°/jour. Ceci vient du fait que dans 

STK, pour une orbite circulaire, la valeur de l’argument du périgée est définie à zéro (ex. périastre au nœud 

ascendant).

Temps 

(UTCG)

Demi-

grand axe 

[km]

Excentricité

Inclinaison 

[deg]

RAAN 

[deg]

Arg. du 

Périgée 

[deg]

Anomalie 

vraie 

[deg]

Anomalie 

moyenne 

[deg]

7/7/11 

10:00 AM

7028,137 0 90 45 0 45 45

7/8/11 

10:00 AM

7028,137 0 90 45 0 302,414 302,414

Variation de R.A.A.N (d) [degrés/jour]

0,000

Variation de � (d) [degrés/jour]

0,000

Tableau IV.8 : Éléments orbitaux classiques de l’orbite LEO « polaire » circulaire

Pour l’orbite LEO « polaire » circulaire, la variation de R.A.A.N (d) est de 0° par jour, et l'anomalie à l’instant

de début est d'environ 45° : ces mêmes valeurs ont été trouvées au chapitre III, dans la section III.4.2, l’Annexe 

II, A.II.4 A. Mais la variation de � (d) est nulle, tandis que les calculs sous MATLAB ont donné une valeur 

d'environ -3,55°/jour. Cet écart vient du fait que dans STK, pour une orbite circulaire, la valeur de l’argument du 

périgée est définie à zéro (ex. périastre au nœud ascendant).

B.  Accès et l’AER

STK nous permet de déterminer un « intervalle d’accès », c’est-à-dire la période de temps pendant laquelle un 

objet peut accéder à un autre objet ou le voir. En d'autres termes, c’est le temps pendant lequel le champ de 

visibilité (Line Of Sight, LOS) entre deux objets est possible. En outre, nous pouvons imposer des contraintes sur 

les accès entre les objets afin de définir ce qui constitue un accès valide. Ces contraintes sont définies comme des 

propriétés des objets entre lesquels les accès sont calculés. STK peut calculer l'accès depuis tous les types de 

véhicules, d’installations, de cibles, de zones visées, et des capteurs vers tous les objets (y compris les planètes et 

les étoiles) dans un scénario.

STK nous permet également de calculer l'ARE [Azimut, Elevation and Range] (distance linéaire entre deux 

points) entre deux objets lors de l'accès pendant l’intervalle de temps compris entre l’instant de début et l’instant

d’arrêt et pour chaque point d’éphémérides disponible.

Les valeurs des temps d’accès et de l’AER pour différents types d’orbite sont données dans l’Annexe A.III.3.

IV.2.4   Synthèse des résultats des simulations de mécanique orbitale

D’après le Tableau IV.10, nous pouvons observer que :

- La variation de R.A.A.N (d) et la variation de � (d) sont plus importantes pour des orbites de petite 

taille (c’est-à-dire ayant une altitude ou un demi-grand axe de faible valeur) comme les orbites LEO et 

VLEO elliptiques. Et elles sont égales à 0 pour l'orbite « polaire » circulaire.
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- Le nombre d'accès et donc la durée totale de visibilité dépendent de l'inclinaison et de l'altitude de 

l’orbite. La durée totale de visibilité pour un lieu donné est importante quand l'altitude de l’orbite est 

haute ou quand l'inclinaison du satellite place le satellite à la bonne position au-dessus de la station 

terrestre.

- En comparaison avec des orbites de petite taille comme les orbites LEO et VLEO, les orbites de plus

grande taille comme l’orbite MEO ont une période orbitale plus longue, et donc un nombre de passages 

et un nombre d’accès par jour plus faibles, mais une durée de visibilité plus longue.

- L’angle d’élévation des stations terrestres de nos scénarii de simulation n’est pas limité a priori par une 

valeur minimale. Pour éviter que les stations terrestres, à très basse élévation, rencontrent des objets

dans leur champ de visibilité, STK permet d’ajouter une contrainte sur l’angle d’élévation minimal 

d’une station terrestre. Un bon angle d’élévation minimal typique a une valeur comprise entre 5 et 8 

degrés, mais la valeur peut augmenter selon la zone considérée, le terrain environnant, et même les 

bâtiments. Une synthèse des résultats de mécanique orbitale produits avec une contrainte d’angle 

d’élévation minimal à 6 degrés est donnée dans le Tableau IV.11. Cette contrainte diminue la durée 

totale de visibilité ou le nombre d’accès, ainsi que les distances maximale et moyenne.

IV.3 Constellations en couverture continue de la Terre pour différents types d’orbite

IV.3.1   Objectif des scenarii de simulation

Une constellation de nanosatellites est considérée. L’objectif des scénarii de simulation décrits dans cette section 

est de répondre à la question de savoir s’il est possible, pour différents types d’orbite envisagés dans le Tableau 

IV.1, de concevoir une constellation (obtenue par la méthode « Walker Star » ou la méthode « Walker Delta ») 

offrant une couverture continue de la Terre, et si oui, de trouver la constellation optimale pour chaque type 

d’orbite. 

IV.3.2   Méthode de recherche de la constellation optimale

Les stations terrestres et les nanosatellites sont tout d’abord créés dans STK. Ensuite, pour trouver la 

constellation optimale de satellites, deux programmes sont utilisés. L’un est un programme C qui sert à générer

une combinaison du nombre de plans P et du nombre de satellites par plan N à tester dans STK. L’autre est STK 

qui est utilisé pour tester si une combinaison du nombre de plans P et du nombre N de satellites par plan peut 

assurer une couverture continue de la Terre (24 heures/jour).

L’organigramme de l’algorithme utilisé pour trouver la constellation optimale de satellites en vue d’une

couverture continue de la Terre est montré sur la

Figure IV.4. Cet algorithme a été programmé en C. Le code C de cet algorithme est donné dans l’Annexe III, 

section A.III.4.

Pour trouver la constellation optimale de satellites, les valeurs de P_min, P_max, N_min et N_max sont choisies

égales ou à peu près égales aux valeurs approximatives calculées au chapitre III, dans la section III.5.1 A. 

Rappelons que les valeurs approximatives de P_min, P_max, N_min et N_max sont calculées pour les différents 

types d’orbite respectivement aux altitudes minimale, maximale et moyenne (pour une orbite elliptique) du 

satellite ou à une altitude constante du satellite (pour une orbite circulaire), avec un angle d'élévation de 5 degrés, 

et pour une vélocité constante du satellite tout au long de l'orbite. Les valeurs choisies de P_min, P_max, N_min

et N_max pour trouver les constellations optimales en couverture continue de la Terre pour les différents types 

d’orbite sont montrées dans le Tableau IV.9.

Type d’orbite

Valeur approximative Valeur choisie

P_min P_max N_min N_max P_min P_max N_min N_max

LEO elliptique 5 8 7 16 5 8 7 16

VLEO elliptique 9 10 13 14 9 10 13 14

MEO « Molniya » elliptique 2 4 4 64 2 4 4 64

MEO « Tundra » elliptique 2 12 21 2 4 21

LEO « inclinée » circulaire 7 10 6 8 7 12

LEO « polaire » circulaire 7 10 6 8 7 12

Tableau IV.9 : Valeurs choisies de P_min, P_max, N_min et N_max pour trouver les constellations optimales en couverture 

continue de la Terre pour différents types d’orbite
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Tableau IV.10 : Résumé des résultats de mécanique orbitale sans la contrainte de l’angle d’élévation minimal

LEO VLEO

MEO

"Molniya"

MEO

"Tundra"

LEO

"Incliné"

LEO

"Polaire"

Rayon du périgée [km] 6732,14 6746,14 7628,14 31609,14 7028,14 7028,14

Excentricité 0,08 0,00015 0,71 0,25 0,00 0,00

Inclinaison [deg] 71,00 40,02 63,40 63,40 72,00 90,00

RAAN [deg] 45,00 45,00 45,00 45,00 45,00 45,00

Arg. du périgée [deg] 30,00 30,00 30,00 30,00 0,00 0,00

Anomalie vraie [deg] 15,00 15,00 15,00 15,00 45,00 45,00

Période orbitale [min] 103,00 91,93 717,79 1436,04 97,73 97,73

Variation de R.A.A.N 

(dW ) 

[deg/jour] -2,066 -6,271 -0,125 -0,007 -2,191 0.000 

Variation de w   (dw ) [deg/jour] -1,491 7,911 0,000 0,000 0,000 0.000 

Nombre de passages par jour 14 16 2 1 15 15

8 4 3 2 9 8

Durée minimale [min] 8,090 4,455 9,096 196,050 7,902 2,970

Durée maximale [min] 16,944 8,548 130,930 714,931 13,886 13,471

Durée moyenne [min] 11,526 7,068 57,484 455,490 11,017 9,831

Durée totale [min] 92,208 28,274 172,453 910,981 99,155 78,645

Élevation minimale [deg] 0,000 0,000 0,000 0,000 0,000 0,000

Élevation maximale [deg] 50,874 11,637 87,063 85,475 78,393 57,652

Élevation moyenne [deg] 11,014 3,891 15,613 39,970 11,395 10,259

Distance minimale [km] 800,860 1284,078 1646,656 25689,673 675,122 770,399

Distance maximale [km] 4169,071 2226,929 33573,392 52246,386 2998,981 3000,459

Distance moyenne [km] 2374,614 1865,168 17604,454 37868,385 2206,953 2258,115

7 6 3 2 7 7

Durée minimale [min] 1,122 1,907 11,076 222,997 7,493 3,853

Durée maximale [min] 18,285 10,097 150,481 764,169 13,887 13,435

Durée moyenne [min] 10,432 7,388 61,578 493,583 10,672 9,433

Durée totale [min] 73,022 44,331 184,733 987,166 74,701 66,031

Élevation minimale [deg] 0,000 0,000 0,000 0,000 0,000 0,000

Élevation maximale [deg] 61,429 39,008 80,097 84,771 81,494 56,743

Élevation moyenne [deg] 11,528 8,824 15,903 38,899 12,613 10,408

Distance minimale [km] 851,403 575,540 1488,999 25463,743 666,655 774,229

Distance maximale [km] 4268,75 2227,247 36008,063 51884,671 2995,151 2995,151

Distance moyenne [km] 2531,46 1614,832 19709,426 38291,899 2185,873 2236,931

Nombre d'accès par jour

Satellite-Liege

Satellite-Toulouse

Nombre d'accès par jour

Conditions initiales du propagateur (Propagator Initial Conditions )

Nom de propagateur = J2Perturbation

Temps de début = 7 Jul 2011 10:00:00,000000000 UTCG

Temps d'arrête  = 8 Jul 2011 10:00:00,000000000 UTCG

Elliptique Circulaire
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Tableau IV.11 : Résumé des résultats de mécanique orbitale avec une contrainte de l’angle d’élévation 

minimal à 6 degrés

LEO VLEO

MEO

"Molniya"

MEO

"Tundra"

LEO

"Incliné"

LEO

"Polaire"

Rayon du périgée [km] 6732,14 6746,14 7628,14 31609,14 7028,14 7028,14

Excentricité 0,08 0,00015 0,71 0,25 0,00 0,00

Inclinaison [deg] 71,00 40,02 63,40 63,40 72,00 90,00

RAAN [deg] 45,00 45,00 45,00 45,00 45,00 45,00

Arg. du périgée [deg] 30,00 30,00 30,00 30,00 0,00 0,00

Anomalie vraie [deg] 15,00 15,00 15,00 15,00 45,00 45,00

Période orbitale [min] 103,00 91,93 717,79 1436,04 97,73 97,73

Variation de R.A.A.N 

(dW ) 

[deg/jour] -2,066 -6,271 -0,125 -0,007 -2,191 0.000 

Variation de w   (dw ) [deg/jour] -1,491 7,911 0,000 0,000 0,000 0.000 

Nombre de passages par jour 14 16 2 1 15 15

6 3 3 2 8 5

Durée minimale [min] 2,082 1,741 7,737 175,588 0,202 4,179

Durée maximale [min] 13,533 4,912 98,930 676,328 10,924 10,545

Durée moyenne [min] 8,676 3,546 43,778 425,958 7,174 8,603

Durée totale [min] 52,057 10,638 131,334 851,916 57,393 43,014

Élevation minimale [deg] 6,000 6,000 6,000 6,000 6,000 6,000

Élevation maximale [deg] 50,874 11,637 87,063 85,475 78,393 57,652

Élevation moyenne [deg] 17,409 7,689 19,324 42,487 17,548 17,282

Distance minimale [km] 800,860 1284,078 1646,656 25689,673 675,122 770,399

Distance maximale [km] 3463,247 1657,202 29184,522 51648,059 2403,863 2403,825

Distance moyenne [km] 1923,877 1537,389 15494,984 37338,468 1818,369 1796,127

5 4 3 2 6 4

Durée minimale [min] 5,061 5,498 9,555 200,736 4,201 7,557

Durée maximale [min] 14,957 7,281 118,055 725,892 10,922 10,508

Durée moyenne [min] 9,256 6,542 48,399 463,314 7,580 9,290

Durée totale [min] 46,279 26,168 145,198 926,628 45,483 37,159

Élevation minimale [deg] 6,000 6,000 6,000 6,000 6,000 6,000

Élevation maximale [deg] 61,429 39,008 80,097 84,771 81,494 56,743

Élevation moyenne [deg] 17,637 14,317 19,347 41,289 19,072 17,459

Distance minimale [km] 851,403 575,540 1488,999 25463,743 666,655 774,229

Distance maximale [km] 3577,479 1657,769 32070,421 51531,301 2398,205 2398,286

Distance moyenne [km] 2101,613 1249,361 17851,096 37796,872 1801,832 1767,512

Nombre d'accès par jour

Elliptique Circulaire

Satellite-Liege

Satellite-Toulouse

Nombre d'accès par jour

Conditions initiales du propagateur (Propagator Initial Conditions )

Nom de propagateur = J2Perturbation

Temps de début = 7 Jul 2011 10:00:00,000000000 UTCG

Temps d'arrête  = 8 Jul 2011 10:00:00,000000000 UTCG
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Figure IV.4 : Organigramme pour trouver la constellation optimale de satellites pour la couverture continue de la Terre 
 

STOP 

Sorties: P_optimal, N_optimal 

N_optimal = N; 
P_optimal = P; 
N = N-1; 

P>=P_min && 
N>=N_min? 

Test (P, N)? 

Vrai 
Test (P, N) = 1 

Faux 

Test (P, N) = 0 
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Faux 
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N_max = floor (P_optimal×N_optimal/ (P_optimal-1)); 
N = N_max; 
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Entrées: P_min, P_max, 
N_min, N_max 

P = P_max, N = N_min 

N_optimal = N; P_optimal = P; 
P = P-1; 
N_max = floor (P_optimal×N_optimal/ (P_optimal-1)); 
N = N_max; 

N = N+1 

Vrai 

Test (P, N) = 1 

False 

Test (P, N) = 0 

LB2 

Vrai 

Faux 

Sortie : Pas de couverture globale de la Terre  

STOP 

P>=P_min && 
N<=N_max? 

Test (P, N)? 

N<=N_max? 
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IV.3.3   Constellations optimales en couverture continue de la Terre

A.  Orbite LEO elliptique

Paramètres de constellation 

(inclinaison : nombre de plans/ 

nombre de satellites par plan/

espacement entre plans)

Durée totale 

[min]

Pourcentage total

(%)

Couverture continue de la 

Terre ?

71° : 8/7/1 1440 100 Oui

71° : 7/8/1 1440 100 Oui

71° : 7/7/1 1440 100 Oui

71° : 6/8/1 1440 100 Oui

71° : 6/7/1 1371,9 95,27 Non

71° : 5/9/1 92,8 6,45 Non

La constellation optimale est : 71° : 6/8/1, donc le nombre total minimal de satellites est 48.

Tableau IV.12 : Constellations « Walker Delta » en couverture continue de la Terre pour une orbite LEO elliptique 

Des graphiques 2D et 3D illustrant la constellation « Walker Delta » de l’orbite LEO elliptique définie par 71° : 

6/8/1 et 71° : 5/9/1 sont donnés sur la Figure IV.5 et Figure IV.6 respectivement.

Graphique 3D

Graphique 2D

Figure IV.5 : Graphiques 2D et 3D de la constellation « Walker Delta » de l’orbite LEO elliptique définie par 71° : 6/8/1
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Graphique 3D

Graphique 2D

Figure IV.6 : Graphiques 2D et 3D de la constellation « Walker Delta » de l’orbite LEO elliptique définie par 71° : 5/9/1

B.  Orbite VLEO elliptique

Paramètres de constellation 

(inclinaison : nombre de plans/ nombre de 

satellites par plan/ espacement entre plans)

Couverture continue de la Terre ?

40,02° : 10/13/1 Aucune période de couverture de la Terre (globale) n’existe

40,02° : 10/14/1 Aucune période de couverture de la Terre (globale) n’existe

Donc, aucune période de couverture globale de la Terre n’existe

Tableau IV.13 : Constellation « Walker Delta » en couverture continue de la Terre pour une orbite VLEO elliptique

Pour une orbite VLEO elliptique, aucune couverture globale continue de la Terre n’est possible à cause de 

l’inclinaison de l’orbite qui ne peut pas offrir de couverture aux altitudes supérieures à environ 60° et aux

altitudes en-dessous d’environ -60°.

Des graphiques 2D et 3D illustrant la constellation « Walker Delta » de l’orbite VLEO elliptique définie par 

40,02° : 10/14/1 sont donnés sur la Figure A.III.12 en Annexe III, A.III.6.

Région pas de couverture

Région pas de couverture
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C.  Orbite MEO « Molniya » elliptique

Paramètres de constellation 

(inclinaison : nombre de plans/ 

nombre de satellites par plan/

espacement entre plans)

Durée totale 

[min]

Pourcentage total

(%)

Couverture continue de la 

Terre ?

63,40° : 4/4/1 538,9 37,42 Non

63,40° : 4/5/1

635,8 44,15 Non

63,40° : 4/6/1

791,08 54,94 Non

63,40° : 4/7/1

910,26 63,21 Non

63,40° : 4/8/1

1006,08 69,87 Non

63,40° : 4/9/1

1109,01 77,01 Non

63,40° : 4/10/1

1222,56 84,9 Non

63,40° : 4/11/1

1279,47 88,85 Non

63,40° : 4/12/1

1344,93 93,4 Non

63,40° : 4/13/1

1386,06 96,25 Non

63,40° : 4/14/1

1423,231 98,84 Non

63,40° : 4/15/1

1440 100 Oui

63,40° : 3/20/1

1440 100 Oui

63,40° : 3/19/1

1432,05 99,45 Non

63,40° : 2/30/1

704,67 48,94 Non

La constellation optimale est : 63,40° : 3/20/1, donc le nombre total minimal de satellites est 60.

Tableau IV.14 : Constellation « Walker Delta » en couverture continue de la Terre pour une orbite MEO « Molniya » 

elliptique

Des graphiques 2D et 3D illustrant la constellation « Walker Delta » de l’orbite MEO « Molniya » elliptique 

définie par 63,40° : 3/20/1 sont donnés sur la Figure A.III.13 en Annexe III, A.III.6.

La constellation « Walker Delta » optimale pour une orbite MEO « Molniya » elliptique, et définie par les 

paramètres 63,40° : 3/20/1, est un peu plus grande en termes du nombre total de satellites (nombre total de 

satellites de 60). Ce n’est pas anormal, car comme cela a été explicité au chapitre III.7, dans la section §III.7.2

Constellation de l’orbite elliptique, la constellation « Walker Delta » ne peut pas offrir une bonne constellation 

optimale pour une orbite elliptique et pour une couverture continue de la Terre, car il y aurait de nombreux 

chevauchements des empreintes des satellites. Pour une constellation d’orbites elliptiques, la méthode « Walker 

Delta » devrait être utilisée pour assurer une couverture continue d’une zone spécifique.

D.  Orbite MEO « Tundra » elliptique

Paramètres de constellation 

(inclinaison : nombre de plans/ 

nombre de satellites par plan/

espacement entre plans)

Durée totale 

[min]

Pourcentage total

(%)

Couverture continue de la 

Terre ?

63,40° : 2/4/1 1334,764 92,69 Non

63,40° : 2/5/1

1440 100 Oui

La constellation optimale est : 63,40° : 2/5/1, donc le nombre total minimal de satellites est 10.

Tableau IV.15 : Constellation « Walker Delta » en couverture continue de la Terre pour une orbite MEO « Tundra » 

elliptique

La constellation « Walker Delta » d’orbites MEO « Tundra » elliptiques définie par les paramètres 63,40° : 2/5/1 

est illustrée par les graphiques 2D et 3D de la Figure A.III.14 en Annexe III, A.III.6.



Page | 44

E.  Orbite LEO « inclinée » circulaire

Paramètres de constellation 

(inclinaison : nombre de plans/ 

nombre de satellites par plan/

espacement entre plans)

Durée totale 

[min]

Pourcentage total

(%)

Couverture continue de la 

Terre ?

72° : 8/7/1 N/A (non applicable) Non

72° : 8/8/1 1440 100 Oui

72° : 7/9/1 1440 100 Oui

72° : 7/8/1 N/A Non

72° : 6/10/1 N/A Non

La constellation optimale est : 72° : 7/9/1, donc le nombre total minimal de satellites est 63.

Tableau IV.16 : Constellation « Walker Delta » en couverture continue de la Terre pour des orbites LEO « inclinées » 

circulaires

La constellation « Walker Delta » d’orbites LEO « inclinées » circulaires définie par 72° : 7/9/1 est illustrée par 

les graphiques 2D et 3D de la Figure A.III.15 en Annexe III, A.III.6.

F.  Orbite LEO « polaire » circulaire

Paramètres de constellation 

(inclinaison : nombre de 

plans/ nombre de satellites 

par plan/ espacement entre 

plans)

Durée totale 

[min]

Pourcentage total

(%)

Couverture continue de la 

Terre ?

90° : 8/7/1 1,252 0,087 Non

90° : 8/8/1 1440 100 Oui

90° : 7/9/1 1440 100 Oui

90° : 7/8/1 1440 100 Oui

90° : 7/7/1 N/A

1

Non

90° : 6/9/1 1440 100 Oui

90° : 6/8/1 1329,139 92,301286 Non

La constellation optimale est : 90° : 6/9/1, donc le nombre total minimal de satellites est 54.

Tableau IV.17 : Constellation « Walker Star » en couverture continue de la Terre pour des orbites LEO « polaires » 

circulaires

La constellation « Walker Star » d’orbites LEO « polaires » circulaires définie par 90° : 6/9/1 est illustrée sur les 

graphiques 2D et 3D de la Figure A.III.16 en Annexe III, A.III.6.

IV.3.4   Résumé de l’optimisation des constellations

Type d’orbite

Couverture 

continue de la 

Terre ?

Constellation optimale

(inclinaison : nombre de plans/ 

nombre de satellites par plan/

espacement entre plans)

Nombre total 

de satellites

LEO elliptique Oui 71°: 6/8/1 48

VLEO elliptique Non 40,02°: NA/NA/NA N/A

MEO « Molniya » elliptique Oui 63,40°: 3/20/1 60

MEO « Tundra » elliptique Oui 63,40°: 2/5/1 10

LEO « inclinée » circulaire Oui 72°: 7/9/1 63

LEO « polaire » circulaire Oui 90°: 6/9/1 54

Tableau IV.18 : Constellations optimale en couverture continue de la Terre

1

N/A : Non applicable.
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IV.4 Constellation de satellites optimale pour des orbites de basse altitude pour couvrir une 

région spécifique

IV.4.1 Description des scénarii de simulation 

Dans cette section, l’objectif des scenarii de simulation mis en place dans STK est de trouver une constellation

optimale qui fournit une couverture continue (24 heures/jour) pour une zone spécifiée (entre deux endroits 

précis). Deux scénarii, l’un pour des orbites LEO « inclinées » circulaires, et l’autre pour des orbites LEO 

elliptiques, sont créés afin de valider un cas de couverture continue sur une zone spécifique dont les 

délimitations sont définies par les positions de deux stations terrestres : une station terrestre située à Liège, en 

Belgique (latitude : 50,62°, longitude : 5,5667°) et une station terrestre située à Toulouse (latitude : 43,60°, 

longitude : 1,4333°). Les communications entre les deux stations terrestres transitent par un nanosatellite. Ces 

deux scénarii seront testés et comparés.

IV.4.2 Méthode pour trouver la constellation optimale 

La méthode qui permet d’obtenir les constellations optimales est similaire à celle décrite et utilisée dans la 

section IV.3.2   . L’organigramme de l’algorithme C utilisé pour produire une combinaison du nombre de plans 

P et du nombre N de satellites par plan à tester dans STK est donné sur la Figure IV.7 ci-après.

Figure IV.7 : Organigramme de l’algorithme permettant de trouver la constellation optimale de satellites pour une

couverture continue d’une zone spécifiée 

Les valeurs de P_min, P_max, N_min et N_max sont choisies prudemment. Les valeurs de P_max et N_max sont

choisies égales aux valeurs optimales P et N de la constellation globale en couverture continue de la Terre, telles 

qu’indiquées dans le Tableau IV.18 de la section IV.3.4   , car les valeurs P et N requises pour une constellation

de satellites pour couvrir une zone spécifiée doivent être, à l’évidence, plus faibles que dans le cas de la 

couverture globale continue de la Terre. Les valeurs choisies de P_min, P_max, N_min et N_max pour trouver la 

constellation optimale en couverture continue d’une zone spécifique pour des orbites LEO elliptiques et LEO 

« inclinées » circulaires sont présentées dans le Tableau IV.19.

START

Entrées: P_min, P_max,

N_min, N_max

P = P_max, N = N_max

STOP

Sorties: P_optimal, N_optimal

N_optimal = N;

P_optimal = P;

N = N-1;

Vrai

Test (P, N) = 1

Faux

Test (P, N) = 0

Vrai

Faux

P = P-1;

N_max = floor (P_optimal*N_optimal/ (P_optimal-1));

N = N_max;

P>=P_min &&

N>=N_min?

Test (P, N)?

N>=N_min?
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Type d’orbite LEO elliptique

LEO « inclinée » 

circulaire

P_min, P_max, N_min et N_max choisies pour une 

couverture globale continue de la Terre

P_min = 5

P_max = 8

N_min = 7

N_max = 16

P_min = 6

P_max = 8

N_min = 7

N_max = 12

Valeusr optimales de P et N

P = 6

N = 8

P = 7

N = 9

P_min, P_max, N_min et N_max choisies pour une

couverture continue d’une zone spécifique

P_max = 6

N_max = 8

P_min = 5

N_min = 5

P_max = 7

N_max = 9

P_min = 5

N_min = 5

Tableau IV.19 : Valeurs choisies de P_min, P_max, N_min et N_max pour trouver la constellation optimale en couverture 

continue d’une zone spécifique pour des orbites LEO elliptiques et LEO « inclinées » circulaires

IV.4.3 Constellations optimales en couverture continue sur une zone spécifique

A.  Orbite LEO elliptique

Constellation (inclinaison : nombre de plans/ nombre 

de satellites par plan/ espacement entre plans)

Durée totale 

[min]

Couverture continue?

71°: 6/8/1 1440 Oui

71°: 6/7/1 1440 Oui

71°: 6/6/1 1438,13 Non

71°: 5/8/1 1434,23 Non

La constellation optimale est : 71° : 6/7/1, donc le nombre total minimal de satellites est 42.

Tableau IV.20 : Constellation optimale par la méthode « Walker Delta » pour des orbites LEO elliptiques en couverture 

continue d’une zone spécifique

Une économie de 6 satellites est réalisée par rapport au cas de la couverture globale continue de la Terre, pour le 

même type d’orbite, avec la constellation « Walker Delta ».

B.  Orbite LEO « inclinée » circulaire

Constellation (inclinaison : nombre de plans/ nombre 

de satellites par plan/ espacement entre plans)

Durée totale 

[min]

Couverture continue ?

72° : 7/9/1 1440 Oui

72° : 7/8/1 1440 Oui

72° : 7/7/1 1440 Oui

72° : 7/6/1 1440 Oui

72° : 7/5/1 1437,483 Non

72° : 6/7/1 1440 Oui

72° : 6/6/1 1439,986 Non

72° : 5/8/1 1403,304 Non

La constellation optimale est : 72° : 6/7/1, donc le nombre total minimal de satellites est 42.

Tableau IV.21 : Constellation « Walker Delta » en couverture continue d’une zone spécifique (Toulouse-Liège) pour des 

orbites LEO « inclinées » circulaires

Une économie de 21 satellites est réalisée par rapport au cas de la couverture globale continue de la Terre, pour 

le même type d’orbite, avec la constellation « Walker Delta ».
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IV.4.4 Synthèse des résultats d’optimisation des constellations

Type d’orbite

Constellation optimale

en couverture continue de 

la Terre

(inclinaison : nombre de 

plans/ nombre de satellites 

par plan/ espacement entre 

plans)

Constellation optimale

en couverture continue sur 

une zone spécifique

(Toulouse-Liège)

(inclinaison : nombre de 

plans/ nombre de satellites 

par plan/ espacement entre 

plans)

Nombre de 

satellites 

économisés 

LEO elliptique 71°: 6/8/1 71°: 6/7/1 6

LEO “inclinée” circulaire 72°: 7/9/1 72°: 6/7/1 21

Tableau IV.22 : Constellations « Walker Delta » optimales en couverture continue d’une zone spécifique entre Toulouse et 

Liège

Remarque :

Pour le cas présent, l’orbite LEO « inclinée » circulaire permet d’avoir un plus faible nombre de satellites que 

pour l’orbite LEO elliptique. Mais ce résultat dépend de la zone sélectionnée. Car, en réalité, l’orbite LEO 

elliptique donnerait lieu à une constellation plus optimale que celle de l'orbite circulaire sur certaines zones, 

parce que la couverture de l'orbite circulaire ne s’étend pas à son apogée comme celle de l’orbite elliptique,

comme cela a été expliqué au chapitre III, dans la section III.5.2.

IV.5 Bilans de liaison entre un nanosatellite en basse orbite terrestre et une station terrestre 

située à Liège

IV.5.1 Description des scénarii de simulation

Les scénarii mis en œuvre  dans STK et décrits dans cette section ont pour objectif de déterminer les bilans de 

liaison entre un nanosatellite et une station terrestre située à Liège, en Belgique, dans les deux cas de figure 

suivants : le nanosatellite est d’abord en orbite LEO elliptique, puis en orbite LEO « inclinée » circulaire. 

Un résumé des caractéristiques du système de communication étudié sont présentées dans le Tableau IV.23.

STK est utilisé pour créer les scénarii comprenant les stations terrestres et le nanosatellite, placé sur différentes

orbites. Ensuite, pour chaque scénario, les antennes, les émetteurs et les récepteurs du module 

STK/Communications sont mis en œuvre pour modéliser les communications impliquées dans le système et pour 

évaluer les bilans de liaison associés.

Émetteurs

Vers le satellite

Vers la station

terrestre de Liège

Bande de fréquence (UHF/VHF)

Liaison descendante 

(VHF)

Liaison montante 

(UHF)

Fréquence [MHz] 145 435

Puissance

Protocole AX.25 et D-STAR

Puissance transmise [W] 0,75 20

[dBW] -1,25 13,01

Protocole Balise

Puissance transmise [W] 0,1 0,1

[dBW] -10 -10
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Antenne

Type d’antenne Monopole Yagi

Gain d’antenne [dBi] 2,15 13,35

Pertes de dépointage d’antenne [dB] 7,6 0,15

Pertes de dépolarisation d’antenne [dB] 0,2283 0,2283

Pertes des lignes de transmission

Pertes totales des lignes de 

transmission

[dB] 1,02 3,09

Débits des données et types de modulation

Protocole Balise AX.25 D-STAR

Débit des données 12 WPM ou 20 bps 9,6 kbit/s DV Mode : 4,8 kbit/s

Type de modulation FSK non-cohérente FSK non-cohérente GMSK

Codage Aucun Aucun Aucun

Pertes de propagation

Liaison descendante 

(VHF)

Liaison montante 

(UHF)

Fréquence [MHz] 145 435

Pertes en espace libre à l’altitude 

minimale du satellite

[dB] 140,14 149,68

Pertes atmosphériques [dB] 2,10 2,10

Pertes ionosphériques [dB] 0,80 0,40

Pertes dues à la pluie [dB] 0,00 0,00

Récepteurs

Vers le satellite

Vers la station 

terrestre de Liège

Bande de fréquence (UHF/VHF)

Liaison descendante 

(VHF)

Liaison montante 

(UHF)

Fréquence [MHz] 145 435

Antenne

Type d’antenne Yagi Monopole

Gain d’antenne [dBi] 13,35 2,15

Pertes de dépointage d’antenne [dB] 0,15 7,6

Pertes des lignes de transmission

Pertes totales en ligne, de l’antenne 

jusqu’au LNA

[dB] 1,85 0,83

Gain du LNA [dB] 20 20

Pertes en ligne, du LNA au récepteur [dB] 0,5 0

Température de bruit efficace

[K]

681,13 219,66

Débits des données et types de modulation

Protocole Balise AX.25 D-STAR

Débit des données

12 WPM ou 20 

bps

9,6 kbit/s DV Mode: 4,8 kbit/s

Type de modulation

FSK non-

cohérente

FSK non-cohérente GMSK

Codage Aucun Aucun Aucun

TEB 10

-5

10

-5

10

-5
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E

b

/N

0

requis 13,35 dB 13,35 dB 9,72 dB

Pertes de mise en œuvre du 

démodulateur

1 dB 1 dB 1 dB

E

b

/N

0

seuil 14,35 dB 14,35 dB 10,72 dB

Tableau IV.23 : Principales caractéristiques du système de communication étudié

IV.5.2 Bilans de liaison du système satellitaire en orbite terrestre basse

A.  Orbite LEO elliptique

En utilisant les capacités de calcul du logiciel de simulation STK, les bilans de liaison pour l’orbite LEO 

elliptique indiqués dans les tableaux Tableau IV.24Tableau IV.25 et Tableau IV.26 ont été obtenus.

Tableau IV.24 : Bilans de liaison pour l’orbite LEO elliptique pour le canal AX.25

Tableau IV.25 : Bilans de liaison pour l’orbite LEO elliptique pour le canal D-STAR

Eb/No Min Eb/No Max Eb/No Min Eb/No Max

Temps [UTCG] 7-juil-11 10:00:00 AM 7-juil-11 7:07:25 PM 7-juil-11 10:03:24 AM 7-juil-11 10:00:00 AM 7-juil-11 7:07:25 PM 7-juil-11 10:03:24 AM

Puissance transmise (Xmtr Power) [dBW] -1,249 -1,249 -1,249 14:24,0 13,01 13,01

PIRE (EIRP) [dBW] -0,119 -0,119 -0,119 23,27 23,27 23,27

Distance (Range) [km] 1721,897021 4169,070898 800,860447 1721,8561 4169,070972 800,859346

Perte dans l'espace libre [dB] -140,3953 -148,0759 -133,7463 -149,9375 -157,6184 -143,2887

Rapport signal sur bruit C/No [dBHz] 60,912165 53,231523 67,561171 69,354424 61,673575 76,003236

Eb/No [dB] 21,0895 13,4088 27,7385 29,5317 21,8509 36,1805

BER 6,21E-29 8,68E-06 1,00E-30 1,00E-30 1,00E-30 1,00E-30

Retard de propagation [sec] 0,006 0,014 0,003 0,006 0,014 0,003

Eb/No seuil [dB] 14,35 14,35 14,35 14,35 14,35 14,35

Marge du système [dB] 6,7395 -0,9412 13,3885 15,1817 7,5009 21,8305

Nombre d'accès

Durée totale d'accès [min]

Nombre d'accès

Durée totale d'accès [min]

92,208 92,207

Avec une contrainte minimale de bilans de liaison (marge du système) de 6 dB

4 8

28,063 92,207

Protocole AX.25

Liaison descendante Liaison montante

Aucune contrainte

8 8

Eb/No Min Eb/No Max Eb/No Min Eb/No Max

Temps [UTCG] 7-juil-11 10:00:00 AM 7-juil-11 7:07:25 PM 7-juil-11 10:03:24 AM 7-juil-11 10:00:00 AM 7-juil-11 7:07:25 PM 7-juil-11 10:03:24 AM

Puissance transmise (Xmtr Power) [dBW] -1,249 -1,249 -1,249 14:24,0 13,01 13,01

PIRE (EIRP) [dBW] -0,119 -0,119 -0,119 23,27 23,27 23,27

Distance (Range) [km] 1721,897021 4169,070898 800,860447 1721,8561 4169,070972 800,859346

Perte dans l'espace libre [dB] -140,3953 -148,0759 -133,7463 -149,9375 -157,6184 -143,2887

Rapport signal sur bruit C/No [dBHz] 60,912165 53,231523 67,561171 69,354424 61,673575 76,003236

Eb/No [dB] 24,0998 16,4191 30,7488 32,542 24,8612 39,1908

BER 1,00E-30 3,83E-21 1,00E-30 1,00E-30 1,00E-30 1,00E-30

Retard de propagation [sec] 0,006 0,014 0,003 0,006 0,014 0,003

Eb/No seuil [dB] 10,72 10,72 10,72 10,72 10,72 10,72

Marge du système [dB] 13,3798 5,6991 20,0288 21,822 14,1412 28,4708

Nombre d'accès

Durée totale d'accès [min]

Nombre d'accès

Durée totale d'accès [min]

92,208 92,207

Avec une contrainte minimale de bilans de liaison (marge du système) de 6 dB

8 8

91,681 92,207

Protocole D-STAR

Liaison descendante Liaison montante

Aucune contrainte

8 8
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Tableau IV.26 : Bilans de liaison pour l’orbite LEO elliptique pour le canal de balise

D’après les tableaux Tableau IV.24Tableau IV.25 et Tableau IV.26, on peut observer que :

- Les durées totales des accès en liaison montante et en liaison descendante sont pratiquement identiques

à celles obtenues sous Excel et Matlab, égales à environ 92,21 minutes. La faible différence de 0,001 

minute vient du fait que, dans STK, les calculs des temps d’accès (dont ceux vers l’objet visé) sont 

exécutés sur la base du capteur transmettant le signal.

- Il n’y a aucun effet sur la durée totale d’accès quand la marge minimale du système est plus grande que

la contrainte minimale de marge système de 6 dB.

- Pour l’orbite LEO elliptique, et pour la liaison descendante avec le protocole AX.25, la marge minimale 

du système est de -0,9412 dB et la marge maximale du système est de 13,3885 dB. Donc, avec la 

contrainte minimale de bilans de liaison de 6 dB, la durée totale d’accès est réduite de 92,208 minutes à 

28,063 minutes car l’on considère qu’il n’y a pas l’accès quand le lien de communication a une marge 

système inférieure à 6 dB (le lien de communication est considéré comme non valide).

- Pour l’orbite LEO elliptique, et pour la liaison montante avec le protocole AX.25, la marge minimale du 

système est de 7,5 dB et la marge maximale du système est de 21,83 dB. La liaison est donc valide tout 

au long de l’orbite.

- Pour l’orbite LEO elliptique, en liaison montante avec le protocole D-STAR, la marge minimale du 

système est de 14.14 dB et la marge maximale du système est de 28.47 dB, donc la marge système est 

supérieure à 6 dB en permanence. La liaison montante est donc valide tout au long de l’orbite pour la 

configuration système étudiée.

- Pour l’orbite LEO elliptique, en liaison descendante avec le protocole D-STAR, la marge minimale du 

système est de 5,7 dB et la marge maximale du système est de 20,03 dB. Par conséquent, avec la 

contrainte minimale de marge système de 6 dB, la durée totale d’accès est réduite de 92,208 minutes à 

91,681 minutes.

- Pour l’orbite LEO elliptique, sur le canal de la balise en liaison descendante, la marge minimale du 

système est de 17,12 dB et la marge maximale du système est de 31,45 dB. La liaison est donc valide

tout au long de l’orbite.

- Sans changer l’orbite, dans les cas où les liaisons ne sont pas valides, les bilans de liaison peuvent être 

améliorés par exemple en augmentant soit le gain d’antenne de l’émetteur ou du récepteur, soit la 

puissance de transmission de l’antenne d’émission, ou encore en utilisant un schéma de modulation et 

codage plus performant.

B.  Orbite LEO « inclinée » circulaire

Les bilans de liaison obtenus pour une orbite LEO « inclinée » circulaire sont indiqués dans les tableauxTableau 

IV.27, Tableau IV.28 et Tableau IV.29.

Eb/No Min Eb/No Max

Temps [UTCG] 7-juil-11 10:00:00 AM 7-juil-11 7:07:25 PM 7-juil-11 10:03:24 AM

Puissance transmise (Xmtr Power) [dBW] -10 -10 -10

PIRE (EIRP) [dBW] -8,87 -8,87 -8,87

Distance (Range) [km] 1721,897021 4169,070898 800,860447

Perte dans l'espace libre [dB] -140,3953 -148,0759 -133,7463

Rapport signal sur bruit C/No [dBHz] 52,161552 44,48091 58,810559

Eb/No [dB] 39,1513 31,4706 45,8003

BER 1,00E-30 1,00E-30 1,00E-30

Retard de propagation [sec] 0,006 0,014 0,003

Eb/No seuil [dB] 14,35 14,35 14,35

Marge du système [dB] 24,8013 17,1206 31,4503

Nombre d'accès

Durée totale d'accès [min]

Nombre d'accès

Durée totale d'accès [min]

8

92,208

Protocole de la balise

Liaison descendante

Aucune contrainte

8

92,208

Avec une contrainte minimale de bilans de liaison (marge du système) de 6 dB
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Tableau IV.27 : Bilans de liaison pour une orbite LEO « inclinée » circulaire sur le canal AX.25

Tableau IV.28 : Bilans de liaison pour une orbite LEO « inclinée » circulaire sur le canal D-STAR

Tableau IV.29 : Bilans de liaison pour une orbite LEO « inclinée » circulaire sur le canal de balise

Eb/No Min Eb/No Max Eb/No Min Eb/No Max

Temps [UTCG] 7-juil-11 10:00:00 AM 7-juil-11 11:50:21 AM 8-juil-11 8:51:43 AM 7-juil-11 10:00:00 AM 7-juil-11 11:50:21 AM 8-juil-11 8:51:43 AM

Puissance transmise (Xmtr Power) [dBW] -1,249 -1,249 -1,249 14:24,0 13,01 13,01

PIRE (EIRP) [dBW] -0,119 -0,119 -0,119 23,27 23,27 23,27

Distance (Range) [km] 1867,728014 2998,980326 675,121807 1867,68903 2998,982503 675,122047

Perte dans l'espace libre [dB] -141,1014 -145,2146 -132,2628 -150,6437 -154,757 -141,8052

Rapport signal sur bruit C/No [dBHz] 60,206035 56,092836 69,044665 68,648269 64,534882 77,486715

Eb/No [dB] 20,3833 16,2701 29,222 28,8256 24,7122 37,664

BER 9,56E-25 3,16E-10 1,00E-30 1,00E-30 1,00E-30 1,00E-30

Retard de propagation [sec] 0,006 0,01 0,002 0,006 0,01 0,002

Eb/No seuil [dB] 14,35 14,35 14,35 14,35 14,35 14,35

Marge du système [dB] 6,0333 1,9201 14,872 14,4756 10,3622 23,314

Nombre d'accès

Durée totale d'accès [min]

Nombre d'accès

Durée totale d'accès [min]

99,154 99,154

Avec une contrainte minimale de bilans de liaison (marge du système) de 6 dB

4 9

30,63 99,154

Protocole AX.25

Liaison descendante Liaison montante

Aucune contrainte

9 9

Eb/No Min Eb/No Max Eb/No Min Eb/No Max

Temps [UTCG] 7-juil-11 10:00:00 AM 7-juil-11 11:50:21 AM 8-juil-11 8:51:43 AM 7-juil-11 10:00:00 AM 7-juil-11 11:50:21 AM 8-juil-11 8:51:43 AM

Puissance transmise (Xmtr Power) [dBW] -1,249 -1,249 -1,249 14:24,0 13,01 13,01

PIRE (EIRP) [dBW] -0,119 -0,119 -0,119 23,27 23,27 23,27

Distance (Range) [km] 1867,728014 2998,980326 675,121807 1867,68903 2998,982503 675,122047

Perte dans l'espace libre [dB] -141,1014 -145,2146 -132,2628 -150,6437 -154,757 -141,8052

Rapport signal sur bruit C/No [dBHz] 60,206035 56,092836 69,044665 68,648269 64,534882 77,486715

Eb/No [dB] 23,3936 19,2804 32,2323 31,8359 27,7225 40,6743

BER 1,00E-30 1,00E-30 1,00E-30 1,00E-30 1,00E-30 1,00E-30

Retard de propagation [sec] 0,006 0,01 0,002 0,006 0,01 0,002

Eb/No seuil [dB] 10,72 10,72 10,72 10,72 10,72 10,72

Marge du système [dB] 12,6736 8,5604 21,5123 21,1159 17,0025 29,9543

Nombre d'accès

Durée totale d'accès [min]

Nombre d'accès

Durée totale d'accès [min]

99,154 99,154

Avec une contrainte minimale de bilans de liaison (marge du système) de 6 dB

9 9

99,154 99,154

Protocole D-STAR

Liaison descendante Liaison montante

Aucune contrainte

9 9

Eb/No Min Eb/No Max

Temps [UTCG] 7-juil-11 10:00:00 AM 7-juil-11 11:50:21 AM 8-juil-11 8:51:43 AM

Puissance transmise (Xmtr Power) [dBW] -10 -10 -10

PIRE (EIRP) [dBW] -8,87 -8,87 -8,87

Distance (Range) [km] 1867,728014 2998,980326 675,121807

Perte dans l'espace libre [dB] -141,1014 -145,2146 -132,2628

Rapport signal sur bruit C/No [dBHz] 51,455423 47,342223 60,294053

Eb/No [dB] 38,4451 34,3319 47,2838

BER 1,00E-30 1,00E-30 1,00E-30

Retard de propagation [sec] 0,006 0,01 0,002

Eb/No seuil [dB] 14,35 14,35 14,35

Marge du système [dB] 24,0951 19,9819 32,9338

Nombre d'accès

Durée totale d'accès [min]

Nombre d'accès

Durée totale d'accès [min]

9

99,154

Protocole de la balise

Downlink

Aucune contrainte

9

99,154

Avec une contrainte minimale de bilans de liaison (marge du système) de 6 dB
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D’après les tableauxTableau IV.27, Tableau IV.28 et Tableau IV.29, on peut observer que :

- Sur la liaison montante avec le protocole AX.25, le système a une marge minimale de 10,36 dB et une

marge maximale de 23,31 dB. Donc la liaison est bien valide tout au long de l’orbite.

- Sur la liaison descendante avec le protocole AX.25, la marge minimale du système est de 1,92 dB et la 

marge maximale du système est de 14,87 dB. Donc, avec la contrainte minimale de bilans de liaison de 

6 dB, la durée totale d’accès est réduite de 99,154 minutes à 30,63 minutes.

- Sur la liaison montante avec le protocole D-STAR, le système a une marge minimale de 17 dB et une

marge maximale de 29,95 dB. La liaison est valide en continu tout au long de l’orbite.

- Sur la liaison descendante avec le protocole D-STAR, la marge minimale du système est de 8,56 dB et 

la marge maximale du système est de 21,51 dB. La liaison est valide en continu sur toute l’orbite.

- Sur la liaison descendante sur le canal de la balise, la marge minimale du système est de 19,98 dB et la 

marge maximale du système est de 32,93 dB. La liaison est valide en continu tout au long de l’orbite.

IV.6 Conclusion

Dans ce chapitre, à travers des simulations réalisées sous STK, nous avons démontré des éléments de mécanique 

orbitale ; obtenu des constellations optimales de satellites, tout d’abord pour une couverture terrestre globale 

continue, puis pour une couverture sur une zone spécifique délimitée entre deux emplacement donnés, pour une 

orbite terrestre basse ; enfin, nous avons calculé les bilans de liaison entre un nanosatellite KAMPUCH-1 et une

station terrestre localisée à Liège, en Belgique. Il a été vérifié que :

- Plus l'orbite est de petite taille, plus importantes sont la variation de � (d) et la variation de R.A.A.N 

(d), et plus courte est la durée de visibilité, ce qui entraîne donc un plus grand nombre de satellites 

total requis pour une constellation en couverture globale continue de la Terre,.

- L’orbite VLEO elliptique d’inclinaison à 40° ne permet pas une constellation en couverture globale 

continue de la Terre.
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Conclusion

Dans ce mémoire, un certain nombre d’aspects liés aux systèmes nanosatellites ont été abordés et étudiés, avec 

un découpage du travail en trois parties principales : une partie bibliographique, une partie théorique, et une 

partie réalisation et simulation.

Dans la partie bibliographique, nous nous sommes attachés à présenter un aperçu sommaire et synthétique de 

l’historique des nanosatellites, de l’état de l’art de leur développement, de leur architecture système et de leurs 

applications scientifiques et commerciales, pour tenter finalement de faire ressortir leurs nombreux avantages qui 

vont certainement influencer les nouvelles stratégies de développement spatial dans les années à venir. La 

recherche combinée du faible coût et d’une miniaturisation toujours plus avancée laisse pressentir que des 

changements dans l’aventure spatiale se dessinent, ou seront nécessaires pour faire face au contexte d’une 

concurrence internationale très vive, surtout face à la montée en puissance des acteurs spatiaux asiatiques, 

contexte auquel s’ajoutent des conditions économiques moroses.

A travers la partie théorique, l’idée maîtresse a été de proposer une étude rapide des principaux éléments de 

conception d’un système nanosatellitaire, en partant de la définition de la mission, puis en déterminant 

l’architecture globale du système (segment spatial, segment terrestre, environnement spatial, couche physique et 

couche liaison), pour finalement insister davantage sur des éléments classiques de mécanique orbitale, sur 

l’optimisation des constellations de satellites, et sur le calcul des bilans de liaison. Nous avons ainsi noté, entre 

autres, l'effet du choix de l'orbite, des bandes de fréquences et des types de modulation sur la qualité des liens de 

communication. Notre travail a été un survol bien rapide ; des problématiques très pointues à identifier 

resteraient à être formulées et résolues et pourraient faire l’objet de travaux de recherche doctorale futurs.

Dans un troisième et dernier volet, nous avons effectué quelques simulations, notamment en utilisant le logiciel 

STK doté de très nombreuses et intéressantes fonctionnalités. Ce logiciel a été exploité surtout pour des analyses 

orbitographiques, pour la détermination de constellations nanosatellitaires et pour le calcul de bilans de liaison.

Des scénarii de simulation ont donc été mis en œuvre dans le but de vérifier les résultats obtenus dans la partie 

théorique.

L’étude du système nanosatellitaire fictif que nous avons baptisé KAMPUCH-1 réalisée dans ce mémoire a été 

personnellement difficile pour nous, et a demandé bien des labeurs, mais le sujet très intéressant, à l’intersection 

de diverses disciplines des sciences de l’ingénieur, en valait la peine. Seul l’avenir confirmera si le nanosatellite 

représente un meilleur choix technologique et économique que les satellites traditionnels parce qu’il est « plus 

rapide, plus petit, meilleur et moins cher », mais j’ai eu le plaisir de contribuer à l’étude de cette problématique.

Maintenant qu’il est confirmé que mon pays, le Cambodge, aura son premier satellite de communications en 

2013, je souhaite que les nanosatellites soient une technologie qui fasse son chemin dans les futures industries et 

politiques spatiales cambodgiennes qui ne manqueront pas de se développer dans un proche avenir.
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Annex I

History of nanosatellites

Year 1961 2000 2003

Name OSCAR ASU-OSCAR 37 (ASUSAT) Cubesat-OSCAR 55 Quakesat

Date 12 December, 1961 27 January, 2000 30 June, 2003 June 30, 2003 on Rockot

Mass 4.5 kg 6 kg 1 kg 5 kg

Size ? ? 10 x 10 x 10 cm 10×10×32 cm

Types of orbit

VLEO

Apogee:431.00  km

Perigee:245.30 km

LEO

Apogee: 799.00 km

Perigee: 746.30 km

LEO

Apogee: 831.00 km

Perigee: 816.39 km

LEO

Apogee: 837.9 km

Perigee: 824.1km

Inclination 81.14° 100.19° 98.72° 98.72°

Period [minutes] 91.30 100.30 101.37 101.53

Launch vehicle ? Minotaur-1 Dnepr Rokot/Briz-KM

Launch location

Vandenberg Air Force Base, 

California, in United States

Vandenberg Air Force Base, 

California, in United States

Baikonur Cosmodrome, 

Kazakhstan

Plesetsk Cosmodrome, 

Arkhangelsk Oblast

Project/organization OSCAR Arizona State University

Tokyo Institute of Technology 

Matunaga LSS

Stanford University

Nation/Country USA USA Japan USA

Frequency band

VHF

(Downlink 144.9830 MHz)

UHF?

UHF

(Downlink 437.4000 MHz 

AFSK 1200 BPS)

UHF

(436.675MHz 9600 bps FSK)

Application

Telecommunications

(Amateur radio)

Telecommunications

(Amateur radio)

Telecommunications

(Amateur radio)

Earth observation

(Earthquake detection)

Image



Year 2003 2005 2006

Name

CubeSat-OSCAR 57

(CubeSat XI-IV)

RS-22

CubeSat-OSCAR 58

(Cubesat XI-V) GeneSat-1

Date 30 June, 2003 27 September, 2003 27 October, 2005 16 December, 2006 

Mass 1 kg 1 kg? 1 kg 4.500 kg

Size 10 x 10 x 10 cm 10 x 10 x 10 cm? 10 x 10 x 10 cm 10cm x 10cm x 30cm

Types of orbit

LEO

Apogee: 832.00 km

Perigee: 817.00 km

LEO

Apogee: 693.00 km

Perigee: 675.00 km

LEO

Apogee: 709.00 km

Perigee: 682.00 km

VLEO

Apogee: 370.00 km

Perigee: 368.00 km

Inclination 98.72 ° 98.10° 98.18° 40.02°

Period [minutes] 101.39 98.44 98.68 91.93

Launch vehicle Dnepr Dnepr Cosmos Minotaur-1

Launch location

Baikonur Cosmodrome, 

Kazakhstan

Baikonur Cosmodrome, 

Kazakhstan

Plesetsk MSC (Multi Space 

Camera)

NASA Wallops Flight

Facility, Mid-Atlantic Regional 

Spaceport (MARS)

Project/organization University of Tokyo

Mozhaisky Military Space 

University

University of Tokyo

National Aeronautics and Space 

Administration (NASA)

Nation/Country Japan Russia Japan USA

Frequency band

UHF

(Downlink 437.4900 MHz 

AFSK 1200 BPS)

UHF

(Downlink 435.3520 MHz)

UHF

(Downlink 437.3450 MHz 

AFSK 1200 BPS)

UHF

(Downlink 437.0750 MHz 

AFSK 1200 BPS)

Application

Telecommunications

(Amateur radio)

Telecommunications

(Amateur radio)

Telecommunications

(Amateur radio)

Telecommunications

(Amateur radio)

Image



Year 2007 2008

Name CAPE-1

Delfi OSCAR-64

(Delfi-C3)

Cubesat Oscar-65

(Cute-1.7 + APD II)

Cubesat Oscar - 66

(SEEDS II)

Date 2007-04-17 28 April, 2008 28 April, 2008 28 April, 2008

Mass ? 2.2 kg 3 kg 1 kg

Size CubeSat (1U) 10cm x 10cm x 34cm 20cmx15cmx10cm 10 x 10 x 10 cm

Types of orbit

LEO

LEO

Apogee: 642.10 km

Perigee: 621.60 km

LEO

Apogee: 641.90 km

Perigee: 622.30 km

LEO

Apogee: 642.90 km

Perigee: 621.80 km

Inclination ? 98.00° 98.00° 98.00 °

Period [minutes] ? 97.35 97.36 97.36

Launch vehicle Dnepr PSLV PSLV PSLV

Launch location

Baikonur Cosmodrome, 

Kazakhstan

Satish Dawan Space

Center, India

Satish Dawan Space

Center, India

Satish Dawan Space

Center, India

Project/organization

University of Louisiana at 

Lafayette (Students)

Delft University of 

Technology

Tokyo Institute of 

Technology

Nihon University

Nation/Country ? Netherlands Japan Japan

Frequency band ?

VHF

(Downlink 145.8700 MHz 

BPSK 1200 BPS )

UHF

(437.4750 MHz GMSK 9600 

BPS)

UHF

(Downlink 437.4850 MHz FM)

Application Technology Demonstration

Telecommunications

(Amateur radio)

Telecommunications

(Amateur radio)

Telecommunications

(Amateur radio)

Image ?



Year 2008 2009

Name COMPASS-1

PRISM

KKS-1 STARS

Date 28 April, 2008 23 January, 2009 23 January, 2009 23 January, 2009

Mass 1 kg 8 kg 3 kg 8 kg

Size 1U CubeSat 19cm x 19cm x 30cm 15cm x 15cm x 15cm 16cm x 16cm x 16cm

Types of orbit

LEO

Apogee: 642.30 km

Perigee: 621.50 km

LEO

Apogee: 670.00 km

Perigee: 660.00 km

LEO

Apogee: 670.00 km

Perigee: 660.00 km

LEO

Apogee: 670.00 km

Perigee: 660.00 km

Inclination 98.00° 98.03° 98.00 ° 98.00°

Period [minutes] 97.35 98.04 98.04 98.04

Launch vehicle PSLV H-IIA F15 H-IIA F15 H-IIA F15

Launch location

Satish Dawan Space

Center, India

Tanegashima Space Center, 

Tanegashima

Tanegashima Space Center, 

Tanegashima

Tanegashima Space Center, 

Tanegashima

Project/organization

Aachen University of Applied 

Sciences

Intelligent Space Systems 

Laboratory (ISSL) of 

University of Tokyo

Tokyo Metropolitan College 

of Industrial Technology

Kagawa University

Nation/Country Germany Japan Japan Japan

Frequency band

UHF

(Downlink 437.4050 MHz 

AFSK 1200 BPS)

UHF

(Downlink 437.4250 MHz 

AFSK 1200 BPS)

UHF

(Downlink 437.4450 MHz 

AX.25)

UHF

(Downlink 437.4850 MHz 

AX.25)

Application

Telecommunications

(Amateur radio)

Telecommunications

(Amateur radio)

Telecommunications

(Amateur radio)

Telecommunications

(Amateur radio)

Image ?



Year 2009

Name SwissCube ITUpSAT1 UWE-2 BEESAT

Date 23 September, 2009 23 September, 2009 23 September, 2009 23 September, 2009

Mass 1 kg 1 kg 1 kg 1 kg

Size 10cm cube 10cm cube 10cm cube 10cm cube

Types of orbit

LEO

Apogee: 752.00 km

Perigee: 726.00 km

LEO

Apogee: 752.00 km

Perigee: 726.00 km

LEO

Apogee: 752.00 km

Perigee: 726.00 km

LEO

Apogee: 752.00 km

Perigee: 726.00 km

Inclination 98.28° 98.29° 98.30° 98.30°

Period [minutes] 99.59 99.59 99.59 99.59

Launch vehicle PSLV-C14 PSLV-C14 PSLV-C14 PSLV-C14

Launch location

Satish Dawan Space

Center, India

Satish Dawan Space

Center, India

Satish Dawan Space

Center, India

Satish Dawan Space

Center, India

Project/organization

Ecole Polytechnique Federale 

De Lausanne

Istanbul Teknik Universitesi Universitat Wurzburg Technische Universitat Berlin

Nation/Country Switzerland Turkey Germany Germany

Frequency band

UHF

(Downlink 437.5050 MHz 

FSK 1200 BPS)

UHF

(Downlink 437.3250 MHz)

UHF

(Downlink 437.3850 MHz 

FSK 9600 BPS)

UHF

(Downlink 436.0000 MHz 

GMSK 9600 BPS)

Application

Telecommunications

(Amateur radio)

Telecommunications

(Amateur radio)

Telecommunications

(Amateur radio)

Telecommunications

(Amateur radio)

Image



Year 2010

Name RAX O/OREOS

Date 20 November, 2010 20 November, 2010

Mass 2.8 kg 5.5 kg

Size 10cmx10cmx34cm 10cmx10cmx34cm

Types of orbit

LEO

Apogee: 650.00 km

Perigee: 650.00 km

LEO

Apogee: 650.00 km

Perigee: 650.00 km

Inclination 72.00° 72.00°

Period [minutes] 97.73 97.73

Launch vehicle Minotaur IV Minotaur IV

Launch location Kodiak, Alaska, USA Kodiak, Alaska, USA

Project/organization

University of Michigan and 

SRI International

NASA Ames and Santa Clara 

University

Nation/Country USA USA

Frequency band

UHF

(Downlink 437.5050 MHz 

GMSK 9600 BPS)

UHF

(Downlink 437.3050 MHz AX.25 

1200 BPS)

Application

Telecommunications

(Amateur radio)

Telecommunications

(Amateur radio)

Image

Table A.I.1 : History of nanosatellites



Annex II

A.II.1 Frame structure

A. AX.25 protocol

Each frame is made up of several smaller groups, called fields. The AX.25’s frame structure is shown in Figure A.II.1. 

Note that the first bit to be transmitted is on the left side.

U and S frame construction

Information frame construction

Figure A.II.1 : AX.25’s frame structure

 Flag field: is a frame delimiter for synchronization, one octet long “01111110”, and occurs at both the beginning 

and the end of each frame.

 Address field: identifies both the source of the frame and its destination in order to route the packet. It can contain 2 

to 10 ham calls.

 Control field: contains some control information such as the kind of packet, the number of the packet, and much 

more.

 Protocol ID (PID) field: appears in the information frames I (Information) and UI (Unnumbered information) only

for identifying which kind of layer 3 protocol used.

 Information field: contains data to be sent (up to 256 bytes)

 Frame Check Sequence (FCS) field: is a code (16 bits) inserted after data to detect possible transmission errors.

B. D-STAR protocol

The DV mode’s frame structure of D-STAR is shown in Figure A.II.2.

Synchronization Radio Header Data End-of-frame

Figure A.II.2 : D-STAR’s frame structure in DV mode

 Synchronization

There are 2 kinds of synchronization fields (or patterns) at the beginning of the frame:

- The bit synchronization pattern (64-bit long in the protocol). For GMSK modulation, this pattern consists in 16 

repetitions of the four bits 1010 placed at the beginning of the frame. For QPSK modulation, these four bits are 

1001.

- The frame synchronization pattern (15-bit long in the protocol, 111011001010000).

End-of-frame

15 bits

Frame synch 

inverted

Bit synch

32 bits



 Radio header

The radio header, or simply called header, is 328 bits long (before coding) and contains some information about the 

frame. The successive fields are:

- Three 1-byte flags that give some information about the kind of communication (flag 1) or are left available for 

further development of the protocol (flags 2 and 3)

- The ID field (36 bytes) which is used to identify of the sender and destination. It consists of a series of the 

destination repeater call sign, the departure repeater call sign, the companion call sign, the own call sign 1, and 

the own call sign 2 used for additional information about the transmitter.

- P_FCS (Frame Check Sequence) which is an error-detection code (2 bytes). It permits one to detect the 

presence of some type of errors but not to correct them.

 Data

The data part of the D-STAR frame consists in an alternance of voice frame (72 bits) and data frame (24 bits), always 

starting with a voice frame.

 End-of-frame pattern

The end-of-frame pattern is composed of 32 synchronization bits 1010 followed by the beginning-of-frame pattern 

inverted: 000100110101111.

C. Beacon

The Beacon’s frame structure is illustrated in the Figure A.II.3.

HI HI DE OUFTI1 SW AA BB … PP YY ZZ

Figure A.II.3 : Beacon’s frame structure

HI HI DE and ZZ: Synchronization

OUFTI1: Identification

SW (Status Word): 8 bits of status

AA BB … PP: 16 value of 8 bits

YY: Checksum



A.II.2 Formulas of orbital mechanics

Input parameters

Variable inputs Fixed inputs

Name     :   Name of orbit type Earth gravity constant u =398600,607 [km^3/s^2]

f_up      :   Frequency uplink [MHz] Earth Radius Re = 6378,136 [km]

f_down :   Frequency downlink [MHz]

Second zonal harmonic 

of the Earth planet

J2 = 1,08263×10^-3 [Unit less]

elev      :   Elevation angle [degrees] Radians to degrees rad2deg = 180/pi [Unit less]

ha       :   Height of apogee [km] Degrees to radians deg2rad = pi/180 [Unit less]

hp        :   Height of perigee [km] Seconds to minutes sec2mn = 1/60 [Unit less]

Relative spacing between satellites in 

adjacent planes F (0<= F <= P-1)

[Unit less]

Inclination (i) [degrees]

Argument of perigee (w) [degrees]

R.A.A.N: Right Ascension of the 

Ascending node (o)

[degrees]

True anomaly initial (v) [degrees]

Calculation parameters

1/ Orbital Parameters

Semimajor axis (a) a = (ha+hp+2×Re)/2 [km]

Eccentricity (e) e = [(ha+Re)-(hp+Re)]/[(ha+Re)+(hp+Re)] [Unit less]

Orbit period (T) T = (2×pi) × a× sqrt(a/u)×sec2mn [minutes]

Initial Value of eccentric (E) E_ini = 2×atan(sqrt((1-e)/(1+e))×tan(v/2×deg2rad)); [rad]

Mean anomaly (M) M_ini = E_ini-e×sin(E_ini); [rad]

Time rate of change of w (dw)

dw = -[3/2×(sqrt(u)×J2×Re^2)/((1-

e^2)^2×(a^(7/2)))]×(5/2×(sin(i×deg2rad))^2-2)

[rad/s]

dw_DegPerDay = dw×rad2deg×3600×24 [deg/day]

Time variation of R.A.A.N (do)

do = -[3/2×(sqrt(u)×J2×Re^2)/((1-

e^2)^2×(a^(7/2)))]×cos(i×deg2rad)

[rad/s]

do_DegPerDay = do×rad2deg×3600×24; [deg/day]

Sun-synchronous inclination

X=-0.098919152×(1-e^2)^2×(a/Re)^3.5;

if -1<=X && X<=1

i_SunSynchro = acos(X)×rad2deg;

fprintf('\n Sun-synchronous inclination \t\t %.2f \t\t degrees', 

i_SunSynchro);

else

fprintf('\n Sun-synchronous inclination \t\t None');

end;

[degrees]

Orbit radius

Minimum orbit radius r_min = hp+Re [km]

Maximum orbit radius r_max = ha+Re [km]

Mean orbit radius r_mean = a [km]

2/ Slant Range and Free Space Path Loss

Slant range

Slant range S = sqrt(r^2-Re^2×(cos(elev×deg2rad))^2)-Re×sin(elev×deg2rad) [km]

Minimum slant range

S_min = sqrt(r_min^2-Re^2×(cos(elev×deg2rad))^2)-

Re×sin(elev×deg2rad)

[km]

Maximum slant range

S_max = sqrt(r_max^2-Re^2×(cos(elev×deg2rad))^2)-

Re×sin(elev×deg2rad)

[km]

Mean slant range

S_mean = sqrt(r_mean^2-Re^2×(cos(elev×deg2rad))^2)-

Re×sin(elev×deg2rad)

[km]

Propagation delay

Propagation delay Propagation_delay = S×10^3/c [sec]

Minimum Propagation delay Propagation_delay_min = S_min×10^3/c [sec]

Maximum Propagation delay Propagation_delay_max = S_max×10^3/c [sec]



Mean Propagation delay Propagation_delay_mean = S_mean×10^3/c [sec]

Wavelength

Wavelength uplink Lambda_up = c/(f_up×10^6) [m]

Wavelength Downlink Lambda_down = c/(f_down×10^6) [m]

Free Space (FS) path loss

Uplink

Uplink FS path loss L_up=22+20×log10((S×1000)/Lambda_up) [dB]

Minimum FS path loss L_min_up=22+20×log10((S_min×1000)/Lambda_up) [dB]

Maximum FS path loss L_max_up=22+20×log10((S_max×1000)/Lambda_up) [dB]

Mean FS path loss L_mean_up=22+20×log10((S_mean×1000)/Lambda_up) [dB]

Downlink

Downlink FS path loss L_down=22+20×log10((S×1000)/Lambda_down) [dB]

Minimum FS path loss L_min_down=22+20×log10((S_min×1000)/Lambda_down) [dB]

Maximum FS path loss L_max_down=22+20×log10((S_max×1000)/Lambda_down) [dB]

Mean FS path loss L_mean_down=22+20×log10((S_mean×1000)/Lambda_down) [dB]

3/ Zone Coverage, Duration of Visibility and Number of Satellite Required for Continuous Coverage

Nadir angle

Nadir angle alpha = asin(Re/r×cos(elev×deg2rad))×rad2deg [degrees]

Minimum nadir angle alpha_min = asin(Re/r_max×cos(elev×deg2rad))×rad2deg [degrees]

Maximum nadir angle alpha_max = asin(Re/r_min×cos(elev×deg2rad))×rad2deg [degrees]

Mean nadir angle alpha_mean = asin(Re/r_mean×cos(elev×deg2rad))×rad2deg [degrees]

Central angle

Central angle beta = acos((Re/r×cos(elev×deg2rad)))×rad2deg-elev [degrees]

Minimum central angle beta_min = acos((Re/r_min×cos(elev×deg2rad)))×rad2deg-elev [degrees]

Maximum central angle beta_max = acos((Re/r_max×cos(elev×deg2rad)))×rad2deg-elev [degrees]

Mean central angle beta_mean = acos((Re/r_mean×cos(elev×deg2rad)))×rad2deg-elev [degrees]

Footprint length

Footprint length FPL = 2×Re×beta×deg2rad [km]

Minimum footprint length FPL_min = 2×Re×beta_min×deg2rad [km]

Maximum footprint length FPL_max = 2×Re×beta_max×deg2rad [km]

Mean footprint length FPL_mean = 2×Re×beta_mean×deg2rad [km]

Footprint area

Footprint area FPA = 2×pi×Re^2×(1-cos(beta×deg2rad)) [km^2]

Minimum footprint area FPA_min = 2×pi×Re^2×(1-cos(beta_min×deg2rad)) [km^2]

Maximum footprint area FPA_max = 2×pi×Re^2×(1-cos(beta_max×deg2rad)) [km^2]

Mean footprint area FPA_mean = 2×pi×Re^2×(1-cos(beta_mean×deg2rad)) [km^2]

Velocity of the satellite

Velocity of satellite V = sqrt(u×10^6×(2/r-1/a)) [m/s]

Minimum velocity of satellite V_min = sqrt(u×10^6×(2/r_max-1/a)) [m/s]

Maximum velocity of satellite V_max = sqrt(u×10^6×(2/r_min-1/a)) [m/s]

Mean velocity of satellite V_mean = sqrt(u×10^6×(2/r_mean-1/a)) [m/s]

Duration of Visibility

Duration of visibility t = FPL×10^3/V×sec2mn [minutes]

Minimum duration of visibility t_min = FPL_min×10^3/V_max×sec2mn [minutes]

Maximum duration of visibility t_max = FPL_max×10^3/V_min×sec2mn [minutes]

Mean duration of visibility t_mean = FPL_mean×10^3/V_mean×sec2mn [minutes]

Number of satellites required for continuous coverage

Number of satellite required N = ceil(T/t) [Unit less]

Minimum number of satellite required N_min = ceil(T/t_max) [Unit less]

Maximum number of satellite required N_max = ceil(T/t_min) [Unit less]

Mean number of satellite required N_mean = ceil(T/t_mean) [Unit less]

4/ Time of Flight (TOF) from perigee to true anomaly initial

Initial Value of eccentric (E) E = 2×atan(sqrt((1-e)/(1+e))×tan(v/2×deg2rad)) [rad]

Mean anomaly (M) M = E-e×sin(E×deg2rad) [rad]

Time of Flight (TOF)

if E>=0

TOF = M×T/(2×pi);

[minutes]



else

TOF = T+(M×T/(2×pi));

end

5/ Constellation

Walker Star constellation

=========================

Street width

Street width
beta_street = acos(cos(beta×deg2rad)/cos(pi/N))

[rad]

Minimum street width
beta_street_min = acos(cos(beta_min×deg2rad)/cos(pi/N_max))

[rad]

beta_street_min_deg = beta_street_min×rad2deg
[degrees]

Maximum street width
beta_street_max = acos(cos(beta_max×deg2rad)/cos(pi/N_min))

[rad]

beta_street_max_deg = beta_street_max×rad2deg
[degrees]

Mean street width
beta_street_mean = acos(cos(beta_mean×deg2rad)/cos(pi/N_mean))

[rad]

beta_street_mean_deg = beta_street_mean×rad2deg
[degrees]

if beta_street_min>beta_street_max

temp=beta_street_min;

beta_street_min=beta_street_max;

beta_street_max=temp;

end

Street of coverage (SOC)

SOC
SOC_rad = 2×beta_street

[rad]

Minimum SOC
SOC_min_rad = 2×beta_street_min

[rad]

SOC_min_km = 2×Re×beta_street_min
[km]

Maximum SOC
SOC_max_rad = 2×beta_street_max

[rad]

SOC_max_km = 2×Re×beta_street_max
[km]

Mean SOC
SOC_mean_rad = 2×beta_street_mean

[rad]

SOC_mean_km = 2×Re×beta_street_mean
[km]

Perpendicular separation distance between adjacent planes moving in the same direction, D_SD

D_SD
D_SD = beta_street×rad2deg + beta

[degrees]

Minimum D_min_SD = beta_street_min×rad2deg + beta_min [degrees]

Maximum D_max_SD = beta_street_max×rad2deg + beta_max [degrees]

Mean D_mean_SD = beta_street_mean×rad2deg + beta_mean [degrees]

Perpendicular separation distance between adjacent planes moving in the opposite direction, D_OD

D_OD D_OD = 2×beta_street×rad2deg [degrees]

Minimum D_min_OD = 2×beta_street_min×rad2deg [degrees]

Maximum D_max_OD = 2×beta_street_max×rad2deg [degrees]

Mean D_mean_OD = 2×beta_street_mean×rad2deg [degrees]

Number of planes

Number of planes P = round([(180 - D_OD)/(D_SD)]+1) [Unit less]

Minimum number of planes P_min = round([(180 - D_max_OD)/(D_max_SD)]+1) [Unit less]

Maximum number of planes P_max = round([(180 - D_min_OD)/(D_min_SD)]+1) [Unit less]

Mean number of planes P_mean = round([(180 - D_mean_OD)/(D_mean_SD)]+1) [Unit less]

Total number of satellite, TNOS

Total number of satellite TNOS = N×P [Unit less]

Minimum total number of satellite TNOS_min = N_min×P_min [Unit less]

Maximum total number of satellite TNOS_max = N_max×P_max [Unit less]

Mean total number of satellite TNOS_mean = N_mean×P_mean [Unit less]

Walker Delta constellation (i:TNOS/P/F)

=========================

Pattern Unit (PU)

PU PU = 360/TNOS [degrees]

Minimum PU PU_min = 360/TNOS_min [degrees]

Maximum PU PU_max = 360/TNOS_max [degrees]

Mean PU PU_mean = 360/TNOS_mean [degrees]

Node spacing

Node spacing NodeSpacing= PU× N [degrees]

Minimum Node spacing NodeSpacing_min= PU_min × N_min [degrees]

Maximum Node spacing NodeSpacing_max= PU_max × N_max [degrees]



Mean Node spacing NodeSpacing_mean= PU_mean × N_mean [degrees]

In-plane spacing between satellite

In-plane spacing between satellite IPS = PU × P [degrees]

Minimum IPS_min = PU_min × P_min [degrees]

Maximum IPS_max = PU_max × P_max [degrees]

Mean IPS_mean = PU_mean × P_mean [degrees]

Phase difference between adjacent planes

Phase difference between adjacent planes APS = PU × F [degrees]

Minimum APS_min = PU_min × F [degrees]

Maximum APS_max = PU_max × F [degrees]

Mean APS_mean = PU_mean × F [degrees]

Table A.II.1 : Formulas of orbital mechanics



A.II.3 MATLAB code for orbital mechanics

%-------------------------------------------------------------------------

%   Orbital Mechanics with MATLAB

%-------------------------------------------------------------------------

function [] = orbit_prop (Name, ha, hp, i, elev, w, o, v, f_up, f_down, F)

% Elliptical orbit:

% LEO  :       orbit_prop('LEO', 1447, 354, 71, 5, 30, 45, 15, 435, 145, 1)

% VLEO :       orbit_prop('VLEO', 370, 368, 40.02, 5, 30, 45, 15, 435, 145, 1)

% MEO(Molnya): orbit_prop('MEO (Molnya)', 39105, 1250, 63.4, 5, 30, 45, 15, 435, 145, 1)

% MEO(Tundra): orbit_prop('MEO (Tundra)', 46340, 25231, 63.4, 5, 30, 45, 15, 435, 145, 1)

% Circular orbit:

% LEO :           orbit_prop('LEO', 650, 650, 72, 5, 0, 45, 45, 435, 145, 1)

%%I%%       >>>>>>>>>>>>>>>>>>>> The input parameters <<<<<<<<<<<<<<<<<<<<

%%I.1%%     >>> Variable inputs

% Name, ha, hp, i are chosen to vary for comparison in our case.

% Name      :   Name of orbit type

% f_up      :   Frequency uplink                                  [MHz]

% f_down    :   Frequency downlink                                [MHz]

% elev      :   Elevation Angle        [degrees]

% ha        :   Height of Apogee                                  [km]

% hp        :   Height of Perigee                                 [km]

% Relative spacing between satellites in adjacent planes F; % 0<= F <= P-1  [unit less]

% i, w, o, and v: Obtain by satellite measurement system

% i         :   Inclination                                       [degrees]

% w         :   Argument of Perigee                               [degrees]

% o     :   R.A.A.N: Right Ascension of the Ascending node    [degrees]

% v         :   True anomaly initial                              [degrees]

%%I.2%%     >>> Fix inputs

u = 398600.607;           % Earth gravity constant                 [km^3/s^2]

Re = 6378.136;            % Earth Radius                                      [km]

J2 = 1.08263*10^-3;       % Second zonal harmonic of the Earth planet         [unit less]

c=299.8*10^6;             % Speed of light                   [m/s]

rad2deg = 180/pi;         % Radians to degrees

deg2rad = pi/180;         % Degrees to radians

sec2mn = 1/60;            % Seconds to minutes

% The Keplerian elements are:

%   a  : semimajor axis                            [km]

%   e  :  eccentricity                              [unit less]

%   i  :  inclination                               [degrees]

%  o  :  right ascension of the ascending node     [degrees]

%   w  :  argument of perigee                       [degrees]

%   v  :  true anomaly                              [degrees]

%%II%%      >>>>>>>>>>>>>>>>>>>>> Orbit Properties <<<<<<<<<<<<<<<<<<<<<<

%%II.1%%    >>> Orbital Parameters

% Input parameters: ha, hp, Re, i, o, w, v



a = (ha+hp+2*Re)/2;                         %   a : Semimajor Axis          [km]

e = [(ha+Re)-(hp+Re)]/[(ha+Re)+(hp+Re)];    %   e : Eccentricity            [unit less]

T = (2*pi) * a* sqrt(a/u)*sec2mn;           %   T : Orbit period            [minutes]

% Initial Value of eccentric (E) [rad]

E_ini = 2*atan(sqrt((1-e)/(1+e))*tan(v/2*deg2rad));

% Mean anomaly (M) [rad]

M_ini = E_ini-e*sin(E_ini);

% The time rate of change of the argument of perigee [rad/s]

dw = -[3/2*(sqrt(u)*J2*Re^2)/((1-e^2)^2*(a^(7/2)))]*(5/2*(sin(i*deg2rad))^2-2);

% The time rate of change of the argument of perigee [deg/day]

dw_DegPerDay = dw*rad2deg*3600*24;                                            

% dw_DegPerDay = 19.92770307*1/(1-e^2)^2*(Re/a)^3.5*(1-1.25*(sin(i))^2) 

% dw_DegPerDay > 0, or 0°<=i<63.4° or 116.6°<i<=180°  : the perigee advances in the 

direction of the motion of the satellite (hence, the name advance of perigee for this 

phenomenon).

% dw_DegPerDay < 0, or 63.4°<=i<116.6°                : the perigee regresses, moving 

opposite to the direction of motion.

% dw_DegPerDay = 0 when J2=0, or i= 63.4° or i=116.6° : are the critical inclinations at 

which the apse line does not move.

% The time variation of the right ascension o or the rate of drift [rad/s]

do = -[3/2*(sqrt(u)*J2*Re^2)/((1-e^2)^2*(a^(7/2)))]*cos(i*deg2rad);

% The time variation of the right ascension o or the rate of drift [deg/day]

do_DegPerDay = do*rad2deg*3600*24;                                            

% do_DegPerDay = -9.963851533*1/(1-e^2)^2*(Re/a)^3.5*cos(i)

% do_DegPerDay < 0, or 0°<=i<90°          : Prograde orbits, the node line drifts 

westward.

% do_DegPerDay > 0, or 90°<i<=180°        : Retrograde orbits, the node line drifts 

eastward.

% do_DegPerDay = 0 when J2=0, or i=90°    : Polar orbits, the node line is stationary.

fprintf('\n The Orbit Properties of %s orbit are in the list below: \n\n', Name);

fprintf('\n------------------------------------------------------------------------------

--------------------------------------');

fprintf('\n \t\t\t\t\t ***** The Orbit Properties of %s orbit *****', Name);

fprintf('\n------------------------------------------------------------------------------

--------------------------------------');

fprintf('\n Parameter \t\t\t\t\t\t\t Value ');

fprintf('\n------------------------------------------------------------------------------

--------------------------------------');

fprintf('\n 1/ Orbital Parameters ');

fprintf('\n------------------------------------------------------------------------------

--------------------------------------');

fprintf('\n Earth radius (Re) \t\t\t\t\t %.2f \t km', Re);

fprintf('\n Height of apogee (ha) \t\t\t\t %.2f \t km', ha);

fprintf('\n Height of perigee (hp) \t\t\t %.2f \t km', hp);

fprintf('\n Elevation angle (elev) \t\t\t %.2f \t\t degrees', elev);

fprintf('\n Inclination (i) \t\t\t\t\t %.2f \t\t degrees', i);

fprintf('\n R.A.A.N (o) \t\t\t\t\t\t %.2f \t\t degrees', o);

fprintf('\n Argument of perigee (w) \t\t\t %.2f \t degrees', w);

fprintf('\n True anomaly (v) \t\t\t\t\t %.2f \t\t degrees', v);

fprintf('\n Mean anomaly (M) \t\t\t\t\t %.2f \t\t degrees', radtodeg(M_ini));

fprintf('\n Semimajor axis (a) \t\t\t\t %.2f \t km', a);

fprintf('\n Eccentricity (e) \t\t\t\t\t %e \t\t unit less', e);

fprintf('\n Orbit period (T) \t\t\t\t\t %.2f  \t minutes', T);

fprintf('\n Time rate of change of w (dw) \t\t %.2f \t\t degrees/day', dw_DegPerDay);

fprintf('\n Time variation of R.A.A.N (do) \t %.2f \t\t degrees/day', do_DegPerDay);



% The sun-synchronous inclination [deg]

X=-0.098919152*(1-e^2)^2*(a/Re)^3.5;

if -1<=X && X<=1

i_SunSynchro = acos(X)*rad2deg;

fprintf('\n Sun-synchronous inclination \t\t %.2f \t\t degrees', i_SunSynchro);

else

fprintf('\n Sun-synchronous inclination \t\t None');

end;

fprintf('\n------------------------------------------------------------------------------

--------------------------------------');

% return;

%%II.2%%    >>> Slant Range and Free Space Path Loss

% We calculate the Slant Range and Free Space Path Loss for r_min, r_max and r_mean by 

assuming the elevation angle 5 degrees.

% Input parameters: ha, hp, Re, elev, f_up, f_down

if ha==hp

H=ha;   % Orbit altitude [km]

r = H+Re; % orbit radius [km]

S = sqrt(r^2-Re^2*(cos(elev*deg2rad))^2)-Re*sin(elev*deg2rad);     % Slant range [km]

Propagation_delay = S*10^3/c; % [sec]

Lambda_up = c/(f_up*10^6);           % Wavelenght uplink     [m]

Lambda_down = c/(f_down*10^6); % Wavelenght downlink   [m]

L_up=22+20*log10((S*1000)/Lambda_up);   % Minimum Free Space Path Loss of uplink [dB]

L_down=22+20*log10((S*1000)/Lambda_down); % Minimum Free Space Path Loss of uplink [dB]

fprintf('\n 2/ Slant Range and Free Space Path Loss ');

fprintf('\n--------------------------------------------------------------------------

------------------------------------------');

fprintf('\n Orbit altitude \t\t\t\t\t %.2f \t km ', H);

fprintf('\n Orbit radius \t\t\t\t\t\t %.2f \t km ', r);

fprintf('\n Slant range \t\t\t\t\t\t %.2f \t km ', S);

fprintf('\n Propagation delay \t\t\t\t\t %.2f \t\t sec ', Propagation_delay);

fprintf('\n \t\t\t\t\t Uplink ');

fprintf('\n \t\t\t\t\t ------ ');

fprintf('\n Frequency uplink \t\t\t\t\t %.2f \t MHz', f_up);

fprintf('\n Wavelength uplink \t\t\t\t\t %.2f \t\t m', Lambda_up);

fprintf('\n Free Space (FS) path loss \t\t\t %.2f \t dB ', L_up);

fprintf('\n \t\t\t\t\t Downlink ');

fprintf('\n \t\t\t\t\t ------ ');

fprintf('\n Frequency downlink \t\t\t\t %.2f \t MHz', f_down);

fprintf('\n Wavelength downlink \t\t\t\t %.2f \t\t m', Lambda_down);

fprintf('\n Free Space (FS) path loss \t\t\t %.2f \t dB ', L_down);

fprintf('\n--------------------------------------------------------------------------

------------------------------------------');

else

H_min = hp;                         % Minimum orbit altitude [km]

H_max = ha;                       % Maximum orbit altitude [km]

H_mean = (ha+hp)/2;                 % Mean orbit altitude [km]    

r_min = hp+Re;                      % Minimum orbit radius [km]

r_max = ha+Re;                      % Maximum orbit radius [km]

r_mean = a;                         % Mean orbit radius    [km]

% Elevation angle assume to be 5 degrees anywhere of satellite orbiting the Earth



S_min = sqrt(r_min^2-Re^2*(cos(elev*deg2rad))^2)-Re*sin(elev*deg2rad);     

% Minimum slant range [km]

S_max = sqrt(r_max^2-Re^2*(cos(elev*deg2rad))^2)-Re*sin(elev*deg2rad);     

% Maximum slant range [km]

S_mean = sqrt(r_mean^2-Re^2*(cos(elev*deg2rad))^2)-Re*sin(elev*deg2rad);   

% Mean slant range    [km]

Propagation_delay_min = S_min*10^3/c; % [sec]

Propagation_delay_max = S_max*10^3/c; % [sec]

Propagation_delay_mean = S_mean*10^3/c; % [sec]

Lambda_up = c/(f_up*10^6);           % Wavelenght uplink     [m]

Lambda_down = c/(f_down*10^6);       % Wavelenght downlink   [m]

L_min_up=22+20*log10((S_min*1000)/Lambda_up);            % Minimum Free Space Path 

Loss of uplink [dB]

L_max_up=22+20*log10((S_max*1000)/Lambda_up);            % Minimum Free Space Path 

Loss of uplink [dB]

L_mean_up=22+20*log10((S_mean*1000)/Lambda_up);          % Mean Free Space Path Loss 

of uplink    [dB]

L_min_down=22+20*log10((S_min*1000)/Lambda_down);        % Minimum Free Space Path 

Loss of uplink [dB]

L_max_down=22+20*log10((S_max*1000)/Lambda_down);        % Minimum Free Space Path 

Loss of uplink [dB]

L_mean_down=22+20*log10((S_mean*1000)/Lambda_down);      % Mean Free Space Path Loss 

of uplink    [dB]

fprintf('\n 2/ Slant Range and Free Space Path Loss ');

fprintf('\n--------------------------------------------------------------------------

------------------------------------------');

fprintf('\n Orbit altitude \t\t\t\t\t Minimum orbit altitude \t Maximum orbit 

altitude \t Mean orbit altitude');

fprintf('\n \t\t\t\t\t\t\t\t\t %.2f \t km \t\t\t %.2f \t km \t\t\t %.2f \t km', 

H_min, H_max, H_mean);

fprintf('\n Orbit radius \t\t\t\t\t\t Minimum orbit radius \t\t Maximum orbit radius 

\t\t Mean orbit radius');

fprintf('\n \t\t\t\t\t\t\t\t\t %.2f \t km \t\t\t %.2f \t km \t\t\t %.2f \t km', 

r_min, r_max, r_mean);

fprintf('\n Slant range \t\t\t\t\t\t Minimum slant range \t\t Maximum slant range 

\t\t Mean slant range');

fprintf('\n \t\t\t\t\t\t\t\t\t %.2f \t km \t\t\t %.2f \t km \t\t\t %.2f \t km',

S_min, S_max, S_mean);

fprintf('\n propagation delay \t\t\t\t\t Minimum propagation delay \t Maximum 

propagation delay \t Mean propagation delay');

fprintf('\n \t\t\t\t\t\t\t\t\t %.6f \t sec \t\t\t\t %.6f \t sec \t\t\t\t %.6f \t 

sec', Propagation_delay_min, Propagation_delay_max, Propagation_delay_mean);

fprintf('\n \t\t\t\t\t\t\t\t\t\t\t\t\t\t Uplink ');

fprintf('\n \t\t\t\t\t\t\t\t\t\t\t\t\t\t ------ ');

fprintf('\n Frequency uplink \t\t\t\t\t %.2f \t MHz', f_up);

fprintf('\n Wavelength uplink \t\t\t\t\t %.2f \t\t m', Lambda_up);

fprintf('\n Free Space (FS) path loss \t\t\t Minimum FS path loss \t\t Maximum FS 

path loss \t\t Mean FS path loss');

fprintf('\n \t\t\t\t\t\t\t\t\t %.2f \t dB \t\t\t %.2f \t dB \t\t\t %.2f \t dB', 

L_min_up, L_max_up, L_mean_up);

fprintf('\n \t\t\t\t\t\t\t\t\t\t\t\t\t\t Downlink ');

fprintf('\n \t\t\t\t\t\t\t\t\t\t\t\t\t\t ------ ');

fprintf('\n Frequency downlink \t\t\t\t %.2f \t MHz', f_down);

fprintf('\n Wavelength downlink \t\t\t\t %.2f \t\t m', Lambda_down);

fprintf('\n Free Space (FS) path loss \t\t\t Minimum FS path loss \t\t Maximum FS 

path loss \t\t Mean FS path loss');



fprintf('\n \t\t\t\t\t\t\t\t\t %.2f \t dB \t\t\t %.2f \t dB \t\t\t %.2f \t dB', 

L_min_down, L_max_down, L_mean_down);

fprintf('\n--------------------------------------------------------------------------

------------------------------------------');

end

%  return;    

%%II.3%%    >>> Zone Coverage and Duration of Visibility

% Input parameters: >>> r_min, r_max, r_mean, a (From II.2 and II.1 get by ha, hp, Re); 

Re; elev

% The zone coverage and duration of visibility depends on two parameters:

% orbit altitude and elevation angle.

% - The zone coverage is estimated at the minimum altitude, maximum altitude, and mean 

altitude with the

% elevation angle 5 degrees.

% - The duration of visibility is estimated for a constant velocity of

% satellite with the elevation angle 5 degrees during orbiting.

if ha==hp

% Nadir Angle [degrees]

alpha = asin(Re/r*cos(elev*deg2rad))*rad2deg;

% Central Angle [degrees]

beta = acos((Re/r*cos(elev*deg2rad)))*rad2deg-elev;

% Footprint Length [km]

FPL = 2*Re*beta*deg2rad;

% Footprint Area [km^2]

FPA = 2*pi*Re^2*(1-cos(beta*deg2rad));

% Velocity of the Satellite [m/s]

V = sqrt(u*10^6*(2/r-1/a));

% Duration of Visibility [minutes]

t = FPL*10^3/V*sec2mn;

fprintf('\n 3/ Zone Coverage and Duration of Visibility ');

fprintf('\n--------------------------------------------------------------------------

------------------------------------------');

fprintf('\n Orbit radius \t\t\t\t\t\t %.2f \t km ', r);  

fprintf('\n Nadir angle \t\t\t\t\t\t %.2f \t\t degrees ', alpha);

fprintf('\n Central angle \t\t\t\t\t\t %.2f \t\t degrees ', beta);

fprintf('\n Footprint length \t\t\t\t\t %.2f \t km ', FPL);

fprintf('\n Footprint area \t\t\t\t\t %.2f km^2 ', FPA);

fprintf('\n Velocity of the satellite \t\t\t %.2f \t m/s ', V);

fprintf('\n Duration of Visibility \t\t\t %.2f \t\t minutes ', t);

% The number of satellites required for the area specific coverage in one repeat 

cycle period T

N = ceil(T/t);

fprintf('\n Orbit period (T) \t\t\t\t\t %.2f \t\t minutes', T);

fprintf('\n\n Number of satellites required');

fprintf('\n for continuous coverage \t\t\t %d', N);



fprintf('\n--------------------------------------------------------------------------

------------------------------------------');

else

% Nadir Angle [degrees]

alpha_max = asin(Re/r_min*cos(elev*deg2rad))*rad2deg;            

% (Maximum) Nadir angle of minimum altitude          [degrees]

alpha_min = asin(Re/r_max*cos(elev*deg2rad))*rad2deg;            

% (Minimum) Nadir angle of maximum altitude          [degrees]

alpha_mean = asin(Re/r_mean*cos(elev*deg2rad))*rad2deg;          

% Mean nadir angle of mean altitude                  [degrees]

% Central Angle [degrees]

beta_min = acos((Re/r_min*cos(elev*deg2rad)))*rad2deg-elev;      

% Minimum central angle         [degrees]

beta_max = acos((Re/r_max*cos(elev*deg2rad)))*rad2deg-elev;      

% Maximum central angle         [degrees]

beta_mean = acos((Re/r_mean*cos(elev*deg2rad)))*rad2deg-elev;    

% Mean central angle            [degrees]

% Footprint Length [km]

FPL_min = 2*Re*beta_min*deg2rad;                % Minimum footprint length      [km]

FPL_max = 2*Re*beta_max*deg2rad;                % Maximum footprint length      [km]

FPL_mean = 2*Re*beta_mean*deg2rad;              % Mean footprint length         [km]

% Footprint Area [km^2]

FPA_min = 2*pi*Re^2*(1-cos(beta_min*deg2rad)); %  Minimum footprint area     [km^2]

FPA_max = 2*pi*Re^2*(1-cos(beta_max*deg2rad)); %  Maximum footprint area     [km^2]

FPA_mean = 2*pi*Re^2*(1-cos(beta_mean*deg2rad)); %  Mean footprint area        [km^2]

% Velocity of the Satellite [m/s]

V_max = sqrt(u*10^6*(2/r_min-1/a));                              

% (Maximum) velocity of the satellite of minimum altitude [m/s]

V_min = sqrt(u*10^6*(2/r_max-1/a));                              

% (Minimum) velocity of the satellite of maximum altitude [m/s]

V_mean = sqrt(u*10^6*(2/r_mean-1/a));                            

% Mean velocity of the satellite of mean altitude         [m/s]

% Duration of Visibility [minutes]

t_max = FPL_max*10^3/V_min*sec2mn;  % Minimum duration of visibility [minutes]

t_min = FPL_min*10^3/V_max*sec2mn;  % Maximum duration of visibility [minutes]

t_mean = FPL_mean*10^3/V_mean*sec2mn; % Mean duration of visibility    [minutes]

fprintf('\n 3/ Zone Coverage and Duration of Visibility ');

fprintf('\n--------------------------------------------------------------------------

------------------------------------------');

fprintf('\n Orbit radius \t\t\t\t\t\t Minimum orbit radius \t\t Maximum orbit radius 

\t\t Mean orbit radius');

fprintf('\n \t\t\t\t\t\t\t\t\t %.2f \t km \t\t\t %.2f \t km \t\t\t %.2f \t km', 

r_min, r_max, r_mean);

fprintf('\n Nadir angle \t\t\t\t\t\t Minimum nadir angle \t\t Maximum nadir angle 

\t\t Mean nadir angle');

fprintf('\n \t\t\t\t\t\t\t\t\t %.2f \t\t degrees \t\t %.2f \t\t degrees \t\t %.2f 

\t\t degrees', alpha_min, alpha_max, alpha_mean);

fprintf('\n Central angle \t\t\t\t\t\t Minimum central angle \t\t Maximum central 

angle \t\t Mean central angle');

fprintf('\n \t\t\t\t\t\t\t\t\t %.2f \t\t degrees \t\t %.2f \t\t degrees \t\t %.2f 

\t\t degrees', beta_min, beta_max, beta_mean);

fprintf('\n Footprint length \t\t\t\t\t Minimum footprint length \t Maximum footprint 

length \t Mean footprint length');



fprintf('\n \t\t\t\t\t\t\t\t\t %.2f \t km \t\t\t %.2f \t km \t\t\t %.2f \t km', 

FPL_min, FPL_max, FPL_mean);

fprintf('\n Footprint area \t\t\t\t\t Minimum footprint area \t Maximum footprint 

area \t Mean footprint area');

fprintf('\n \t\t\t\t\t\t\t\t\t %.2f  km^2 \t\t\t %.2f km^2 \t\t\t %.2f km^2', 

FPA_min, FPA_max, FPA_mean);

fprintf('\n Velocity of the satellite \t\t\t Minimum velocity \t\t\t Maximum velocity 

\t\t\t Mean velocity');

fprintf('\n \t\t\t\t\t\t\t\t\t %.2f \t m/s \t\t\t %.2f \t m/s \t\t\t %.2f \t m/s', 

V_min, V_max, V_mean);

fprintf('\n Duration of Visibility \t\t\t Minimum duration \t\t\t Maximum duration 

\t\t\t Mean duration');

fprintf('\n \t\t\t\t\t\t\t\t\t %.2f \t\t minutes \t\t %.2f\t\t minutes \t\t %.2f \t\t 

minutes', t_min, t_max, t_mean);

% The number of satellites required for continuous coverage in one repeat cycle 

period T

N_min = ceil(T/t_max);            % Minimum number of satellites required

N_max = ceil(T/t_min);            % Maximum number of satellites required

N_mean = ceil(T/t_mean);          % Mean number of satellites required

fprintf('\n Orbit period (T) \t\t\t\t\t %.2f \t minutes', T);

fprintf('\n Number of satellites required \t\t Minimum number \t\t\t Maximum number 

\t\t\t Mean number');

fprintf('\n for continuous coverage \t\t\t %d \t\t\t\t\t\t\t %d \t\t\t\t\t\t\t %d', 

N_min, N_max, N_mean);

fprintf('\n--------------------------------------------------------------------------

------------------------------------------');

end

% return;

%%II.4%%    >>> Time of Flight (TOF) from perigee to true anomaly initial

% Input parameters: >>> true anomaly initial (v), eccentricity (e), period (T)

% Initial Value of eccentric (E) [rad]

E = 2*atan(sqrt((1-e)/(1+e))*tan(v/2*deg2rad));

% Mean anomaly (M) [rad]

M = E-e*sin(E);

% Time of flight from perigee to true anomaly (TOF) [minutes]

if E>=0

TOF = M*T/(2*pi);

else

TOF = T+(M*T/(2*pi));

end

fprintf('\n 4/ Time of Flight (TOF) from perigee to true anomaly initial ');

fprintf('\n------------------------------------------------------------------------------

--------------------------------------');

fprintf('\n True anomaly (v) \t\t\t\t\t %.2f \t\t degrees', v);

fprintf('\n Eccentricity (e) \t\t\t\t\t %.2f \t\t unit less', e);

fprintf('\n Orbit period (T) \t\t\t\t\t %.2f  \t minutes', T);

fprintf('\n Initial Value of eccentric (E) \t %.2f \t\t radians', E);

fprintf('\n Mean anomaly (M) \t\t\t\t\t %.2f \t\t radians', M);

fprintf('\n Time of Flight (TOF) \t\t\t\t %.2f\t\t minutes', TOF);



fprintf('\n------------------------------------------------------------------------------

--------------------------------------');

%  return;

%%II.5%%    >>> Constellation

% Input parameters: >>> period (T), Duration of Visibility (t)

if ha==hp

fprintf('\n 5/ Constellation ');

fprintf('\n--------------------------------------------------------------------------

------------------------------------------');

%==============================================

% Walker Star Constellation : Approximated number of planes and total number of 

satellites

%==============================================

% Input parameters: Number of satellite per plane (N), the earth central angle (beta)

% Recall that: this constellation is used for the circular orbit with the

% same altitude and the same coverage throughout the orbit

%----------- FPL (coverage), Duration of visibility (T), Number of satellite required 

--------------

beta_street = acos(cos(beta*deg2rad)/cos(pi/N)); % Street width [rad]

beta_street_deg = beta_street*rad2deg; % Street width [deg.]

SOC_deg = 2*beta_street_deg; % Street of coverage [deg]

SOC_km = 2*Re*beta_street; % Street of coverage [km]

% The perpendicular separation or Phase difference between adjacent planes moving in 

the same direction

D_SD = beta_street*rad2deg + beta; % [deg]

% The perpendicular separation or Phase difference between adjacent planes moving in 

the opposite direction

D_OD = 2*beta_street*rad2deg; % [deg]

% We have: 2*beta_street + (P-1)*(beta_street+beta) = 180 [deg.]

P = ceil([(180 - D_OD)/(D_SD)]+1); % Number of planes

TNOS = N*P; % Total number of satellites

fprintf('\n \t\t\t Walker Star constellation : Approximated number of planes and 

total number of satellites ');

fprintf('\n \t\t\t 

========================================================================================\

n');

fprintf('\n Central angle \t\t\t\t\t\t %.2f \t\t degrees ', beta);    

fprintf('\n\n Number of satellites required');

fprintf('\n for continuous coverage \t\t\t %d ', N);

fprintf('\n (Number of satellites per plane)\n');

fprintf('\n Street width \t\t\t\t\t\t %.2f \t\t degrees ', beta_street_deg);

fprintf('\n\n Street of coverage (SOC) \t\t\t %.2f \t\t deg ', SOC_deg);

fprintf('\n \t\t\t\t\t\t\t\t\t %.2f \t km \n', SOC_km);

fprintf('\n\n Perpendicular separation (D)');

fprintf('\n between adjacent planes moving  \t %.2f \t\t degrees ', D_SD);

fprintf('\n in the same direction\n');

fprintf('\n Perpendicular separation (D)');

fprintf('\n between adjacent planes moving  \t %.2f \t\t degrees ', D_OD);

fprintf('\n in the different direction\n');



fprintf('\n Number of planes \t\t\t\t\t %d ', P); 

fprintf('\n Total number of satellite \t\t\t %d ', TNOS);

%==============================================

% Walker Delta Constellation

%==============================================

% Input parameters: i:T/P/F (i:TNOS/P/F), In our case: i:45/5/1

% TNOS: Totalnumber of satellites

% P: Number of planes

% F: Relative spacing between satellites in adjacent planes

% Relative spacing between satellites in adjacent planes

% F = 1; % 0<= F <= P-1

%----------- Number of satellite required per plane (N), Pattern Unit (PU), Node 

spacing,

%----------- In-plane spacing between satellites, Phase difference between adjacent 

planes

% Number of satellite required per plane

N = TNOS/P;

% Pattern Unit [deg.]

PU = 360/TNOS;

% Node spacing [deg.]

NodeSpacing= PU * N;

% In-plane spacing between satellites [deg.]

IPS = PU * P;

% Phase difference between adjacent planes [deg.]

APS = PU * F;

fprintf('\n\n\n \t\t\t\t\t\t\t\t\t\t\t Walker Delta constellation (i:TNOS/P/F)');

fprintf('\n \t\t\t\t\t\t\t\t\t\t\t ==========================\n');

fprintf('\n Inclination (i) \t\t\t\t\t %.2f \t\t degrees', i);

fprintf('\n Relative spacing between \t\t\t %.2f \t\t', F);

fprintf('\n satellites in adjacent planes (F)\n');

fprintf('\n Number of planes (P) \t\t\t\t %d ', P);  

fprintf('\n Total number of satellite (TNOS) \t %d ', TNOS);  

fprintf('\n Pattern Unit (PU) \t\t\t\t\t %.2f \t\t degrees ', PU);  

fprintf('\n Node spacing \t\t\t\t\t\t %.2f \t\t degrees ', NodeSpacing);  

fprintf('\n In-plane spacing between \t\t\t %.2f \t\t degrees ', IPS);

fprintf('\n satellites');

fprintf('\n Phase difference between \t\t\t %.2f \t\t degrees ', APS);

fprintf('\n adjacent planes');

fprintf('\n--------------------------------------------------------------------------

------------------------------------------');

else

fprintf('\n 5/ Constellation ');

fprintf('\n--------------------------------------------------------------------------

------------------------------------------');

%==============================================

% Walker Star Constellation : Approximated number of planes and total number of 

satellites

%==============================================

% Input parameters: Number of satellite per plane (N), the earth central angle (beta)

% Recall that: this constellation is used for the circular orbit with the



% same altitude and the same coverage throughout the orbit

%----------- Minimum FPL (coverage), Minimum duration of visibility (T), Minimum 

number of satellite required --------------

%----------- Maximum FPL (coverage), Maximum duration of visibility (T), Maximum 

number of satellite required --------------

beta_street_min = acos(cos(beta_min*deg2rad)/cos(pi/N_max)); % Street width [rad]

beta_street_max = acos(cos(beta_max*deg2rad)/cos(pi/N_min)); % Street width [rad]

if beta_street_min>beta_street_max

temp=beta_street_min;

beta_street_min=beta_street_max;

beta_street_max=temp;

else

%beta_street_min;

%beta_street_max;

end

beta_street_min_deg = beta_street_min*rad2deg; % Street width [deg.]

beta_street_max_deg = beta_street_max*rad2deg; % Street width [deg.]

SOC_min_deg = 2*beta_street_min_deg; % Street of coverage [rad]

SOC_min_km = 2*Re*beta_street_min; % Street of coverage [km]

SOC_max_deg = 2*beta_street_max_deg; % Street of coverage [rad]

SOC_max_km = 2*Re*beta_street_max; % Street of coverage [km]

% The perpendicular separation or Phase difference between adjacent planes moving in 

the same direction

D_min_SD = beta_street_min*rad2deg + beta_min; % [deg]

% The perpendicular separation or Phase difference between adjacent planes moving in 

the different direction

D_min_OD = 2*beta_street_min*rad2deg; % [deg]

% The perpendicular separation or Phase difference between adjacent planes moving in 

the same direction

D_max_SD = beta_street_max*rad2deg + beta_max; % [deg]

% The perpendicular separation or Phase difference between adjacent planes moving in 

the different direction

D_max_OD = 2*beta_street_max*rad2deg; % [deg]

% We have: 2*beta_street + (P-1)*(beta_street+beta) = 180 [deg.]

P_min = ceil([(180 - D_max_OD)/(D_max_SD)]+1); % Number of planes

% We have: 2*beta_street + (P-1)*(beta_street+beta) = 180 [deg.]

P_max = ceil([(180 - D_min_OD)/(D_min_SD)]+1); % Number of planes 

%----------- Mean FPL (coverage), Mean duration of visibility (T), Mean number of 

satellite required --------------

beta_street_mean = acos(cos(beta_mean*deg2rad)/cos(pi/N_mean)); % Street width [rad]

beta_street_mean_deg = beta_street_mean*rad2deg; % Street width [deg.]

SOC_mean_deg = 2*beta_street_mean_deg; % Street of coverage [rad]

SOC_mean_km = 2*Re*beta_street_mean; % Street of coverage [km]

% The perpendicular separation or Phase difference between adjacent planes moving in 

the same direction

D_mean_SD = beta_street_mean*rad2deg + beta_mean; % [deg]

% The perpendicular separation or Phase difference between adjacent planes moving in 

the different direction



D_mean_OD = 2*beta_street_mean*rad2deg; % [deg]

% We have: 2*beta_street + (P-1)*(beta_street+beta) = 180 [deg.]

P_mean = ceil([(180 - D_mean_OD)/(D_mean_SD)]+1); % Number of planes

TNOS_min = N_min*P_min; % Total number of satellites

TNOS_max = N_max*P_max; % Total number of satellites

TNOS_mean = N_mean*P_mean; % Total number of satellites

fprintf('\n \t\t\t Walker Star constellation : Approximated number of planes and 

total number of satellites ');

fprintf('\n \t\t\t 

========================================================================================\

n');

fprintf('\n Central angle \t\t\t\t\t\t Minimum central angle \t\t Maximum central 

angle \t\t Mean central angle');

fprintf('\n \t\t\t\t\t\t\t\t\t %.2f \t\t degrees \t\t %.2f \t\t degrees \t\t %.2f 

\t\t degrees', beta_min, beta_max, beta_mean);

fprintf('\n Number of satellites required \t\t Minimum number \t\t\t Maximum number 

\t\t\t Mean number');

fprintf('\n for continuous coverage \t\t\t %d \t\t\t\t\t\t\t %d \t\t\t\t\t\t\t %d', 

N_min, N_max, N_mean);

fprintf('\n (Number of satellites per plane)\n');

fprintf('\n Street width \t\t\t\t\t\t Minimum street width \t\t Maximum street width 

\t\t Mean street width');

fprintf('\n \t\t\t\t\t\t\t\t\t %.2f \t\t degrees \t\t %.2f \t\t degrees \t\t %.2f 

\t\t degrees', beta_street_min_deg, beta_street_max_deg, beta_street_mean_deg);

fprintf('\n Street of coverage (SOC) \t\t\t Minimum SOC \t\t\t\t Maximum SOC \t\t\t\t 

Mean SOC');

fprintf('\n \t\t\t\t\t\t\t\t\t %.2f \t\t degrees \t\t %.2f \t\t degrees \t\t %.2f 

\t\t degrees', SOC_min_deg, SOC_max_deg, SOC_mean_deg);

fprintf('\n \t\t\t\t\t\t\t\t\t %.2f \t km \t\t\t %.2f \t km \t\t\t %.2f \t km\n', 

SOC_min_km, SOC_max_km, SOC_mean_km);

fprintf('\n Perpendicular separation (D) \t\t Minimum \t\t\t\t\t Maximum \t\t\t\t\t 

Mean');

fprintf('\n between adjacent planes moving  \t %.2f \t\t degrees \t\t %.2f \t\t 

degrees \t\t %.2f \t\t degrees', D_min_SD, D_max_SD, D_mean_SD);

fprintf('\n in the same direction\n');

fprintf('\n Perpendicular separation (D) \t\t Minimum \t\t\t\t\t Maximum \t\t\t\t\t 

Mean');

fprintf('\n between adjacent planes moving  \t %.2f \t\t degrees \t\t %.2f \t\t 

degrees \t\t %.2f \t\t degrees', D_min_OD, D_max_OD, D_mean_OD);

fprintf('\n in the different direction\n');

fprintf('\n Number of planes \t\t\t\t\t Minimum number \t\t\t Maximum number \t\t\t 

Mean number');

fprintf('\n \t\t\t\t\t\t\t\t\t %d \t\t\t\t\t\t\t %d \t\t\t\t\t\t\t %d', P_min, P_max, 

P_mean);

fprintf('\n Total number of satellite \t\t\t Minimum number \t\t\t Maximum number 

\t\t\t Mean number');

fprintf('\n \t\t\t\t\t\t\t\t\t %d \t\t\t\t\t\t %d \t\t\t\t\t\t %d', TNOS_min, 

TNOS_max, TNOS_mean);

%==============================================

% Walker Delta Constellation

%==============================================

% Input parameters: i:T/P/F (i:TNOS/P/F), In our case: i:45/5/1

% TNOS: Totalnumber of satellites

% P: Number of planes



% F: Relative spacing between satellites in adjacent planes

% Relative spacing between satellites in adjacent planes

% F = 1; % 0<= F <= P-1

%----------- Number of satellite required per plane (N), Pattern Unit (PU), Node 

spacing,

%----------- In-plane spacing between satellites, Phase difference between adjacent 

planes

% Number of satellite required per plane

N_min = TNOS_min/P_min;

% Pattern Unit [deg.]

PU_min = 360/TNOS_min;

% Node spacing [deg.]

NodeSpacing_min= PU_min * N_min;

% In-plane spacing between satellites [deg.]

IPS_min = PU_min * P_min;

% Phase difference between adjacent planes [deg.]

APS_min = PU_min * F;

%----------- Number of satellite required per plane (N), Pattern Unit (PU), Node 

spacing,

%----------- In-plane spacing between satellites, Phase difference between adjacent 

planes

% Number of satellite required per plane

N_max = TNOS_max/P_max;

% Pattern Unit [deg.]

PU_max = 360/TNOS_max;

% Node spacing [deg.]

NodeSpacing_max= PU_max * N_max;

% In-plane spacing between satellites [deg.]

IPS_max = PU_max * P_max;

% Phase difference between adjacent planes [deg.]

APS_max = PU_max * F;

%----------- Number of satellite required per plane (N), Pattern Unit (PU), Node 

spacing,

%----------- In-plane spacing between satellites, Phase difference between adjacent 

planes

% Number of satellite required per plane

N_mean = TNOS_mean/P_mean;

% Pattern Unit [deg.]

PU_mean = 360/TNOS_mean;

% Node spacing [deg.]

NodeSpacing_mean= PU_mean * N_mean;

% In-plane spacing between satellites [deg.]

IPS_mean = PU_mean * P_mean;

% Phase difference between adjacent planes [deg.]

APS_mean = PU_mean * F;

fprintf('\n\n\n \t\t\t\t\t\t\t\t\t\t\t Walker Delta constellation (i:TNOS/P/F)');

fprintf('\n \t\t\t\t\t\t\t\t\t\t\t ===========================\n');

fprintf('\n Inclination (i) \t\t\t\t\t %.2f \t\t degrees', i);

fprintf('\n Relative spacing between \t\t\t %.2f \t\t', F);

fprintf('\n satellites in adjacent planes (F)\n');

fprintf('\n Number of planes (P) \t\t\t\t Minimum number \t\t\t Maximum number \t\t\t 

Mean number');



fprintf('\n \t\t\t\t\t\t\t\t\t %d \t\t\t\t\t\t\t %d \t\t\t\t\t\t\t %d', P_min, P_max, 

P_mean);

fprintf('\n Total number of satellite (TNOS) \t Minimum number \t\t\t Maximum number 

\t\t\t Mean number');

fprintf('\n \t\t\t\t\t\t\t\t\t %d \t\t\t\t\t\t %d \t\t\t\t\t\t %d', TNOS_min, 

TNOS_max, TNOS_mean);

fprintf('\n Pattern Unit (PU) \t\t\t\t\t Minimum PU \t\t\t\t Maximum PU \t\t\t\t Mean 

PU');

fprintf('\n \t\t\t\t\t\t\t\t\t %.2f \t\t degrees \t\t %.2f \t\t degrees \t\t %.2f 

\t\t degrees', PU_min, PU_max, PU_mean);

fprintf('\n Node spacing \t\t\t\t\t\t Minimum \t\t\t\t\t Maximum \t\t\t\t\t Mean');

fprintf('\n \t\t\t\t\t\t\t\t\t %.2f \t\t degrees \t\t %.2f \t\t degrees \t\t %.2f 

\t\t degrees', NodeSpacing_min, NodeSpacing_max, NodeSpacing_mean);

fprintf('\n In-plane spacing between \t\t\t Minimum \t\t\t\t\t Maximum \t\t\t\t\t 

Mean');

fprintf('\n satellites \t\t\t\t\t\t %.2f \t\t degrees \t\t %.2f \t\t degrees \t\t 

%.2f \t\t degrees', IPS_min, IPS_max, IPS_mean);

fprintf('\n Phase difference between \t\t\t Minimum \t\t\t\t\t Maximum \t\t\t\t\t 

Mean');

fprintf('\n adjacent planes \t\t\t\t\t %.2f \t\t degrees \t\t %.2f \t\t degrees \t\t 

%.2f \t\t degrees', APS_min, APS_max, APS_mean);

fprintf('\n--------------------------------------------------------------------------

------------------------------------------');

end

return;



A.II.4 Orbital calculation

A. Orbital parameters

The results of orbital parameters of the different orbit types in Table A.II.2 are obtained by applying the formulas in 

Annex II, A.II.2 and computing in MATLAB where its code is given in Annex II, A.II.3.

Orbit types

Elliptical Circular

LEO VLEO

MEO

“Molniya”

MEO

“Tundra”

LEO

Orbital parameters Unit

Earth radius (R

e

) [km] 6378.14 6378.14 6378.14 6378.14 6378.14

Height of apogee (h

a

) [km] 1447.00 370.00 39105.00 46340.00 650.00

Height of perigee (h

p

) [km] 354.00 368.00 1250.00 25231.00 650.00

Inclination (i) [degrees] 71.00 40.02 63.4 63.4 72

R.A.A.N (�) [degrees] 45.00

45.00 45.00 45.00 45.00

Argument of perigee (�)
[degrees] 30.00 30.00 30.00 30.00 0.00

True anomaly (v) [degrees] 15.00 15.00 15.00 15.00 45.00

Semi-major axis (a) [km]
7278.64 6747.14 26555.64 42163.64 7028.14

Eccentricity (e) [unit less]
0.08 0.00015 0.71 0.25 0.00

Orbital period (T) [minutes]
103.00 91.93 717.79 1436.04 97.73

Mean anomaly (M) [degrees]
12.89 15.00 1.78 8.75 45.00

Time rate of change of �

(d)

[degrees/day]
-1.49 7.91 0.00 0.00 -1.85

Time variation of R.A.A.N 

(d)

[degrees/day]
-2.07 -6.27 -0.13 -0.01 -2.19

Sun-synchronous inclination [degrees]
98.93 96.92 None None 97.99

Table A.II.2 : Orbital parameters of different orbits

According to the results of orbital parameters of different orbits in Table A.II.2, we can notice that:

- Height of apogee (h

a

) or Height of perigee (h

p

)  (: increase)  Semi-major axis (a)   Orbital period (T) 

(the bigger size of orbit is, the slower of velocity of satellite, and hence the longer orbital period). Also, the 

bigger size of orbit results in the smaller of time rate of change of � (d) and time variation of R.A.A.N (d).

- [Height of apogee (h

a

) – Height of perigee (h

p

)]  (increasing in orbit size) Eccentricity (e)  (= 0: circular 

orbit, < 1: elliptical orbit, = 1: parabolic orbit, > 1: Hyperbolic orbit)

- If 0° < i < 90°, then d < 0. That is, for prograde orbit, the node line drifts westward. Therefore, since the right 

ascension of the node continuously decreases, this phenomenon is called regression of the nodes. If 90° < i < 

180°, we see that d > 0, the node line advances eastward; it is called retrogression of the nodes (retrograde 

orbit). For polar orbit (i = 90°), the node line is stationary. (See Figure A.II.4)

- If 0° < i < 63.4° or 116.6° < i < 180°, then d > 0, which means the perigee advances in the direction of the 

motion of the satellite. If 63.4° < i < 116.6°, the perigee regresses, the perigee moves in opposite to the 

direction of motion of the satellite. i = 63.4° and i = 116.6° are the critical inclinations at which the apse line 

does not move. (See Figure A.II.4)



Figure A.II.4 : Regression of the node and advance of perigee for nearly circular orbits of altitudes 300 to 1100 km

B. Slant range and free space path loss

This section will study the impact of orbit types (orbit altitude), elevation angles and frequency bands on slant range and 

free space path loss. The slant range depends on the orbit altitude and elevation angle, and the free space path loss 

depends on the slant range and frequency.

As shown in Table A.II.3, Table A.II.4 and Table A.II.5, we can observe that

- If the orbit altitude  (: increase)  the slant range   free space path loss 

- If the elevation angle  (: decrease)  the slant range   free space path loss 

- If the frequency  (: increase)  free space path loss 

Note: Minimum altitude of satellite = Altitude of perigee (h

p

)

Elevation Angle [Degrees] 5

Uplink Downlink

Frequency [MHz] 435.00 145.00

Wavelength [m] 0.69 2.07

Orbit type

Slant 

Range 

[km]

Propagation 

delay 

[sec]

Free Space (FS) path 

losses [dB]

Uplink downlink

Elliptical LEO

Apogee (h

a

): 1447.00 km, Perigee (h

p

): 354.00 km

1668.98 0.005567 149.68 140.14

Elliptical VLEO

Apogee (h

a

): 370.00 km, Perigee (h

p

): 368.00 km

1710.99 0.005707 149.90 140.36

Elliptical MEO “Molniya”

Apogee (h

a

): 39105.00 km, Perigee (h

p

): 1250.00 km

3665.11 0.012225 156.51 146.97

Elliptical MEO “Tundra”

Apogee (h

a

): 46340.00 km, Perigee (h

p

): 25231.00 km

30408.05 0.101428 174.89 165.35

Circular LEO

Apogee (h

a

): 650.00 km, Perigee (h

p

): 650.00 km

2447.95 0.01 153.01 143.47

Table A.II.3 : Slant range and free space path loss for different orbit types (orbit altitude) with elevation angle 5°



Elliptical LEO

Uplink Downlink

Frequency [MHz] 435.00 145.00

Wavelength [m] 0.69 2.07

Elevation Angle [Degrees]

Slant 

Range 

[km]

Propagation 

delay 

[sec]

Free Space (FS) path loss 

[dB]

Uplink downlink

5 1668.98 0.005567 149.68 140.14

10 1314.78 0.004386 147.61 138.07

15 1063.28 0.003547 145.77 136.22

20 884.45 0.002950 144.17 134.62

25 755.11 0.002519 142.79 133.25

Table A.II.4 : Slant range and free space path loss for different elevation angles

Elliptical LEO

Elevation Angle [Degrees] 5

Uplink Downlink

Frequency [MHz] 435.00 145.00

Wavelength [m] 0.69 2.07

Frequency bands

Slant 

Range 

[km]

Propagation 

delay 

[sec]

Free Space (FS) path loss 

[dB]

Uplink downlink

UHF/VHF

Uplink frequency (UHF): 435.00 MHz

Downlink frequency (VHF): 145.00 MHz

1668.98 0.005567 149.68 140.14

Ku

Uplink frequency (UHF): 14000 MHz

Downlink frequency (VHF): 12000 MHz

1668.98

0.005567

179.83 178.50

Ka

Uplink frequency (UHF): 30000 MHz

Downlink frequency (VHF): 20000 MHz

1668.98

0.005567

186.45 182.93

Table A.II.5 : Slant range and free space path loss for different frequency bands



A.II.5 Circular orbit constellations

The circular orbit constellation is used for the whole earth coverage because of their common altitude and inclination 

which provide a constant coverage or fixed satellite footprint size throughout the orbit. Recall that the coverage of 

satellite is greatly dependent on its altitude. There are two basic types of circular orbit constellation which have arisen 

from the street of coverage method: “Walker Star” and “Walker Delta” constellations [3].

The “street of coverage” method, which is shown in the Figure A.II.5, is a method which consists in lining up several 

satellites in an orbital plane to provide a dense set of overlapping coverage circles. One street of coverage will provide 

continuous coverage under the orbit trace, but is insufficient to provide complete Earth coverage. By using multiple 

streets of coverage from several satellites planes, (continuous) whole-Earth coverage can be achieved.

Single street of coverage Multiple streets of coverage

Figure A.II.5 : Street of coverage method

A. Walker Star

- This type of constellation requires that all orbits have a common inclination of 90 degrees or near 90 degrees.

- The “Walker Star” name comes from the fact that, if we draw on a polar map, the orbital planes intersect to 

make a star, as shown in Figure A.II.6. It can also be called as the -constellation (RAAN Spread is 180°, the 

angle that is subtended in the plane of reference by the surface made by joining the evenly-spaced ascending 

nodes of the orbital planes).

- The characteristics of a Walker Star Constellation are shown in Table A.II.6 and Figure A.II.7.

Figure A.II.6 : Walker Star constellation



a. Street width

b. Satellites in adjacent planes moving in the same direction

c. Satellites in adjacent planes moving in the opposite direction

Figure A.II.7 : Characteristics of a Walker Star constellation
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Street of coverage
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β
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S/
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β
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S/
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street

β
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Table A.II.6 : Characteristics of a Walker Star constellation (, S)

B. Walker Delta

- This type of constellation requires that orbital planes is inclined with a constant inclination (generally less than 

90°) and the evenly spacing of the right angles of the ascending nodes 1...p across the full 360° of 

longitude, which means that ascending and descending planes of satellites and their coverage continuously 

overlap, rather than being separated as the ones with the Walker Star constellation.

- The “Walker Delta” name comes from the fact that, if we draw on a polar map, at a minimum of three orbital 

planes, a rounded triangle or Greek delta letter ( is formed around the pole by these planes, as shown in 

Figure A.II.8. It can also be called as the 2-constellation (RAAN Spread is 360°, the angle that is subtended 

in the plane of reference by the surface made by joining the evenly-spaced ascending nodes of the orbital 

planes).

- The characteristics of a Walker Delta constellation are shown in Figure A.II.8 and Table A.II.7.

Figure A.II.8 : Walker Delta constellation

Example: 55°: 25/5/1 constellation shown in Figure A.II.9.

 Inclination angle: i = 55°

 25 satellites in 5 planes (T = 25, P = 5 and F = 1)

 5 satellites per planes (S = T/5 = 5)

 Pattern Unit : PU = 360°/T = 14.4°

 Node spacing [degrees] = PU × S = 14.4 × 5 = 72°

 In-plane spacing between satellites [degrees] = PU × P or = 360°/S = 72°

 Phase difference between adjacent planes [degrees] = PU × F = 14.4°

In Figure A.II.9, satellite 1 is positioned at its ascending node, therefore, the satellite 6 which is the satellite in the next 

most-Easterly plane is located one PU beyond its nodal position.

  : Earth central angle

 S : Number of satellites per plane (evenly spaced)

 

street

: Street width

 

 

 S

street

/cos

cos

cos





 

(as shown in the Figure A.II.7 a)

 Street of coverage 

street

2

 If the satellites in adjacent planes are going in the same direction as shown in Figure A.II.7 b, then the 

perpendicular separation, D_SD, between the orbit planes is:

 

street

SDD _

 If the satellites in adjacent planes are going in the opposite direction as shown in Figure A.II.7 c, then the 

perpendicular separation, D_OD, between the orbit planes is:

street

ODD 2_ 

 The approximate number of planes, P:

P = ceil([(180 - D_OD)/(D_SD)]+1)

 Total number of satellites, TNOS:

TNOS = N×P



Table A.II.7 : Characteristics of a Walker Delta constellation (i: T/P/F)

Figure A.II.9 : Walker Delta constellation, defined by 55°: 25/5/1

Note: When i = 90°, the formula of Node Spacing in the Table A.II.7 is changed to Node spacing [degrees] = 180°/P, 

and the Walker Delta constellation or 2-constellation is become the Walker Star constellation or -constellation.

 Walker Delta constellation is denoted by

i:T/P/F 1)PF(0 

 i : Inclination angle [degrees], i < 90°

 T : Number total of satellites

 P : Number of orbital planes evenly spaced in node

 F : Relative spacing between satellites in adjacent planes or Inter-plane spacing

 S = T/P : Number of satellites per plane (evenly spaced)

 Pattern Unit :

PU [degrees] = 360°/T

 Planes are spaced at intervals of (PU × S) in node

Node spacing [degrees] = PU × S = 360°/P when i < 90°

 Satellites are spaced at intervals of (PU × P) within each plane

In-plane spacing between satellites [degrees] = PU × P = 360°/S

 If a satellite is at its ascending node, the satellite of the next most easterly plane will be (PU × F) past the 

node

Phase difference between adjacent planes [degrees] = PU × F



A.II.6 Space environment

This section will present about the earth’s atmosphere and the space environment effects on satellites.

A. Earth's atmosphere

The Earth's atmosphere ([6], [12]) is divided into 5 regions: troposphere, stratosphere, mesosphere, thermosphere and 

exosphere. The boundaries between these regions are called the tropopause, stratopause, mesopause, and exobase. The 

earth’s atmosphere is illustrated in Table A.II.8 and Figure A.II.11.

Troposhpere Stratosphere Mesosphere Thermosphere Exosphere

Altitude

Between about

0 to 10 km

Between about

10 to 50 km

Between about

50 to 80 km

Between about

80 to 500 km

Between about

> 500 km

Temperature

Decrease with 

altitude

20 to -60 °C

Increase with 

altitude

-60 to -15 °C

Decrease with 

altitude

-15 to -100 °C

Increase with 

altitude

-100 to 2 000 °C

Increase with 

altitude

> 2 000 °C 

Table A.II.8 : Earth’s atmosphere

- Ozone layer (Ozonosphere): is in the stratosphere region which is vitally important to life because it absorbs 

biologically harmful UV radiation from the Sun.

- Ionosphere: This is the region of the atmosphere that contains ions (that form a "plasma"), created by the 

interaction of solar radiation with gas particles. The ionosphere overlaps with the mesosphere and thermosphere, 

going up to an altitude of 550 km.

- Homosphere (or Turbosphere) and Heterosphere: The region below the turbopause (that is, below an altitude of 

about 100 km) is known as the homosphere or turbosphere, where the chemical constituents are well mixed and the 

composition of the atmosphere remains fairly uniform. The region above the turbopause is called the heterosphere, 

where, in the absence of mixing, the chemical composition of the atmosphere varies.

- Van Allen radiation belts: These are regions where charged particles (forming a plasma) from the solar wind are 

trapped by the Earth's magnetic field. Qualitatively, there are two belts: an inner belt, consisting mostly of protons, 

and an outer belt, consisting mostly of electrons. The Van Allen radiation belts are shown in Figure A.II.10.

Van Allen radiation belts Space debris

Figure A.II.10 : Van Allen radiation belts and space debris



Figure A.II.11 : Earth’s atmosphere

B. Space environment effects on satellites

The space environment has significant effects on satellites. The discussion below highlights the principal effects 

experienced by satellites orbiting the Earth.

 Atomic oxygen

The atomic oxygen atoms impact the satellite materials with their high chemical reactivity. To provide corrosion 

protection against atomic oxygen, the satellite faces are covered with a protective layer through the chemical treatment 

process, Alodine.

 Plasma

Particles in plasma around the spacecraft are not neutral, therefore possibly leading to charging of the spacecraft, and 

hence to subsequent electric discharges. This can occur in the proximity of the Van Allen radiation belts.

- Charging from plasma bombardment usually results in a negative charge on the surface of the satellite.

- The photoelectric effect results from solar radiation which liberates electrons on a satellite's surface, resulting in a 

positive charge on the satellite's sunlit side. A satellite will usually have a negative potential on shaded areas (due 

to plasma charging) and a positive potential on sunlit areas (due to the photoelectric effect). If the surface of the 

satellite is conductive, a current will develop to cancel these potentials. For a non-conducting surface, the charge 

separation will be maintained until voltage exceeds the resistive threshold of the material. This leads to a sudden 

electrostatic discharge.

These discharges can cause:

- Hardware damage: structural damage, deterioration of the thermal shielding, blown fuses or exploded transistors, 

capacitors and other electronic components.

- Electrical or electronic problems: false commands, on/off circuit switching, memory changes, degradation of solar 

cell and optical sensors.

Therefore, to prevent these problems, the outer surfaces of the satellite will be electrically connected and will be 

recovered by a conducting layer.



 High energy solar flare effect

The high energy solar flare can cause electronic problems and direct damage to satellite’s hardware. In order to protect 

the satellite from this high energy solar flare effect, we need to harden the sensible parts and carefully select of 

materials.

 Out-gassing

Above 100 miles altitude, there is almost no atmospheric pressure, similar to a complete vacuum. In a vacuum, some 

materials experience out-gassing. Out-gassing is a phenomenon where molecules of material evaporate into space. Out-

gassing can result in changes to the physical properties of a material, affecting their performance (decrease of their 

efficiency). For OUFTI-1, the major contamination problem from out-gassing is the deposit on solar cell surfaces. This 

phenomenon can be minimized by the proper selection of materials.

 Thermal environment

Thermal environment changes depend on solar activity. Typically, the outer surfaces of the CubeSat, e.g. the solar cells, 

may experience temperatures ranging from -30°C to +60°C, whereas the inner parts, e.g. the electronic components, may 

experience temperatures ranging from -10 °C to +40°C. The thermal cycles create structural constraints leading to the 

degradation of the structure. These constraints can be reduced by using materials having the same expansion 

coefficients.

 Space debris

Space debris is defined as any non-operational man-made object of any size in space generated by spacecraft explosions 

and by collisions between satellites. The satellites can be damage due to the collision with the space debris (speed 7-8 

km/s). In order to reduce collision risks between satellite and space debris, the removal of enough large debris objects 

need to be taken place by either return it to Earth, or alter its orbit to burn up sooner than normal. For OUFTI-1, 

shielding, energy absorbing panels and other design considerations can make a satellite more resistant to damage from 

impacts with small space debris.



A.II.7 Characteristic of nanosatellite and ground station studied

Frequency band, altitude of satellite, and elevation angle

Frequency band UHF/VHF Ku Ka

Uplink frequency [MHz] 435 14000 30000

Downlink frequency [MHz] 145 12000 20000

Altitude of satellite [km] At perigee

Elevation angle [°] 5 5 5

Orbit type

Orbit type LEO VLEO MEO “Molniya” MEO “Tundra”

Apogee altitude (ha) [km] 1447.00 370.00 39105.00 46340.00

Perigee altitude (hp) [km] 354.00 368.00 1250.00 25231.00

Antenna type

Frequency band UHF/VHF Ku Ka

Antenna type Monopole Patch Patch

Monopole antenna

Frequency band UHF/VHF

Frequency
[MHz]

12000 14000

Antenna gain [dB] 2.15 2.15

Patch antenna

Frequency band Ku Ka

Frequency
[MHz]

12000 14000 20000 30000

Dielectric constant [Unit less] 2.10 2.10 2.10 2.10

Substrate thickness [m] 0.000642 0.000642 0.0003 0.000642

Antenna gain [dB] 5.59 5.27 6.90 5.27

Protocol, transmitter power, data rate and modulation type

Protocol AX.25 D-STAR Beacon

Transmitter power [W] 0.75 0.75 0.1

Data rate [bps] 20 9600 4800

Modulation type FSK non-coherent FSK non-coherent GMSK

Coding None None None

BER 10

-5

10

-5

10

-5

System required E

b

/N

0

[dB] 13.35 13.35 9.72

Table A.II.9 : Characteristics of the nanosatellite studied

Ground station type and its location

Type Gateway

City Liege

Country Belgium

Latitude [°N] 50.62

Longitude [°E] 5.5667

Altitude at sea level [km] 0.00



Antenna type

Frequency band UHF/VHF Ku Ka

Antenna type Yagi Parabolic Parabolic

Yagi antenna

Frequency band UHF/VHF

Boom Length ():

[m]

1.5

Optimum Elements

7

Antenna gain [dB]

13.35

Parabolic antenna

Frequency band Ku Ka

Frequency [MHz] 12000 14000 20000 30000

Dish diameter [m] 4.5 4.5 4.5 4.5

Dish Aperture efficiency [%] 60.50 60.50 60.50 60.50

Antenna gain [dB] 52.87 54.20 57.30 60.82

Protocol, transmitter power, data rate and modulation type

Protocol AX.25 D-STAR

Transmitter power [W] 20 20

Data rate [bps] 4800 9600

Modulation type FSK non-coherent GMSK

Coding None None

BER 10

-5

10

-5

System require E

b

/N

0

[dB] 13.35 9.72

Table A.II.10 : Characteristics of the ground station studied



Annex III

A.III.1 STK instructions

 Steps to create a scenario:

 {Open STK → Click File menu→ Click New} or Click Create a New Scenario icon → Input 

[Name, Description, Location, Analysis period (start time to stop time), Central Body] → Click OK

 Steps to create a satellite by using the Define Properties:

 {Click Insert menu → Click New} or Click Insert New Object icon → Select Satellite → 

Select Define Properties → Click Insert to bring up the Satellite Properties page

 Go to satellite Basic-orbit page → Input [Propagator (Click → J2Perturbation), Step Size, Coord 

Type (Click → Classical), Coord System (Click → J2000), Apogee Altitude (Click → 

Apogee Altitude), Perigee Altitude (Click → Perigee Altitude), Inclination, Argument of Perigee, 

RAAN (Click → RAAN), True Anomaly (Click → True Anomaly)]

 Go to satellite 2D or 3D Graphics Settings to enhance the clarity, the realism and even the accuracy of 

your 2D and 3D visualizations.

 Go to satellite Constraints Settings to model the performance characteristics and limitations of objects 

in the scenario more accurately.

 Click OK to apply the changes and close

 Select the Satellite in the Object Browser

 Click F2 and rename the facility

Note:

- To find the orbital period for a pass (a pass is a complete orbit of a satellite around the Earth between 

successive node crossings) and eccentricity, Click next to Apogee Altitude to open the drop out 

options list → Select Period (see Figure A.III.1)

- To find the satellite Cartesian position, Click at the Coor Type to open the drop out options list → 

Select Cartesian ( see Figure A.III.1)

 Steps to create a facility by using the City Database:

 {Click Insert menu → Click New} or Click Insert New Object ( ) icon → Select Facility → 

Select Select from City Database → Click Insert to bring up the City Database window

 Input [City name (Toulouse or Liege)] → Click Search → Select the right city from the search results 

list → Click Insert and Close

 Right-click on Facility in the Object Browser → Properties → Go to 2D or 3D Graphics Settings to 

enhance the clarity, the realism and even the accuracy of your 2D and 3D visualizations

 Click OK to apply the changes and close

 Select the Facility in the Object Browser

 Click F2 and rename the facility

 Steps to get Classical Orbit Elements report:

{Right-click Satellite in the Object Browser→ Select Report & Graph Manager} or {Click Report 

& Graph Manager icon → Choose Satellite in object type → Select the Satellite which you want to get report}  

→ Go to Styles → Select Show Reports and Unselect Show Graphs → Go to Installed Styles → Select 

Classical Orbit Elements → Go to Generate As → Select Report/Graph → Click Generate

 Steps to get Access report:

 {Right-click Satellite in the Object Browser → Select Access} or {Click on Access icon} 

→ Choose the right Satellite of your simulation in the Access for → Go to Associated Object → Select 

Facility (ex. Liege or Toulouse) → Go to Report → Click Access



Figure A.III.1: How to find orbital period and Cartesian position in STK

 Steps to get AER report of facility:

 {Right-click Facility (e. Liege or Toulouse) in the Object Browser → Select Access} or {Click 

on Access icon} → Choose the right Facility of your simulation in the Access for → Go to 

Associated Object → Select Satellite → Go to Report → Click AER

 Steps to add a minimum elevation angle constraint on facility:

 Right-click Facility (e. Liege or Toulouse) in the Object Browser → Select Properties → Go to 

Constraints-Basic page → Go to Elevation Angle → Select Min → Input the constraint value → Click 

OK to apply and close

 Steps to get create a satellite constellation in STK:

 Create facilities (ground stations) and nanosatellite which is described in IV.2.2 A.

 Right-click Satellite in the Object Browser → Go to Satellite → Select Walker → Input [Type: 

Delta, Number of Planes, Number of Sats per Plane, Inter-Plane Spacing which is the relative spacing 

between satellites in adjacent planes F equal to 1 for all constellations in this thesis, RAAN Spread

which is equal to 180° for Walker Star constellation (usually for polar or near polar orbit, inclination of 

90° or near 90 °) and which is 360° for Walker Delta constellation (for orbit with an inclination 

generally less than 90°), Select Color by Plane, Select Create unique names for sub-objects, Select 

Create Constellation to have STK automatically create a Constellation object that includes all of the 



satellites in the Walker constellation. Enter the constellation's name in the text box] → Click Create 

Walker and Close

To address area coverage capabilities, the Coverage module of STK provides two STK object classes: Coverage 

Definition ( ) and Figure of Merit ( ). Coverage Definition objects allow to define and maintain an area of 

coverage, to define the STK objects providing coverage for the area (such as satellites, aircraft and sensors), to 

define the time period of interest, and to calculate accesses to the region. The Figure of Merit objects attaching to 

a Coverage Definition object provide the means for evaluating the quality of coverage provided by the assigned 

objects (or assets).

 Steps to define the Coverage Region and Assign Assets

 Double-click the icon in the Object Catalog to add a Coverage Definition object to the scenario

 Open the Basic - Grid page from the Coverage Definition properties, and set the following options:

 Grid Area of Interest Type: Global

 Point Granularity: Lat/Lon

 Point Granularity Value: 6.0 deg

 Open the Assets page. Select the Satellite Constellation, click Assign, make sure that Status is set 

to Active, and click Apply

 Open the 2D Graphics-Attributes page, and set the following options as shown in Figure A.III.2

Figure A.III.2: 2D Graphics-Attributes page of Coverage Definition

 Click OK, and then select the Coverage Definition in the Object Browser, select Compute 

Accesses from the Coverage Definition Tools menu.

 Steps to assess the Quality of Coverage with a Figure of Merit

 Select the Coverage Definition in the Object Browser, and double-click the icon in the Object 

Catalog to add a Figure of Merit

 Open the Definition page of the Figure of Merit. Choose Simple Coverage for the Type

 Open the 2D Graphics-Attributes page for the Figure of Merit, and set the following options as shown 

in Figure A.III.3

 Click OK, and animate the scenario

Figure A.III.3: 2D Graphics - Attributes page of Figure of Merit



 Steps to get Global Coverage report:

 {Right-click Coverage Definition in the Object Browser→ Select Report & Graph Manager} 

or {Click Report & Graph Manager icon → Choose Coverage Definition in the Object Type → 

Select the CoverageDefinition} → Go to Styles → Select Show Reports and Unselect 

Show Graphs → Go to Installed Styles → Select Global Coverage → Go to Generate As → Select

Report/Graph → Click Generate

 Steps to create a Chain and get a Complete Chain Access report:

 Set up your scenario with at least three different assets. These can be satellites, ground vehicles, 

facilities, targets, or aircraft. 

 Insert a Chain object and open up its properties browser. 

 On the Basic Definition page for the Chain, highlight the object that starts the communications link 

and click to move it from Available Objects to Assigned Objects. 

 Next, select the object that will relay your communications and click .

 Finally, select and assign the object that will receive communications. 

 Once finished, click OK to close the Chain property browser. 

 Right-click the Chain object, select Chain Tools → Report, and create the Complete Chain Access 

report. This gives the times and durations that the complete chain has access. 

 Click to reset the animation and then click to animate the scenario. A yellow line will connect 

the objects in the Chain during periods of access in the 3D Graphics window.

 Steps to add an Sensor:

 Attach a Sensor ( ) to the satellite

 Rename the Sensor by press F2 after selecting it

 Open Sensor’s ( ) Properties

 Select the Basic – Pointing page

 Set the Pointing Type to Targeted, set the Track Mode to Transpond, and set the About Boresight to 

Rotate

 Select ( ) Station in the Available Targets section

 Move ( ) Station to the Assigned Targets section

 Click OK

Note: Transpond tracking mode means that the antenna points to the true location of the target object. This mode 

is the most appropriate for 2-way communications and is typically sufficient for all non-laser communications. 

Access computations including the computation of targeting times are performed based on the sensor being the 

transmitter of the signal.

 Steps to add an Antenna:

 Select whether satellite’s sensor or facility in the Object Browser that you want to attach the antenna to 

→ Double-click the antenna icon in the Object Catalog to add an antenna

 Rename the antenna’s name in the Object Browser to a proper name by press F2 after selecting it

 Open Antenna’s Properties Browser ( )

 Select Basic – Definition page

 Set the Type to Isotropic, and set the design frequency according to your system

 Leave all other defaults

 Click OK

Note: In fact, the type of our system antennas is whether Monopole (for satellite) or Yagi (for ground station). 

But, there has no such model/type of antenna in STK. To set such model/type of antenna in STK, we have to set 

the Type to Antenna Script and add a whether MATLAB or Visual Basic script file of such type of antenna. 

Also, STK must have a license to integrate with MATLAB or Visual Basic, for example the STK/MATLAB 

license. So, to simplifier the problem and as we don’t have a STK/MATLAB license for our educational used 

only version of STK, we will set the Type to Isotropic with the antenna gain equal to zero dB, and we will set the 



antenna gain of Monopole or Yagi in the Additional Transmitter Gains/Losses tab of Transmitter or Receiver 

instead.

 Steps to add a transmitter (Figure A.III.4):

 Select whether satellite or facility in the Object Browser that you want to add a transmitter → Double-

click a transmitter icon in the Object Catalog to add a transmitter

 Rename the transmitter’s name to a proper name by press F2 after selecting it

 Open the transmitter ( ) Properties Browser ( )

 Select the Basic – Definition page

 Set the Type to Complex TransmitterModel

 Select Model Specs tab and set the value of frequency and power

 Click on the Antenna Tab and set the Reference Type to Link. Note that Sensor/ “Sensor’s 

name”/Antenna/ “Antenna’s name” is the Antenna Name

 Select Modulator tab, enter the value at Data Rate and choose the NFSK (for AX.25 and Beacon 

protocol) or BPSK (for D-STAR protocol) for Modulation Type, and make sure the Auto Scale is 

selected for Signal Bandwidth

 Select Filter tab, and make sure the Use is unselected

 Select the Additional Gains and Losses tab, add Antenna gain and Total transmission line losses into

the Pre-Receive Gains/Losses, and set their value

 Click OK

Note: As in STK, it doesn’t have a GMSK modulation type and also as we don’t have a STK/MATLAB license 

in our STK of educational used only version to integrate the MATLAB script file with STK, in order to facility 

the simulation we will therefore choose the BPSK instead of GMSK for communication in D-STAR protocol.

 Steps to add a receiver (Figure A.III.5):

 Select whether satellite or facility in the Object Browser that you want to add a receiver → Double-

click a receiver icon in the Object Catalog to add a receiver.

 Rename the receiver’s name to a proper name by press F2 after selecting it

 Open the receiver’s Properties Browser ( )

 Select the Basic – Definition page

 Set the Type to Complex Receiver Model

 Select Model Specs tab and set all parameters in this tab. For example, set frequency to 145 MHz for 

downlink and make sure the Auto Track is selected, Eb/N

0

threshold to 14.35 dB for modulation NFSK 

as shown in Figure A.III.5

 Click the Antenna tab and set the Reference Type to Link. Note that Antenna/ “Antenna’s name” is 

the Antenna Name

Note: Set the Reference Type to Link is to create the linked antenna which is independent of any receiver or 

transmitter and thus facilitate the sharing of the antenna by several transmitters and receivers.

 Select the System Noise Temperature tab, select Constant and set the value

 Select the Filter tab and make sure the Auto Scale is selected

 Select the Additional Gains and Losses tab, add Antenna pointing loss at TX, Antenna polarization loss 

at TX, Antenna pointing loss at RX, Antenna gain, Atmosphere losses, Ionosphere losses, Rain losses, 

Total transmission line losses at RX into the Pre-Receive Gains/Losses, and set their value.

Note: As in STK, it doesn’t have the model of our antenna type (so as the antenna pointing loss, the antenna 

polarization loss), atmosphere losses, ionosphere losses, rain losses, and also as we don’t have a STK/MATLAB 

license in our STK of educational used only version to integrate the MATLAB script file with STK, we’ll add all 

these parameters as a constant value in the Additional Gains and Losses tab of the Receiver in order to simplifier 

the problems.

 Click OK.



Figure A.III.4: Adding a Transmitter in STK

 Steps to generating a Link Budget Report

We will concentrate on an examination of the E

b

/N

0

and the Bit Error Rate (BER). To check these values, you 

will create a Link Budget Report.

 Select Receiver ( ) in the Object Browser

 Click Access Tool ( )

 Select the Transmitter of your simulation in the Associated Objects panel

 Click the Report & GraphManager…button

 Turn off the Show Graphs option

 If the Installed Styles folder not already expanded, expand it

 Select the Link Budget – Detailed report

 Click Generate…



Note: The link budget detailed report shows several more communication parameters than just the simple link 

budget report. But, in our case, the gain antenna, the atmosphere losses, the ionosphere losses, and etc, their 

value is not equal to zero dB. Hence, to generate the report for our simulation and to avoid the confusion, we will 

create our report style that will hide the column of gain antenna, atmosphere looses, ionosphere losses, and etc.

 After finishing consulting this report, close the Link Budget report window, close the Report & 

GraphManager window, close the Access Panel

Figure A.III.5: Adding a Receiver in STK

 Steps to create a new Report Style of Link Budget (Figure A.III.6):

 Select Receiver ( ) in the Object Browser

 Click Access Tool ( )

 Select the selected Transmitter of your simulation in the Associated Objects panel

 Click the Report & GraphManager…button

 Turn off the Show Graphs option



 Select My Styles folder, click on icon to create a new report style and enter the name of the new 

report style for example KKBER

 Select Content page, type “Link information” below the Data Providers and click Filter button

 Select the “Time”, “Xmtr Power”, etc of the Link information data and click to the lists below the 

Report Contents as shown in Figure A.III.6

 Click on Units… button to set the unit of the parameter

 Click OK to apply and close

 Select the KKBER report

 Click Generate…

 After finishing consulting this report, close the Link Budget report window, close the Report & 

GraphManager window, close the Access Panel

Figure A.III.6: Creating a new Report Style of Link Budget in STK

 Steps to add a minimum Link Budget constraint on the receiver:

 {Right-click Receiver in the Object Browser → Select Properties → Go to Constraints-Basic

page → Go to Link Budget → Select Min → Input the constraint value → Click OK to apply and close.



A.III.2 3D and 2D graphics of the simulation scenarios

3D graphic

2D graphic

Figure A.III.7: Simulation scenario for elliptical VLEO orbit



3D graphic

2D graphic

Figure A.III.8: Simulation scenario for elliptical MEO “Molniya” orbit



3D graphic

2D graphic

Figure A.III.9: Simulation scenario for elliptical MEO “Tundra” orbit



3D graphic

2D graphic

Figure A.III.10: Simulation scenario for circular LEO “inclined” orbit



3D graphic

2D graphic

Figure A.III.11: Simulation scenario for circular LEO “polar” orbit



A.III.3 Access and AER results

A. Elliptical LEO orbit

a. Access and AER for Satellite-Liege link

b. Access and AER for Satellite-Toulouse link

OUFTI1-To-Toulouse

------------------

Access       Start Time (UTCG)           Stop Time (UTCG)       Duration (min)

------ ----------------------- ----------------------- --------------

1    7 Jul 2011 10:00:00.000    7 Jul 2011 10:06:47.835             6.797

2    7 Jul 2011 11:48:19.414    7 Jul 2011 11:49:26.725             1.122

3    7 Jul 2011 15:23:02.393    7 Jul 2011 15:31:04.750             8.039

4    7 Jul 2011 17:06:47.185    7 Jul 2011 17:23:03.097            16.265

5    7 Jul 2011 18:51:36.327    7 Jul 2011 19:09:53.418            18.285

6    7 Jul 2011 20:38:13.612    7 Jul 2011 20:51:15.410            13.030

7    8 Jul 2011 08:15:16.542    8 Jul 2011 08:24:45.595             9.484

Global Statistics

-----------------

Min Duration           2    7 Jul 2011 11:48:19.414    7 Jul 2011 11:49:26.725          1.122

Max Duration           5    7 Jul 2011 18:51:36.327    7 Jul 2011 19:09:53.418            18.285

Mean Duration                                                                             10.432

Total Duration                                       73.022

Liege-To-OUFTI1

---------------

Global Statistics

-----------------

Min Elevation     8 Jul 2011 08:27:05.187           37.135              0.000    2608.550744

Max Elevation     7 Jul 2011 17:12:23.133           55.572             50.874    1108.195698

Mean Elevation                                                         11.014               

Min Range         7 Jul 2011 10:03:23.909          306.739             29.162     800.860447

Max Range         7 Jul 2011 19:07:24.975          179.489              0.000    4169.070940

Mean Range                                        2374.614227

OUFTI1-To-Liege

---------------

Access       Start Time (UTCG)           Stop Time (UTCG)       Duration (min)

------ ----------------------- ----------------------- --------------

1    7 Jul 2011 10:00:00.000    7 Jul 2011 10:09:18.569             9.309

2    7 Jul 2011 11:46:37.473    7 Jul 2011 11:54:53.176             8.262

3    7 Jul 2011 13:34:41.441    7 Jul 2011 13:42:46.838             8.090

4   7 Jul 2011 15:20:22.873    7 Jul 2011 15:33:18.326            12.924

5    7 Jul 2011 17:05:17.944    7 Jul 2011 17:22:09.481            16.859

6    7 Jul 2011 18:50:28.353    7 Jul 2011 19:07:24.975           16.944

7    7 Jul 2011 20:37:28.949    7 Jul 2011 20:47:21.865             9.882

8    8 Jul 2011 08:17:08.892    8 Jul 2011 08:27:05.187             9.938

Global Statistics

-----------------

Min Duration      3    7 Jul 2011 13:34:41.441    7 Jul 2011 13:42:46.838             8.090

Max Duration           6    7 Jul 2011 18:50:28.353    7 Jul 2011 19:07:24.975            16.944

Mean Duration                                                                   11.526

Total Duration                                                                            92.208



From the chapter IV in section IV.2.3, the orbit period of elliptical LEO orbit is about 103 minutes for a pass. As 

a result, the satellite orbits the earth about 14 (24×60/103) passes per day. For these 14 passes per day, however, 

the satellite can access

- Liege facility 8 accesses per day with the minimum access duration 8.090 minutes, maximum access 

duration 16.944 minutes and total access duration 92.208 minutes per day.

- and Toulouse facility 7 accesses per day with the minimum access duration 1.122 minutes, maximum 

access duration 18.285 minutes and total access duration 73.022 minutes per day as shown in the text 

box above.

Hence, the total duration of access from OUFTI-1 satellite to Liege facility is about 19.18 minutes bigger/better 

than the one from OUFTI-1 satellite to Toulouse facility.

The mean range between Liege facility and OUFTI-1 satellite is about 2374.61 km, while the one between 

Toulouse facility and OUFTI-1 satellite is about 2531.46 km. Hence, the free space path losses between OUFTI-

1 satellite and Liege facility is smaller than the one between OUFTI-1 and Toulouse facility, so that the 

communication between OUFTI-1 and Toulouse facility will averagely worst than the one between OUFTI-1 

and Liege facility.

B. Elliptical VLEO orbit

a. Access and AER for Satellite-Liege link

Liege-To-OUFTI1

---------------

Global Statistics

-----------------

Min Elevation     7 Jul 2011 14:53:51.052          141.398              0.000    2220.988494

Max Elevation     7 Jul 2011 13:14:07.783          176.552             11.637    1284.078572

Mean Elevation                                                          3.891               

Min Range         7 Jul 2011 13:14:07.630          176.603             11.637    1284.078111

Max Range         7 Jul 2011 14:45:47.757          245.035              0.000    2226.929480

Mean Range                                                                       1865.168284

OUFTI1-To-Liege

---------------

Access       Start Time (UTCG)           Stop Time (UTCG)       Duration (min)

------ ----------------------- ----------------------- --------------

1    7 Jul 2011 11:34:53.508    7 Jul 2011 11:42:06.455             7.216

2    7 Jul 2011 13:09:51.496    7 Jul 2011 13:18:24.367             8.548

3    7 Jul 2011 14:45:47.757    7 Jul 2011 14:53:51.052             8.055

4    7 Jul 2011 16:23:04.186    7 Jul 2011 16:27:31.491             4.455

Global Statistics

-----------------

Min Duration           4    7 Jul 2011 16:23:04.186    7 Jul 2011 16:27:31.491             4.455

Max Duration           2    7 Jul 2011 13:09:51.496    7 Jul 2011 13:18:24.367             8.548

Mean Duration                                        7.068

Total Duration                                                                            28.274

Toulouse-To-OUFTI1

------------------

Global Statistics

-----------------

Min Elevation     7 Jul 2011 20:51:15.398          218.720          0.000    4204.463949

Max Elevation     7 Jul 2011 18:59:22.616          248.686             61.429    1137.549575

Mean Elevation                                                         11.528               

Min Range         8 Jul 2011 08:19:38.647    108.201             23.135     851.403463

Max Range         7 Jul 2011 19:09:53.403          168.426              0.000    4268.751618

Mean Range                                                                       2531.463343



b. Access and AER for Satellite-Toulouse link

From the chapter IV in section IV.2.3, the orbit period of elliptical VLEO orbit is about 91.93 minutes for a pass. 

As a result, the satellite orbits the earth about 16 (24×60/91.93) passes per day. For these 16 passes per day, 

however, the satellite can access

- Liege facility 4 accesses per day with the minimum access duration 4.455 minutes, maximum access 

duration 8.548 minutes and total access duration 28.274 minutes per day.

- and Toulouse facility 6 accesses per day with the minimum access duration 1.907 minutes, maximum 

access duration 10.097 minutes and total access duration 44.331 minutes per day as shown in the text 

box above.

Hence, the total duration of access from OUFTI-1 satellite to Liege facility is about 16.06 minutes smaller/worst 

than the one from OUFTI-1 satellite to Toulouse facility.

The mean range between Liege facility and OUFTI-1 satellite is about 1865.17 km, while the one between 

Toulouse facility and OUFTI-1 satellite is about 1614.83 km. Hence, the free space path losses between OUFTI-

1 satellite and Liege facility is bigger than the one between OUFTI-1 and Toulouse facility, so that the 

communication between OUFTI-1 and Toulouse facility will averagely better than the one between OUFTI-1 

and Liege facility.

Toulouse-To-OUFTI1

------------------

Global Statistics

-----------------

Min Elevation     7 Jul 2011 13:18:16.204           95.473              0.000    2226.885293

Max Elevation     7 Jul 2011 13:13:12.886        173.664             39.008     575.540323

Mean Elevation                                                          8.824               

Min Range         7 Jul 2011 13:13:12.828          173.718             39.008     575.540178

Max Range         7 Jul 2011 11:41:46.274           92.217              0.000    2227.246824

Mean Range                                                                       1614.831731

OUFTI1-To-Toulouse

------------------

Access       Start Time (UTCG)           Stop Time (UTCG)       Duration (min)

------ ----------------------- ----------------------- --------------

1    7 Jul 2011 10:00:00.000    7 Jul 2011 10:04:03.912             4.065

2    7 Jul 2011 11:32:25.878    7 Jul 2011 11:41:46.274             9.340

3    7 Jul 2011 13:08:10.381    7 Jul 2011 13:18:16.204            10.097

4    7 Jul 2011 14:44:27.783    7 Jul 2011 14:54:29.521            10.029

5    7 Jul 2011 16:21:04.371    7 Jul 2011 16:29:57.959             8.893

6    7 Jul 2011 18:00:10.337    7 Jul 2011 18:02:04.738             1.907

Global Statistics

-----------------

Min Duration           6    7 Jul 2011 18:00:10.337    7 Jul 2011 18:02:04.738          1.907

Max Duration           3    7 Jul 2011 13:08:10.381    7 Jul 2011 13:18:16.204            10.097

Mean Duration                                                                              7.388

Total Duration                                       44.331



C. Elliptical MEO “Molniya” orbit

a. Access and AER for Satellite-Liege link

b. Access and AER for Satellite-Toulouse

From the chapter IV in section IV.2.3, the orbit period of elliptical MEO “Molniya” orbit is about 717.79 

minutes for a pass. As a result, the satellite orbits the earth about 2 (24×60/717.79) passes per day. For these 2 

passes per day, however, the satellite can access

Toulouse-To-OUFTI1

------------------

Global Statistics

-----------------

Time (UTCG)          Azimuth (deg)    Elevation (deg)     Range (km)

----------------------- ------------- --------------- -----------

Min Elevation     7 Jul 2011 10:23:10.605           41.319              0.000    10063.034449

Max Elevation     7 Jul 2011 10:01:39.598          309.821             80.097     1512.258637

Mean Elevation                                                         15.903                

Min Range         7 Jul 2011 10:01:08.688          262.202             75.480     1488.999031

Max Range         8 Jul 2011 00:48:20.986          254.630 0.000    36008.063340

Mean Range                                                                       19709.426453

OUFTI1-To-Toulouse

------------------

Access       Start Time (UTCG)           Stop Time (UTCG)       Duration (min)

------ ----------------------- ----------------------- --------------

1    7 Jul 2011 10:00:00.000    7 Jul 2011 10:23:10.605            23.177

2    7 Jul 2011 22:17:52.152    8 Jul 2011 00:48:20.986           150.481

3    8 Jul 2011 09:48:55.438    8 Jul 2011 10:00:00.000            11.076

Global Statistics

-----------------

Min Duration           3    8 Jul 2011 09:48:55.438    8 Jul 2011 10:00:00.000            11.076

Max Duration           2    7 Jul 2011 22:17:52.152    8 Jul 2011 00:48:20.986           150.481

Mean Duration                                                                             61.578

Total Duration                                                                           184.733

Liege-To-OUFTI1

---------------

Global Statistics

-----------------

Time (UTCG)          Azimuth (deg)    Elevation (deg)     Range (km)

----------------------- ------------- --------------- -----------

Min Elevation     8 Jul 2011 00:26:31.991          256.404              0.000    33573.391555

Max Elevation     8 Jul 2011 09:59:13.424          131.716             87.063     1692.845094

Mean Elevation                                                         15.613                

Min Range         7 Jul 2011 10:02:47.804          209.942             75.461     1646.655623

Max Range         8 Jul 2011 00:26:31.991          256.404              0.000    33573.391555

Mean Range                                                                       17604.454150

OUFTI1-To-Liege

---------------

Access       Start Time (UTCG)           Stop Time (UTCG)       Duration (min)

------ ----------------------- ----------------------- --------------

1    7 Jul 2011 10:00:00.000    7 Jul 2011 10:32:25.550            32.426

2    7 Jul 2011 22:15:36.168    8 Jul 2011 00:26:31.991           130.930

3    8 Jul 2011 09:50:54.212    8 Jul 2011 10:00:00.000             9.096

Global Statistics

-----------------

Min Duration           3 8 Jul 2011 09:50:54.212    8 Jul 2011 10:00:00.000             9.096

Max Duration           2    7 Jul 2011 22:15:36.168    8 Jul 2011 00:26:31.991           130.930

Mean Duration                                                                          57.484

Total Duration                                                                           172.453



- Liege facility 3 accesses per day with the minimum access duration 9.096 minutes, maximum access 

duration 130.930 minutes and total access duration 172.453 minutes per day.

- and Toulouse facility 3 accesses per day with the minimum access duration 11.076 minutes, maximum 

access duration 150.481 minutes and total access duration 184.733 minutes per day as shown in the text 

box above.

Hence, the total duration of access from OUFTI-1 satellite to Liege facility is about 12.28 minutes smaller/worst 

than the one from OUFTI-1 satellite to Toulouse facility.

The mean range between Liege facility and OUFTI-1 satellite is about 17604.45 km, while the one between 

Toulouse facility and OUFTI-1 satellite is about 19709.43 km. Hence, the free space path losses between 

OUFTI-1 satellite and Liege facility is smaller than the one between OUFTI-1 and Toulouse facility, so that the 

communication between OUFTI-1 and Toulouse facility will averagely worst than the one between OUFTI-1 

and Liege facility.

D. Elliptical MEO “Tundra” orbit

a. Access and AER for Satellite-Liege link

b. Access and AER for Satellite-Toulouse link 

OUFTI1-To-Toulouse

------------------

Access       Start Time (UTCG)           Stop Time (UTCG)       Duration (min)

------ ----------------------- ----------------------- --------------

1    7 Jul 2011 12:00:00.000    8 Jul 2011 00:44:10.145           764.169

2    8 Jul 2011 08:17:00.162    8 Jul 2011 12:00:00.000           222.997

Global Statistics

-----------------

Min Duration           2    8 Jul 2011 08:17:00.162    8 Jul 2011 12:00:00.000           222.997

Max Duration           1    7 Jul 2011 12:00:00.000    8 Jul 2011 00:44:10.145         764.169

Mean Duration                                                                            493.583

Total Duration                                                                           987.166

Liege-To-OUFTI1

---------------

Global Statistics

-----------------

Time (UTCG)          Azimuth (deg)    Elevation (deg)     Range (km)

----------------------- ------------- --------------- -----------

Min Elevation     7 Jul 2011 23:54:55.832          194.881            0.000    52246.386292

Max Elevation     7 Jul 2011 12:42:29.696          302.408             85.475    26296.370590

Mean Elevation                                                         39.970                

Min Range         8 Jul 2011 11:53:28.475   217.449             71.536    25689.673303

Max Range         7 Jul 2011 23:54:55.832          194.881              0.000    52246.386292

Mean Range                                                                       37868.385299

OUFTI1-To-Liege

---------------

Access       Start Time (UTCG)           Stop Time (UTCG)       Duration (min)

------ ----------------------- ----------------------- --------------

1    7 Jul 2011 12:00:00.000    7 Jul 2011 23:54:55.832           714.931

2    8 Jul 2011 08:43:56.990    8 Jul 2011 12:00:00.000           196.050

Global Statistics

-----------------

Min Duration           2 8 Jul 2011 08:43:56.990    8 Jul 2011 12:00:00.000           196.050

Max Duration           1    7 Jul 2011 12:00:00.000    7 Jul 2011 23:54:55.832           714.931

Mean Duration                                                                          455.490

Total Duration                                                                           910.981



From the chapter IV in section IV.2.3, the orbit period of elliptical MEO “Tundra” orbit is about 1436.04 

minutes for a pass. As a result, the satellite orbits the earth about 1 (24×60/1436.04) pass per day. For these 1 

pass per day, however, the satellite can access 

- Liege facility 2 accesses per day with the minimum access duration 196.050 minutes, maximum access 

duration 714.931 minutes and total access duration 910.981 minutes per day.

- and Toulouse facility 2 accesses per day with the minimum access duration 222.997 minutes, maximum 

access duration 764.169 minutes and total access duration 987.166 minutes per day as shown in the text 

box above.

Hence, the total duration of access from OUFTI-1 satellite to Liege facility is about 76.18 minutes smaller/worst 

than the one from OUFTI-1 satellite to Toulouse facility.

The mean range between Liege facility and OUFTI-1 satellite is about 37868.39 km, while the one between 

Toulouse facility and OUFTI-1 satellite is about 38291.90 km. Hence, the free space path losses between 

OUFTI-1 satellite and Liege facility is smaller than the one between OUFTI-1 and Toulouse facility, so that the 

communication between OUFTI-1 and Toulouse facility will averagely worst than the one between OUFTI-1 

and Liege facility.

E. Circular LEO “inclined” orbit

a. Access and AER for Satellite-Liege link

OUFTI1-To-Liege

---------------

Access       Start Time (UTCG)           Stop Time (UTCG)       Duration (min)

------ ----------------------- ----------------------- --------------

1    7 Jul 2011 10:00:00.000    7 Jul 2011 10:10:33.440            10.557

2    7 Jul 2011 11:39:40.713    7 Jul 2011 11:50:20.712            10.667

3    7 Jul 2011 13:23:27.535    7 Jul 2011 13:31:21.675             7.902

4    7 Jul 2011 15:04:54.648    7 Jul 2011 15:14:56.410            10.029

5   7 Jul 2011 16:44:46.810    7 Jul 2011 16:57:59.556            13.212

6    7 Jul 2011 18:24:36.779    7 Jul 2011 18:38:15.344            13.643

7    7 Jul 2011 20:05:47.985    7 Jul 2011 20:14:24.149           8.603

8    8 Jul 2011 07:07:26.620    8 Jul 2011 07:18:05.934            10.655

9    8 Jul 2011 08:44:49.165    8 Jul 2011 08:58:42.307            13.886

Global Statistics

-----------------

Min Duration     3    7 Jul 2011 13:23:27.535    7 Jul 2011 13:31:21.675             7.902

Max Duration           9    8 Jul 2011 08:44:49.165    8 Jul 2011 08:58:42.307            13.886

Mean Duration                                                                  11.017

Total Duration                                                                            99.155

Liege-To-OUFTI1

---------------

Global Statistics

-----------------

Time (UTCG)          Azimuth (deg)    Elevation (deg)     Range (km)

----------------------- ------------- --------------- -----------

Min Elevation     7 Jul 2011 10:10:33.440           24.481             -0.000    2998.598077

Max Elevation     8 Jul 2011 08:51:43.036          115.441             78.393     675.124510

Mean Elevation                                  11.395               

Min Range         8 Jul 2011 08:51:42.764          116.287             78.392     675.121807

Max Range         7 Jul 2011 11:50:20.712           21.699              0.000    2998.981415

Mean Range               2206.952610

Toulouse-To-OUFTI1

------------------

Global Statistics

-----------------

Time (UTCG)          Azimuth (deg)    Elevation (deg)     Range (km)

----------------------- ------------- --------------- -----------

Min Elevation     8 Jul 2011 00:44:10.145          196.243              0.000    51884.670582

Max Elevation     7 Jul 2011 12:16:29.325          289.010           84.771    25729.364885

Mean Elevation                                                         38.899                

Min Range         8 Jul 2011 11:43:35.430          217.160             76.766    25463.743009

Max Range         8 Jul 2011 00:44:10.145  196.243              0.000    51884.670582

Mean Range                                                                       38291.898706



b. Access and AER for Satellite-Toulouse link

From the chapter IV in section IV.2.3, the orbit period of circular LEO “Inclined” orbit is about 97.73 minutes 

for a pass. As a result, the satellite orbits the earth about 15 (24×60/97.73) passes per day. For these 15 passes 

per day, however, the satellite can access

- Liege facility 9 accesses per day with the minimum access duration 7.902 minutes, maximum access 

duration 13.886 minutes and total access duration 99.155 minutes per day.

- and Toulouse facility 7 accesses per day with the minimum access duration 7.493 minutes, maximum 

access duration 13.887 minutes and total access duration 74.701 minutes per day as shown in the text 

box above.

Hence, the total duration of access from OUFTI-1 satellite to Liege facility is about 24.45 minutes bigger/better 

than the one from OUFTI-1 satellite to Toulouse facility.

The mean range between Liege facility and OUFTI-1 satellite is about 2206.95 km, while the one between 

Toulouse facility and OUFTI-1 satellite is about 2185.87 km. Hence, the free space path losses between OUFTI-

1 satellite and Liege facility is bigger than the one between OUFTI-1 and Toulouse facility, so that the 

communication between OUFTI-1 and Toulouse facility will averagely better than the one between OUFTI-1 

and Liege facility.

F. Circular LEO “polar” orbit

a. Access and AER for Satellite-Liege link

Toulouse-To-OUFTI1

------------------

Global Statistics

-----------------

Time (UTCG)          Azimuth (deg)    Elevation (deg)     Range (km)

----------------------- ------------- --------------- -----------

Min Elevation     7 Jul 2011 20:06:49.534          313.636              0.000    2988.515831

Max Elevation     8 Jul 2011 08:49:34.554          111.739            81.494     666.658184

Mean Elevation                                                         12.613               

Min Range         8 Jul 2011 08:49:34.270          112.955             81.493     666.655203

Max Range         7 Jul 2011 11:46:50.959      358.303              0.000    2995.151081

Mean Range                                                                       2185.873205

OUFTI1-To-Toulouse

------------------

Access       Start Time (UTCG)           Stop Time (UTCG)       Duration (min)

------ ----------------------- ----------------------- --------------

1    7 Jul 2011 10:00:00.000    7 Jul 2011 10:08:15.658             8.261

2    7 Jul 2011 11:39:21.350    7 Jul 2011 11:46:50.959             7.493

3    7 Jul 2011 16:46:49.035    7 Jul 2011 16:57:57.196            11.136

4    7 Jul 2011 18:26:02.191    7 Jul 2011 18:39:55.383            13.887

5   7 Jul 2011 20:06:49.534    7 Jul 2011 20:17:19.428            10.498

6    8 Jul 2011 07:05:53.480    8 Jul 2011 07:15:27.138             9.561

7    8 Jul 2011 08:42:41.437    8 Jul 2011 08:56:33.354           13.865

Global Statistics

-----------------

Min Duration           2    7 Jul 2011 11:39:21.350    7 Jul 2011 11:46:50.959             7.493

Max Duration           4    7 Jul 2011 18:26:02.191    7 Jul 2011 18:39:55.383            13.887

Mean Duration    10.672

Total Duration                                                                            74.701



b. Access and AER for Satellite-Toulouse link

OUFTI1-To-Toulouse

------------------

Access       Start Time (UTCG)           Stop Time (UTCG)       Duration (min)

------ ----------------------- ----------------------- --------------

1    7 Jul 2011 10:00:00.000    7 Jul 2011 10:03:51.197             3.853

2    7 Jul 2011 18:28:06.465    7 Jul 2011 18:39:32.846            11.440

3    7 Jul 2011 20:05:11.836    7 Jul 2011 20:18:37.952            13.435

4    7 Jul 2011 21:44:39.765    7 Jul 2011 21:52:26.497             7.779

5    8 Jul 2011 05:33:39.124    8 Jul 2011 05:37:40.825             4.028

6    8 Jul 2011 07:05:29.235    8 Jul 2011 07:18:28.486            12.988

7    8 Jul 2011 08:43:30.538    8 Jul 2011 08:56:01.003    12.508

Global Statistics

-----------------

Min Duration           1  7 Jul 2011 10:00:00.000    7 Jul 2011 10:03:51.197             3.853

Max Duration           3    7 Jul 2011 20:05:11.836    7 Jul 2011 20:18:37.952            13.435

Mean Duration                                                                           9.433

Total Duration                                                                            66.031

Toulouse-To-OUFTI1

------------------

Global Statistics

-----------------

Time (UTCG)          Azimuth (deg)    Elevation (deg)     Range (km)

----------------------- ------------- --------------- -----------

Min Elevation     7 Jul 2011 20:05:11.836          357.305              0.000    2995.151370

Max Elevation     7 Jul 2011 20:11:57.633          276.150             56.743     774.233813

Mean Elevation                                                        10.408               

Min Range         7 Jul 2011 20:11:58.026          275.750             56.742     774.228658

Max Range         7 Jul 2011 20:05:11.836          357.305              0.000    2995.151370

Mean Range                                     2236.930788

Liege-To-OUFTI1

---------------

Global Statistics

-----------------

Time (UTCG)          Azimuth (deg)    Elevation (deg)     Range (km)

----------------------- ------------- --------------- -----------

Min Elevation     7 Jul 2011 21:50:33.051          260.558              0.000    2976.031658

Max Elevation     8 Jul 2011 07:13:45.617           83.402            57.652     770.403948

Mean Elevation                                                         10.259               

Min Range         8 Jul 2011 07:13:45.236           83.801             57.651     770.399088

Max Range         8 Jul 2011 07:20:32.449      2.135              0.000    3000.458618

Mean Range                                                                       2258.115130

OUFTI1-To-Liege

---------------

Access       Start Time (UTCG)           Stop Time (UTCG)       Duration (min)

------ ----------------------- ----------------------- --------------

1    7 Jul 2011 10:00:00.000    7 Jul 2011 10:06:25.238             6.421

2    7 Jul 2011 16:51:00.151    7 Jul 2011 16:53:58.371             2.970

3    7 Jul 2011 18:25:38.472    7 Jul 2011 18:38:17.613            12.652

4    7 Jul 2011 20:03:15.004    7 Jul 2011 20:16:31.392            13.273

5    7 Jul 2011 21:42:15.658    7 Jul 2011 21:50:33.051             8.290

6    8 Jul 2011 05:32:24.630    8 Jul 2011 05:41:48.049             9.390

7    8 Jul 2011 07:07:04.207    8 Jul 2011 07:20:32.449            13.471

8    8 Jul 2011 08:45:49.057    8 Jul 2011 08:57:59.715            12.178

Global Statistics

-----------------

Min Duration           2    7 Jul 2011 16:51:00.151    7 Jul 2011 16:53:58.371             2.970

Max Duration           7  8 Jul 2011 07:07:04.207    8 Jul 2011 07:20:32.449            13.471

Mean Duration                                                                              9.831

Total Duration                                                                          78.645



From the chapter IV in section IV.2.3, the orbit period of circular LEO “Polar” orbit is about 97.73 minutes for a 

pass. As a result, the satellite orbits the earth about 15 (24×60/97.73) passes per day. For these 15 passes per day, 

however, the satellite can access

- Liege facility 8 accesses per day with the minimum access duration 2.970 minutes, maximum access 

duration 13.471 minutes and total access duration 78.645 minutes per day.

- and Toulouse facility 7 accesses per day with the minimum access duration 3.853 minutes, maximum 

access duration 13.435 minutes and total access duration 66.031 minutes per day as shown in the text 

box above.

Hence, the total duration of access from OUFTI-1 satellite to Liege facility is about 12.61 minutes bigger/better 

than the one from OUFTI-1 satellite to Toulouse facility.

The mean range between Liege facility and OUFTI-1 satellite is about 2258.16 km, while the one between 

Toulouse facility and OUFTI-1 satellite is about 2236.93 km. Hence, the free space path losses between OUFTI-

1 satellite and Liege facility is bigger than the one between OUFTI-1 and Toulouse facility, so that the 

communication between OUFTI-1 and Toulouse facility will averagely better than the one between OUFTI-1

and Liege facility.



A.III.4 C code for finding the optimal satellite constellation for a continuous whole Earth 

coverage

#include <math.h>

#include <stdio.h>

#include <conio.h>

int P, N, N_min, N_max, P_min, P_max, testPN;

int N_optimal, P_optimal, count;

char ch;

main()

{

LB1:

clrscr();

printf("\n\n ************************************************************ ");

printf("\n\n *****     Testing Satellite Constellation, P and N      **** ");

printf("\n\n ***** Constellation for continuous whole Earth coverage **** ");

printf("\n\n ************************************************************ ");

printf("\n\n\n + Please input the minimum number of satellite planes, P_min= ");

scanf("%d",&P_min);

printf("\n + Please input the maximum number of satellite planes, P_max= ");

scanf("%d",&P_max);

printf("\n + Please input the maximum number of satellites per plane, N_max= ");

scanf("%d",&N_max);

printf("\n + Please input the minimum number of satellites per plane, N_min= ");

scanf("%d",&N_min);

P=P_max;

N=N_min;

printf("\n\n ----------------------------- START Testing -----------------------------");

while (P>=P_min&&N<=N_max)

{

printf("\n\n -> Testing [ P= %d, N= %d ] ", P, N);

printf("\n\n + Testing satellite constellation %d planes with %d satellites per plane." , P, N);

printf("\n\n + If test is possible, insert value 1 otherwise insert value 0, testPN= ");

scanf("%d",&testPN);

if (testPN==1)

{

N_optimal= N;

P_optimal= P;

P=P-1;

N_max=floor(P_optimal*N_optimal/P);

N=N_max;

goto LB2;

}

else if (testPN==0)

{

N=N+1;

if (N<=N_max)

continue;

else

printf("\n\n ----------------------------- END Testing ----------------------------- ");

printf("\n\n >>> No Periods of Global Coverage Exist!");

goto LB3;



}

}

LB2:

while (P>=P_min&&N>=N_min)

{

printf("\n\n -> Testing [ P= %d, N= %d ] ", P, N);

printf("\n\n + Testing satellite constellation %d planes with %d satellites per plane." , P, N);

printf("\n\n + If test is possible, insert value 1 otherwise insert value 0, testPN= ");

scanf("%d",&testPN);

if (testPN==1)

{

N_optimal= N;

P_optimal= P;

N=N-1;

if (N>=N_min)

continue;

else

P=P-1;

N_max=floor(P_optimal*N_optimal/P);

N=N_max;

continue;

}

else if(testPN==0)

{

P=P-1;

N_max=floor(P_optimal*N_optimal/P);

N=N_max;

continue;

}

}

printf("\n\n ----------------------------- END Testing ----------------------------- ");

printf("\n\n >>> Hence, the optimal constellation is %d planes wtih %d satellites per plane, " 

,P_optimal,N_optimal);

printf("\n\n and the minimum total number of satellites is equal to %d.", P_optimal*N_optimal);

printf("\n\n ----------------------------------------------------------------------- ");

LB3:

printf("\n\n\n\n + Do you want to continue testing an other constellation?");

printf("\n (Press key <Y> for <Yes>,<other key> for <No> and <exit>)");

ch=getch();

if (ch=='Y'||ch=='y')

goto LB1;

else

while(1)

break;

return (0);

}



A.III.5 C code for finding the optimal satellite constellation for a continuous coverage of a 

specific area

#include <math.h>

#include <stdio.h>

#include <conio.h>

int P, N, N_min, N_max, P_min, P_max, testPN;

int N_optimal, P_optimal, count;

char ch;

main()

{

LB1:

clrscr();

printf("\n\n ************************************************************ ");

printf("\n\n ********* Testing Satellite Constellation, P and N ********* ");

printf("\n\n *********   Constellation for continuous coverage  ********* ");

printf("\n\n *********           for an area specific           ********* ");

printf("\n\n ************************************************************ ");

printf("\n\n\n + Please input the minimum number of satellite planes, P_min= ");

scanf("%d",&P_min);

printf("\n + Please input the maximum number of satellite planes, P_max= ");

scanf("%d",&P_max);

printf("\n + Please input the maximum number of satellites per plane, N_max= ");

scanf("%d",&N_max);

printf("\n + Please input the minimum number of satellites per plane, N_min= ");

scanf("%d",&N_min);

P=P_max;

N=N_max;

printf("\n\n ----------------------------- START Testing -----------------------------");

while (P>=P_min&&N>=N_min)

{

printf("\n\n -> Testing [ P= %d, N= %d ] ", P, N);

printf("\n\n + Testing satellite constellation %d planes with %d satellites per plane." , P, N);

printf("\n\n + If test is possible, insert value 1 otherwise insert value 0, testPN= ");

scanf("%d",&testPN);

if (testPN==1)

{

N_optimal= N;

P_optimal= P;

N=N-1;

if (N>=N_min)

continue;

else

P=P-1;

N_max=floor(P_optimal*N_optimal/P);

N=N_max;

continue;

}

else if (testPN==0)

{

P=P-1;

N_max=floor(P_optimal*N_optimal/P);

N=N_max;

continue;



}

}

printf("\n\n ----------------------------- END Testing ----------------------------- ");

printf("\n\n >>> Hence, the optimal constellation is %d planes wtih %d satellites per plane, " 

,P_optimal,N_optimal);

printf("\n\n and the minimum total number of satellites is equal to %d.", P_optimal*N_optimal);

printf("\n\n ----------------------------------------------------------------------- ");

printf("\n\n\n\n + Do you want to continue testing an other constellation?");

printf("\n (Press key <Y> for <Yes>,<other key> for <No> and <exit>)");

ch=getch();

if (ch=='Y'||ch=='y')

goto LB1;

else

while(1)

break;

return (0);

}



A.III.6 3D and 2D graphics of satellite constellations

3D graphic

2D graphic

Figure A.III.12: Walker Delta constellation 2D and 3D graphics for elliptical VLEO orbit defined by 40.02°: 10/14/1

No coverage area

No coverage area

No coverage area



3D graphic

2D graphic

Figure A.III.13: Walker Delta constellation 2D and 3D graphics for elliptical MEO “Molniya” orbit defined by 63.40°: 

3/20/1



3D graphic

2D graphic

Figure A.III.14: Walker Delta constellation 2D and 3D graphics for elliptical MEO “Tundra” orbit defined by 63.40°: 

2/5/1



3D graphic

2D graphic

Figure A.III.15: Walker Delta constellation 2D and 3D graphics for circular LEO “Inclined” orbit defined by 72°: 7/9/1



3D graphic

2D graphic

Figure A.III.16: Walker Star constellation 2D and 3D graphics for circular LEO “Polar” orbit defined by 90°: 6/9/1
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